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GLOSSARY 
 

ACE Advanced Control Equipment 

AI Analog Input 

AO Analog Output 

AWG American Wire Gauge  

DCD Data Carrier Detect 

DFM Direct Frequency Modulation 

DI Digital (Discrete) Input 

DNP Distributed Network Protocol 

DO Digital (Discrete) Output 

DPSK Differential Phase Shift Keying 

EPP Environmentally Preferred Product 

ESD Electrostatic Discharge  

EU European Union 

FCC Federal Communication Commission 

FEP Front End Processor (MCP-M, MCP-T, or FIU) 

FET Field Effect Transistor 

FPGA Field Programmable Gate Array 

FSK Phase Shift Keying 

FIU Field Interface Unit 

GND Ground 

GPRS General Packet Radio Service 

GPS Global Positioning Satellite 

GSM Global System for Mobile Communications  

HW Hardware 

IEC International Electrotechnical Commission 

IO (I/O) Inputs Outputs 

IP Internet Protocol 

IPGW MOSCAD IP gateway 

LAN Local Area Network  

LED Light Emitting Diode 

MCC  Master Control Center 
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MCP-M Motorola Communication Processor – MODBUS 

MDLC Motorola Data Link Communication 

MODBUS MODICON BUS Protocol 

MOSCAD Motorola SCADA 

MOSCAD-L Motorola SCADA-Light 

NEMA National Electrical Manufacturers Association (issues enclosure standards) 

NTP Network Time Protocol 

OPC Open Connectivity 

OVF Overflow 

PC Personal Computer 

PLC Programmable Logic Controller 

PPC Power PC 

PPH Pulse per Hour 

PPM Particle Per Million 

PPP Point-to-Point Protocol 

PPS Pulse per Second 

PSTN Public Switched Telephone Network 

RAM Random Access Memory 

RF Radio Frequency 

ROM Read Only Memory 

RST Reset 

RTS Request to Send 

RTU Remote Terminal Unit (can be MOSCAD or MOSCAD-L) 

RX Receive 

SCADA Supervisory Control and Data Acquisition 

SBO Select Before Operate 

SDRAM Synchronous Dynamic Random Access Memory 

SNMP Simple Network Management Protocol 

SNTP Simple Network Time Protocol 

SPDT Single Pole Double Trigger 

SPST Single Pole Single Trigger 

STS System Tools Suite 

SW Software 

TB Terminal Block 
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TCP Transmission Control Protocol 

TDPSK Trunked Differential Phase Shift Keying 

TX Transmit 

UDF Underflow 

UDP User Datagram Protocol 

USB Universal Serial Bus 

WAN Wide Area Network 

WB Wire Break 
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DESCRIPTION 

Product Overview 
The ACE3600 is a programmable Remote Terminal Unit (RTU). Almost any automation task 
can be implemented with a suitable choice of ACE3600 components.  Typically the RTU 
monitors and controls local equipment and communicates with a control center and with other 
RTUs in the system.  The ACE3600 is the newest Motorola SCADA (MOSCAD) RTU, a 
member of MOSCAD family of RTUs and Control Center Front End Processors. 

The ACE3600 System Tools Suite (STS) can be run on a local or remote PC to perform all the 
setup, programming and monitoring operations such as RTU configuration, system/application, 
download, monitoring, etc.  

Features of the ACE3600 
The ACE3600 combines all the advantages of the legacy MOSCAD and MOSCAD-L RTUs 
with those of modern hardware and software technologies.  

Among these are: 

• A modern CPU platform with powerful microprocessor 

• Real-time operating system based on Wind Rivers VxWorks OS 

• Enhanced communication and networking capabilities 

• Rugged modular design 

• Extended operating temperature range 

• Improved power supply/charger  

• Modules with a high component density 

• System building tools 

• Interoperability with legacy MOSCAD family RTUs 

General Description 
The ACE3600 RTU is a modular unit, comprised of removable modules installed in a multi-
slot frame.  These modules include  

• Power supply  

• CPU 

• I/O modules   
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The basic (default) model includes one power supply and one CPU module.  The number of 
I/O modules is selected as an option of the base model. 

Figure 1-1 provides a general view of the ACE3600 RTU with five I/O modules. 

 

 

Figure 1-1 ACE3600 RTU – General View 
 

I/O Module Options 
The following types of I/O modules are available: 

• Digital Inputs (DI)  

• Digital Outputs (DO) 

• Analog Inputs (AI)  

• Analog Outputs (AO) 

• Mixed I/O 

• Mixed Analog 

Communication Interfaces  
The ACE3600 CPU includes the following serial ports: 

• Configurable RS232 or RS485 serial port 

• Configurable RS232 with GPS receiver support (for time sync)   

• Ethernet 10/100 Mb/s (ACE3640 models) 

POWER 
SUPPLY 
MODULE 

CPU MODULE 

MOUNTING 
PLATE 

I/O MODULES 
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Two additional plug-in ports can be added to the CPU.  The following types of communication 
modules are available for the plug-in ports: 

• RS232  

• RS485  

• General radio interface (Conventional or Trunking, DPSK 1200, FSK 2400, DFM 4800, 
Duo-binary 9600) 

• Ethernet 10 Mb/s 

• Ethernet 10/100 Mb/s (on plug-in Port 1 only)  

ACE3600 RTU Construction 
The ACE3600 is available in various structures: 

• Frame which can accommodate a varied number and type of modules 

• Metal chassis which accommodates the frame, and optional radios, backup battery and 
communication interfaces 

• Protective housing which accommodates the frame, and optional radios, backup battery 
and communication interfaces (suitable for outdoor installation) 

The ACE3600 frame consists of the following elements: 

• Plastic slots which accommodate the power supply, CPU and I/O modules, and 
backplane bus motherboard 

• Mounting plate for attaching the plastic slots together and mounting the frame on a 
wall 

• Backplane bus motherboard which connect the modules to each other via the signal 
buses and connects the modules with operating voltages 

• Power junction box for AC or DC power source and ground connections 

A frame can be mounted on the wall or installed in a 19” rack or customer enclosure.  For more 
information, see the Installation chapter below 

The ACE3600 frame can include wide or narrow plastic slot units: 

• Wide slot unit - can hold a power supply and a CPU or up to three I/O modules 

• Narrow slot unit - can hold up to two I/O modules  
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RTU Options 
Each RTU can include a number of options, including portable and mobile radios, and plastic 
boxes with interface card for communication, etc.   

Housing/Mounting Type Capacity/Options Illustration 

No I/O slot frame 
Basic (default) model. 

Can be installed on a wall. 

Power supply and CPU 

Can be ordered with metal 
chassis or housing options. 

 
3 I/O slot frame 

Can be installed on a wall. 

Power supply and CPU, 
up to 3 I/Os 

Can be ordered with metal 
chassis or housing. 

 
5 I/O slot frame 

Can be installed on a wall. 

Power supply and CPU, 
up to 5 I/Os 

Can be ordered with large 
metal chassis or housing. 

 
7 I/O slot frame 

Can be installed on a wall. 

Power supply and CPU, 
up to 7 I/Os 

Can be ordered with large 
metal chassis or housing. 

 
8 I/O slot frame  

Can be installed on a wall or in 
19” rack/enclosure.  

Power supply and CPU, 
up to 8 I/Os 
 
Can be ordered with metal 
chassis option for accessories: 
6.5 or 10 Ah Lead-Acid 
backup battery 
up to 2 radios;  
up to four plastic boxes. 

 

Small metal chassis 

Enables installation of radio, 
backup battery and other 
accessories. 

Can be installed on a wall or in 
housing.  

Power supply and CPU, 
up to 3 I/Os, 
1 mobile/portable radio, 
1 plastic interface box, 
6.5 Ah Lead-Acid backup 
battery 
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Housing/Mounting Type Capacity/Options Illustration 

Large painted metal chassis 

Enables installation of radio, 
backup battery and other 
accessories. 

Can be installed on a wall or in 
housing. 

Power supply and CPU, 
up to 7 I/Os,  
1 plastic interface box,  
up to 2 mobile/portable 
radios, 
6.5 or 10 Ah Lead-Acid 
backup battery  

Small NEMA 4X/IP65 housing 

Enables installation of radio, 
backup battery and other 
accessories. 

Can be installed on a wall. 

Power supply and CPU, 
up to 3 I/Os,  
1 mobile/portable radio, 
1 plastic interface box,  
6.5 Ah Lead-Acid backup 
battery 

 
Large metal NEMA 4X/IP65 
housing 

Enables installation of radio, 
backup battery and other 
accessories. 

Can be installed on a wall. 

Power supply and CPU, 
up to 7 I/Os,  
1 plastic interface box,  
up to 2 mobile/portable 
radios, 
6.5 or 10 Ah Lead-Acid 
backup battery 

 
 

For installation instructions of each housing/mounting type, see the Installation chapter. 

For the dimensions and weight of each combination, see Appendix A: General Specifications. 

For a detailed list of all ACE3600 options, see the ACE3600 price pages and ordering 
information.  

For a detailed description of the individual modules, see the appropriate chapter below. 
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RTU Components 
The ACE3600 RTU can include the following components. 

Component Function Notes 

Power supply module Converts the main AC or DC 
power source to the voltages 
required by the modules, 
radio/modems and 
accessories.  
Charges the backup battery 
and switches to the battery 
voltage when the main power 
fails (in models with charger.)

See Power Supply Module 
and Backup Battery chapter. 

CPU module Stores and runs the user 
application program, stores 
data collected by the I/O 
modules and communicates 
with the control center, RTUs 
and other devices via the 
communication ports. 

See CPU Module chapter. 

CPU plug-in port Enables adding various 
communication ports to the 
CPU modules. 

See CPU Module chapter. 

CPU plug-in SRAM Provides static RAM. See CPU Module chapter. 

I/O module Matches between the 
ACE3600 and signals of 
various types/levels.   
Interfaces between the 
ACE3600 and the process 
signals. 

See I/O Modules chapter. 

Terminal blocks (TB) Connects the signals to the 
I/O modules. 

See I/O Modules chapter. 

Plug-in 24V DC power supply Enables adding 24 V floating 
power supplies to I/O 
modules for contact “wetting” 
and sensor operation. 

See I/O Modules chapter. 

TB holder kit Holds Module TBs. See I/O Modules chapter. 

Cable with TB holder A cable to connect signals to 
the I/O modules. 

See I/O Modules chapter. 

Backup battery Enables backup RTU 
operation when main power 
fails. 

See Power Supply Module 
and Backup Battery chapter. 
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Component Function Notes 

Radio installation kit Mechanical support and 
cables that enable installation 
of radio. 

See Radio Types and 
Installation Kits chapter. 

RS485 Connection Box Enables connection of up to 6 
devices to the RS485 port on 
the CPU (2W multi-drop). 

See the RS485 Connection 
Box chapter. 

RTU to PC RS232 cable Enables connection of the 
RTU to a PC via the RS232 
port. 

For use of the ACE3600 
Software Tools Suite (STS) 
to perform operations such 
as RTU configuration, 
system/application, 
download, monitoring, etc.  
See the ACE3600 STS User 
Guide. 

RTU to PC Ethernet cable Enables connection of the 
RTU to a PC via the Ethernet 
port. 

For use of the ACE3600 
Software Tools Suite (STS) 
to perform operations such 
as RTU configuration, 
system/application, 
download, monitoring, etc.  
See the ACE3600 STS User 
Guide. 

 

Model Options and Accessories 
F7500  -  ACE3600 System Tools Suite Software 

F7600  -  ACE3600 ‘C’ Toolkit Software  

The full list of ACE3600 options and accessories are listed in the ACE3600 System Planner.  

Product Safety and RF Exposure 
Before using an ACE3600 RTU model with a radio installed, read the operating instructions 
and RF exposure booklet for the specific radio contained in the product.  
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INSTALLATION 

General 
The ACE3600 RTU is shipped from the factory with the modules and plug-in ports assembled.  
The RTU frame is ready for mounting directly on a wall or in a customer's enclosure. The eight 
I/O frame can be installed on a 19" rack. 

Modules can be added to the slots in a frame before or after mounting the RTU on a 
wall/enclosure.   

 

Installation of the ACE3600 should be done only by authorized and 
qualified service personnel in accordance with the US National Electrical 
Code. Only UL Listed parts and components will be used for installation. 
Use UL Listed devices having an environmental rating equal to or better 
than the enclosure rating to close all unfilled openings.  

If the installation involves high-voltage connections, technicians must be 
specifically qualified to handle high voltage. 

If the I/O connections are powered by a hazardous voltage (>60VDC or 
>42Vpeak), all inputs should be defined as hazardous and the unit must be 
installed in a restricted access area for service personnel only. 

If the I/O connections are powered by a safety extra low voltage (SELV) 
(<60VDC or <42Vpeak), all inputs should be defined SELV.  

INSTALLATION CODES 

This device must be installed according to the latest version of the 
country's national electrical codes. For North America, equipment must be 
installed in accordance to the applicable requirements in the US National 
Electrical Code and the Canadian Electrical Code. 

INTERCONNECTION OF UNITS 

Cables for connecting RS232 and Ethernet Interfaces to the unit must be 
UL-certified type DP-1 or DP-2. (Note- when residing in a non LPS circuit.)  

OVERCURRENT PROTECTION 

A readily accessible Listed branch circuit overcurrent protective device 
rated 20 A must be incorporated in the building wiring. 
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External wiring which connects an I/O module to instruments/devices may 
not exceed 42.67m (140 feet).  
If the ACE3600 is subject to high levels of shock or vibration, you must 
take suitable measures to reduce the acceleration or amplitude. We 
recommend that you install the ACE3600 on vibration-damping materials 
(for example, rubber-metal anti-vibration mountings). 

METAL PARTS OF THE POWER SUPPLY MAY BE VERY HOT. 

After removing the power supply module, allow the metal parts to cool 
down before servicing the unit. 

 

A TORX screwdriver is required for installation. 

Mounting the ACE3600 Frame on a Wall 

 

Before drilling holes for mounting the frame, make sure there are no 
electrical wires installed inside the wall at the holes’ location. 

Four holes are provided, one in each corner of the RTU frame, for wall mounting the RTU.  
Figure 2-1, Figure 2-2, and Figure 2-3 show the dimensions of the various frames/metal chassis 
and the distances between the holes. For convenient installation of the ACE3600 RTU on a 
wall, allow an additional 6 cm (2.4") (in W, H) and 7 cm (2.75") (in D) around the plate. 

295 mm

33
0 

m
m

  

410 mm

44
3 

m
m

 
Small Metal Chassis    Large Metal Chassis 

Figure 2-1  Small/Large Metal Chassis Installation Dimensions and Screw Holes for 
Installation 
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Figure 2-2  No I/O and 3 I/O Frame Installation Dimensions and Screw Holes for 

Installation 
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5 I/O Frame      7 I/O Large Frame 

 
Figure 2-3  5 I/O and 7 I/O Frame Installation Dimensions and Screw Holes for 

Installation 
 

The following screw mount installation procedure should be used to install all ACE3600 
frames (with or without a metal chassis) on a wall, except the 8 I/O (19") frames. 

Procedure 2-1  How to Mount the RTU Frame on a Wall 

1) Drill four holes in the wall at the horizontal and vertical distances shown in Figure 2-1 and 
Figure 2-2.  

2) Insert M4 screws (not supplied) with head size DIN 7981C/ST4, 2x38mm into the holes. 

3) Remove the modules from the frame.  

4) Lift the RTU frame and hang over the four screws. 
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5) Remove the outermost modules in order to access the screws. 

6) Tighten all four screws with a screwdriver to secure the frame firmly against the wall. 

7) Replace the removed modules in their slots. 

Installing the ACE3600 in a 19" Rack 
The following screw mount installation procedure should be used to install the ACE3600 8 I/O 
(19") frame in a 19" rack. 

Note: The brackets for 19" rack installation are not provided with the RTU and should be 
ordered separately. 

Procedure 2-2  How to Mount the RTU in a 19" Rack Unit 

1) Press the small metal bracket into the slot of the larger bracket.  See Figure 2-4. 

2) Secure the two brackets together with two M5 screws (supplied), according to the desired 
depth of the unit on the rack.  See Figure 2-4. 

3) Repeat steps 1-2 for the other pair of brackets. 

4) Using the supplied two screws, attach the combined brackets to the metal pole of a 19" 
rack unit.  See Figure 2-4.  Repeat on other side. 

Bracket Groove

Small Bracket

Large Bracket

Metal Pole

 

Figure 2-4  Installation of Brackets for 19" Rack Units 
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5) Hang the 19'' metal chassis on the brackets, so that the two teeth on the back of the metal 
chassis hook onto the groove of the larger bracket.  

 

Figure 2-5  Installation of ACE3600 RTU 19" Rack- Exploded View 
 

6) From the standard rack unit, remove the two modules from the leftmost slots and the two 
modules from the rightmost slots.  For the 19" accessories metal chassis, no accessories 
need to be removed.  (See Figure 2-6.) 

7) Using two supplied M5 (X6) screws and a 16 cm (6.3") long screwdriver, from inside the 
slot secure the 19" metal chassis to the small bracket.  Repeat on the second side.  See 
Figure 2-5. 

8) Replace any removed modules to their slots. 
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Mobile Radio

Portable Radio
Plastic Boxes

Battery
 

Figure 2-6 Installation of ACE3600 RTU 19" Rack Accessories - General View 

Mounting the ACE3600 8 I/O Frame on a Wall 
453 mm

450 mm

12
8 

m
m

93
 m

m

 
Figure 2-7  RTU Metal Chassis Installation Dimensions 

Procedure 2-3  How to Mount the RTU 19" Metal Chassis on a Wall 

The following installation procedure should be used to install the 8 I/O (19") frame on a wall, 
using the special wall mount brackets provided with the RTU.  

1) Remove the CPU, Power Supply and I/O modules from the RTU rack. 

2) Drill four holes into the wall at the horizontal and vertical distances shown in Figure 2-7.   

3) Using two supplied screws, secure the rectangular wall mounting bracket to the wall.   
Repeat for the second bracket. 
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4) Hang the metal chassis on brackets so that the 2 teeth of the metal chassis hook onto the 
groove of the brackets.  (See Figure 2-8.) 

5) Using two M4 screws (not supplied) with head size DIN 7981C/ST4, 2x38mm screws, 
secure the top and bottom of the rack to the left bracket.  Repeat for the right bracket. 

 

 

 

 
Figure 2-8  RTU Metal Chassis Installation  

Mounting the ACE3600 NEMA4 Housing on a Wall 
The following screw mount installation procedure should be used to install ACE3600 frames in 
NEMA4 housing on a wall.  

For convenient installation of the ACE3600 RTU with the NEMA4 housing, allow an 
additional 6 cm (2.4") (in W, H) and 7 cm (2.75") (in D) around the housing. 

Four mounting brackets are provided, one in each corner of the RTU, for wall mounting the 
RTU housing (see Figure 2-9 through Figure 2-11).  Figure 2-9 and Figure 2-10 show the 
distances between the bracket holes.   
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Horizontal Bracket Installation              Vertical Bracket Installation 

Figure 2-9  Large NEMA 4 Housing - Installation Dimensions 
 
 

16.2" (41.2 cm)

16.2"
(41.2 cm)

12.6" (32.0 cm)

12.6"
(32.0 cm)

 
Figure 2-10  Small NEMA 4 Housing - Installation Dimensions 

 

Procedure 2-4  How to Mount the RTU NEMA4 Housing 

1) Drill four holes in the wall at the horizontal and vertical distances shown in Figure 2-9 (for 
the large housing) and in Figure 2-10 (for the small housing.) 

2) Using the brackets and the screws supplied in the plastic bag, fasten the mounting brackets, 
either horizontally or vertically, onto the four back corners of the housing.  See Figure 2-
11. 

3) Mount the RTU onto the wall and secure with M4 screws (not supplied) with head size 
DIN 7981C/ST4, 2x38mm through the bracket hole.  See Figure 2-11. 
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Figure 2-11  Mounting the NEMA 4 Housing 

 

Connecting Power and Ground 
All internal electrical connections except for the main power, ground and battery are performed 
in the factory and supplied with the RTU.  The electrical interconnection diagrams are 
provided in the Break-Fix Procedures chapter. 

The procedures for the main power, ground and battery connections are provided below. 

 

The power and ground connections should be performed only by qualified 
and authorized service personnel.  All power and ground connections 
must be in accordance with local standards and laws.  

Per UL 60950 / EN 60950, install an external circuit breaker rated at 6 A 
between the power source and the ACE3600 Power supply. 

Per UL 60950 / EN 60950, for all I/O modules connections, the maximum 
voltage should not exceed 60V DC or 30 V AC unless it is specifically 
written otherwise. 

To maintain Overvoltage (Installation) Category II, install a suitable surge 
suppressor device in the branch circuit to limit expected transients to over 
voltage Category II values. The limits are based on IEC60664 and are also 
located in Table 2H of UL60950 (for mains = 150V, the transient rating is 
1500V; for 150V < mains = 300V, the transient rating is 2500V; and for 300V 
< mains = 600V, the transient rating is 4000V). 
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Make sure that the ground wire on the user cable is long enough to reach the 
grounding strip. 

Connecting AC/DC Main Power 
The power connection to all the ACE3600 power supply types is via the power junction box 
located on the frame beneath the power supply slot.   

 

Safety standards require that the power cable be attached to the unit at two anchor 
points:  

• Anchor point 1 for all units is inside the power junction box.  (See Figure 2-12 
below.) 

• Anchor point 2 for the basic model (No I/O Slots Frame) is located on the right of 
the power junction box. (See Figure 2-12 below.) 
Anchor point 2 for all units with housing (other than No I/O Slots) is in the 
housing power cable gland. (See Figure 2-16 below.) 
Anchor point 2 for all other units without housing (other than No I/O Slots) is 
near the unit’s ground strip. (See Figure 2-13 below.) 

Clamp - Anchor Point 
Clamp - Anchor Point 

 
Figure 2-12  RTU on No I/O Frame – Cable Anchor Points 1 and 2 
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Anchor Point 2 Clamp  
Figure 2-13  RTU on Metal Chassis – Cable Anchor Point 2 

 

Procedure 2-5  How to Connect the RTU to Main Power Source (Units with Frames and Metal 
Chassis) 

1) Using a screwdriver, open the power junction box cover (save the screws) and unscrew the 
power terminals screws inside the power junction box. 

2) Thread the user's main power cable through the two supplied clamps. 

3) Attach the wires of the user cable, according to the labels (~/0 for AC and +/- for DC.) For 
the No I/O Frame, connect the ground cable to the lower wire terminals (third pair). Figure 
2-14 and Figure 2-15. 

Power Supply
Cable Inlet

User Power Cable

Wire 
Terminals

Anchor Point 1

Junction BoxGround Cables

Cable to Power Supply

0   ~

0   
~

 

Figure 2-14  RTU Power and Ground Connections - No I/O Frame Installation 
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Figure 2-15  RTU Power and Ground Connections – All Other Installations 
 

4) Pass the power cable to the right of the wire terminals inside the junction box, over the 
horizontal ridge.  

5) Close the first clamp around the user cable and screw it onto the junction box, into the hole 
next to wire terminals (anchor point #1).  

6) Close the second clamp and screw it onto the anchor point near the grounding strip (or on 
the bottom of the plastic to the right of the junction box in case of the No I/O Slots frame.) 

7) Replace the junction box cover over the junction box.  

8) Secure the junction box cover with two saved screws. 

9) For all installations except the No I/O frame, loosen the two screws on the grounding strip 
at the bottom of the metal chassis/housing and connect the ground cable to the protective 
ground. Tighten the screws firmly.  

10) Open the door of the power supply module and press in the cable holder downwards.  

 
11) Plug the connector of the power supply cable (3089004V64 for DC, 3089004V65 for AC) 

into the cable inlet on the power supply module (on the bottom of the front panel.) and 
rotate the cable holder upwards to secure. 
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Procedure 2-6  How to Connect the RTU to Main Power Source (Units with Housing) 

1) Using a screwdriver, open the power junction box cover (save the screws) and unscrew the 
power terminals screws inside the power junction box. 

2) Insert the rubber grommet (supplied) into the threaded plastic cable gland, and place it into 
the hole on the bottom of the housing (from the outside.)  (See Figure 2-16.) 

3) Place the nut into the same hole from inside the housing and screw the nut onto the cable 
gland. (See Figure 2-16.) 

4) Thread the user's main power cable (110/220VAC or 24-48VDC) through the cable gland 
cover from below, through the cable gland, and into the housing. (See Figure 2-16.) 

Cable 
Gland 

Grommet 

RTU Housing

NutCable 
Gland  
Cover

Power 
Cable 

 
Figure 2-16  RTU in NEMA4 Housing – Cable Gland Anchor Point 2 

 
5) Attach the wires of the user cable, according to labels (~/0 for AC and +/- for DC.) See 

Figure 2-14 and Figure 2-15. For the No I/O frame, connect the ground cable to the lower 
wire terminals (third pair). 

6) Tighten the screws of the wire terminals and screw the wire terminals onto the junction 
box. 

7) Pass the power cable into the right side of the junction box, over the horizontal ridge. 

8) Place the user cable into the clamp, close the clamp and screw it onto the junction box, into 
the hole next to wire terminals (anchor point #1). 
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9) Replace the junction box cover over the junction box. 

10) Secure the junction box cover with the two saved screws. 

11) For all installations except the No I/O frame, loosen two screws on the grounding strip at 
the bottom of the metal chassis/housing and connect the ground cable to the protective 
ground. Tighten the screws firmly. 

12) Screw the top of the cable gland tightly to the cable gland to secure the cable (anchor point 
#2). 

13) Open the door of the power supply module and release the cable holder (press downward). 

14) Plug the connector of the power supply cable (3089004V64 for DC, 3089004V65 for AC) 
into the cable inlet on the power supply module (on the bottom of the front panel.) and 
close the cable holder. 

Connecting the Backup Battery 
The backup battery of ACE3600 is shipped from factory disconnected. Use this procedure to 
connect the battery cable to the power supply charger. 

 

Before using the Lead Acid backup battery, it is strongly recommended to read the 
information on the battery provided in the Power Supply Module and Backup Battery 
chapter. 

Lead acid batteries will self-discharge if they are stored without charging. Self-
discharge below the manufacturer's recommended voltage will result in internal 
permanent damage to the battery rendering it inoperable. When this occurs, if 
connected to a power supply/charger, the battery may produce excessive internal heat 
and therefore deform and/or leak. 

 

A battery contains diluted sulfuric acid, a toxic and corrosive substance.  
Avoid any bodily contact with the leaking liquid when handling leaking 
batteries and affected parts.  If the battery leaks and the liquid inside touch 
the skin or clothing, immediately wash it off with plenty of clean water.  If 
the liquid splashes into eyes, immediately flush the eyes with plenty of 
clean water and consult a doctor.  Sulfuric acid in the eyes may cause loss 
of eyesight and acid on the skin will cause burns. 

Procedure 2-7  How to Connect the Backup Battery 

1) Check the battery visually. If the battery looks deformed and / or you notice corrosion on 
the battery terminals and / or the battery leaks, DO NOT use the battery and replace it with 
a new battery. 
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2) Check the battery terminal voltage level before connecting it. If the battery voltage is less 
than 10V DC, DO NOT use the battery and replace it with a charged battery that measures 
at least 10V DC. 

3) If the battery passes a visual inspection and the terminal voltage is correct, plug the battery 
cable (3089927V10) into the Battery In/Out connector on the power supply module. 

4) Fully charge the battery prior to initial use (~10 hours). 

Connecting I/O Modules to Ground 
Before operating the I/Os in the ACE3600, the I/O modules must be connected to ground.   

Procedure 2-8  How to Connect an I/O Module to Ground 

1) Identify the PGND pin(s) on the I/O module using the Module Block Diagram or 

Connection Charts in the relevant chapter for the I/O module type.  See the symbol  
next to the Protective Ground in the Module Block Diagrams. 

2) If user-supplied cables are used, connect the ground wire(s) to the PGND pin(s) on the I/O 
module and to the grounding strip at the bottom of the RTU.  (See grounding strip in 
Figure 2-13 above.) 

3) If the wired cable braid is used, identify the ground wire(s) based on the pin number 
printed on the wire label.  
Connect the ground wire(s) from the cable braid to the PGND pin(s) on the I/O module and 
to the grounding strip at the bottom of the RTU.  (See grounding strip in Figure 2-13 
above.)   

4) Repeat steps 1-3 for the PGND wires on all I/O modules.   

Connecting the Radio 
A radio which is shipped in the ACE3600 is fully connected.  To add a radio to the ACE3600, 
use the appropriate radio installation kit.  For information on radio types, radio installation kits 
and connections, see the Radio Types and Installation Kits chapter. 

Opening/Closing the Housing Door 
The door to the small ACE3600 NEMA4 housing is equipped with a latch or with an optional 
padlock accessory.  See Figure 2-17.  The door to the large ACE3600 NEMA4 housing is 
equipped with two door latches or with an optional padlock accessory plus a latch.  See Figure 
2-18. 

Procedure 2-9  How to Open and Close the Housing Door 

1) To open a small RTU housing equipped with a door latch, turn the latch clockwise.  The 
door will open.    
To open a small RTU housing equipped with the padlock accessory, remove the user-
supplied padlock (if one exists) and turn the padlock accessory clockwise.  The door will 
open. 
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To open a large RTU housing equipped with two door latches, turn both latches clockwise.  
The door will open.    
To open a large RTU housing equipped with the padlock accessory and a latch, remove the 
user-supplied padlock (if one exists) and turn the padlock accessory and latch clockwise.  
The door will open. 

2) To close a small RTU housing equipped with a door latch, turn the latch counterclockwise 
and push the door closed until the latch clicks.   
To close a small RTU housing equipped with the padlock accessory, turn the padlock 
accessory counterclockwise and push the door closed until the latch clicks.  Add the user-
supplied padlock (if one exists) to lock the door. 
To close a large RTU housing equipped with two door latches, turn both latches 
counterclockwise and push the door closed until the latch clicks.   
To close a large RTU housing equipped with the padlock accessory and a latch, turn the 
padlock accessory and latch counterclockwise and push the door closed until the latch 
clicks.  Add the user-supplied padlock (if one exists) to the padlock accessory to lock the 
door. 

        
Figure 2-17  Small ACE3600 NEMA4 Housing/Housing with Padlock 

 

       
Figure 2-18  Large ACE3600 NEMA4 Housing/Housing with Padlock 
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Installing Plastic Box Interfaces 
Cards such as RS485 interface card can be attached to the ACE3600 RTU using a plastic box.  
The plastic box can be attached to the 19" accessories metal chassis, small/large metal chassis, 
or small/large NEMA housing. 

Procedure 2-10  How to Install the Plastic Box Interface on the Metal Chassis 

1) To connect the plastic box interface to the metal chassis, place the box on the metal plate 
and click the two pegs on the back of the plastic box into the desired holes on the metal 
chassis.  See Figure 2-19. 
Note: This figure is for illustration purposes only.  It is not possible to install all 
accessories on the same metal chassis. 

Mobile Radio

Portable Radio
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Battery
 

Figure 2-19  Accessories Installed on a Metal Chassis 
 

2) To remove the plastic box interface from the metal chassis, insert a screwdriver into the 
notch located in the snap securing the unit to the chassis.  Slightly bend the snap outwards 
to release it from the slot, and carefully pull out the unit. 
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POWER SUPPLY MODULE AND BACKUP BATTERY 

General Description/Module Overview 
The ACE3600 power supply module provides the other modules in the RTU with their 
operating voltages via the motherboard bus. 

The following power supply options are available: 

• DC power supply low-tier (10.8-16V) 

• DC power supply (10.8-16V) - provided by default with the ACE3600 RTU 

• DC power supply (18-72V) 

• DC power supply (18-72V) with battery charger 

• AC power supply- 90-264V 

• AC power supply- 90-264V with battery charger 

 

Common characteristics of all power supply modules (not including the DC power supply low-
tier): 

• On/Off switch on the front panel 

• Controlled auxiliary voltage outputs 

• Heat convection cooling (no need for fans) 

• Short protection outputs 

• Over heating protection 

• Status LEDs in the front panel 

• PS located on the leftmost slot of the frame 

• Input current protection fuse 

• Controlled power line enables centralized disabling of Electrically Energized relay outputs 
in selectable DO modules. 

Note: The DC power supply low-tier does not support radios that require input power other 
than 10.8-16V.  Do not use portable radios which require 7.5V input with this option. 

Note: The low limit of the DC power supply (10.8-16V) can be configured to 10.5V.  The 
default is 10.8.   
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Common characteristics of power supply modules with battery charger: 

• Automatic switchover to battery on power fail 

• Automatic switchover to main power on power return 

• Temperature compensated charging 

• Over-charging protection 

• Over-discharge protection 

• Battery test and diagnostics, including battery controlled discharge 

Characteristics of the DC power supply low-tier: 

• Two auxiliary voltage outputs 

• Short circuit protection outputs 

• PS located on the leftmost slot of the frame 

• Overvoltage protection for CPU and I/Os 

• Reverse voltage protection 

Figure 3-1 below depicts a general view of the power supply.  

 DO 
BATT
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PWR
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This converter 
exists only in AC 
or 18-72V DC PS

AUX 1A

AUX 1B

AUX 2A

AUX 2B

12V_DO
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18-72 
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Figure 3-1 ACE3600 Power Supply – General View 
 

 

METAL PARTS OF THE POWER SUPPLY MAY BE VERY HOT. 
After removing the power supply module, allow the metal parts to cool 
down before servicing the unit. 

 

Figure 3-2 below depicts a detailed view of the power supply front panel.  

PWR

AUX1

AUX2

 DO

Auxiliary Output 1A
Auxiliary Output 1B
Auxiliary Output 2A
Auxiliary Output 2B
12V DO Control
12V Out (Reserved)
Battery In/Out
Temperature Sensor

AC/DC Main Power Input

BATT

On/Off Switch

Indication LEDs

DC Main Power Input   

            Power Supply                       DC Power Supply Low-Tier 
Figure 3-2 ACE3600 Power Supply – Front Panel 

 

ON/OFF Switch 
The front panel of the power supply module includes an ON/OFF switch for the module.  In the 
OFF (down) position, all the power outputs except Battery In/Out are disabled.  A mechanism 
is provided to prevent accidentally changing the switch position. 

 

In power supply modules equipped with a battery charger, if the ON/OFF switch is in 
the OFF position, and the RTU main power is connected, the Battery In/Out is not 
disabled to ensure battery charging. 
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Input/Output Connectors 
The front panel of the power supply module (not including DC power supply low-tier) includes 
the following connectors.   

Connector Name Description Notes 
Auxiliary Output 1A 13.8V DC (±5%) @ 20°C 

User controlled power output.  
Short protected. 

This output is used for 
powering radios, modems, etc.  
The output can be switched 
ON/OFF either by the user 
application program or using 
the STS hardware test.   
(Default = ON) 
For more information, see the 
Performing Hardware Tests 
section or Application 
Programmer section of 
ACE3600 STS User Guide. 

Auxiliary Output 1B Same as Auxiliary Output 1A Same as Auxiliary Output 1A 

Caution: Auxiliary Output 1A and 1B are ON by default with 13.8V DC.  Do NOT plug in a 
radio which requires less voltage or the radio may be damaged. 

Auxiliary Output 2A DC Power Output  
Selectable/programmable  
3.3 to 9V DC or  
13.8V DC (±5%) @ 20°C.  
User controlled power output.  
Short protected. 

This output is used for 
powering radios, modems, etc.  
The output voltage can be set 
by the user using the STS site 
configuration.   
The output can be switched 
ON/OFF either using the STS 
hardware test or by the user 
application program. (Default = 
OFF) 
If both 2A and 2B are ON, they 
must have the same output 
level.  The voltage levels of 
AUX2A and AUX2B are the 
same. 

Auxiliary Output 2B Same as Auxiliary Output 2A Note: Auxiliary Output 2B can 
be ON independently of 2A.   
The voltage levels of AUX2A 
and AUX2B are the same.  

Caution: If both 2A and 2B are ON, they must have the same output level.  If cables are 
connected to Auxiliary Output 2A and 2B, they must use the same voltage. 
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Connector Name Description Notes 
12V DO Control Control input that enables 

centralized disabling of 
Electrically Energized (EE) relay 
outputs in selectable DO 
modules. 

Input open = Relays are 
disabled.  (ML relays do not 
change state) 
Input shorted = Relays are 
enabled. 

This input controls a dedicated 
12V power line that is available 
to all the slots in the frame.  In 
each relay DO module, the user 
can mechanically select to 
power the relay coils from this 
dedicated 12V power line.  

For details on setting this 
control, see the Module 
Configuration section of the DO 
Relay Module chapter. 

12V Out  (Reserved) Pin 1- PGND 
Pin 2- 12V DO 
Pin 3- GND 
Pin 4- MAIN (12V) 

Battery In/Out  
(only in power supply 
with charger) 

Battery charger output when the 
main power exists. 

Backup power input from battery 
when the main power fails. 

The charging voltage level is 
controlled by the battery 
charger and is a function of the 
temperature. 

Temperature Sensor Sensor for battery temperature to 
control charging level.   

(In modules with power supply 
and charger only)  
For more information, see the 
Backup Battery section below. 

AC/DC Main Power 
Input 

Cable inlet for main power cable 
(AC or DC) 

The cable is part of the RTU 
frame (connected to the power 
junction box. 

Note: When the cable male 
connected is place in this input, 
it locks the power supply 
module in its slot.  To remove 
the power supply module, first 
unplug the power input cable. 

 

The front panel of the DC power supply low-tier includes the following connectors.   

Connector Name Description Notes 
Auxiliary Output 1A Vin=Vout 

Shorted to Power IN. 
This output is used for 
powering radios, modems, etc.  

Auxiliary Output 1B Vin=Vout 
Shorted to Power IN. 

This output is used for 
powering radios, modems, etc.  
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Connector Name Description Notes 
10.8-16V DC Main 
Power Input 

Cable inlet for main power cable 
(DC) 

The cable is part of the RTU 
frame (connected to the power 
junction box. 

Note: When the cable male 
connected is place in this input, 
it locks the power supply 
module in its slot.  To remove 
the power supply module, first 
unplug the power input cable. 

 

LEDs 
The front panel of the power supply module (not including the DC power supply low-tier) 
includes five indication LEDs. 

LED Name Description Status 

PWR Power LED  Indicates the existence of AC or DC main 
power in the Main Power input. 

When the ON/OFF switch is in ON position - 
the LED is lit in Green. 

When the ON/OFF switch is in OFF position, 
but there is AC or DC input or battery-  
the LED is lit in Red. 

When the ON/OFF switch is in ON position and 
the unit is powered from the battery -  
the LED is lit in Orange. 

When there is no AC or DC input or battery 
connected - the LED is OFF. 

AUX1 Auxiliary Output 1 LED AUX1A is ON - Green 
AUX1B is ON - Red  
AUX1A and AUX1B are ON – Orange 

AUX2 Auxiliary Output 2 LED AUX2A is ON - Green 
AUX2B is ON - Red  
AUX2A and AUX2B are ON – Orange 

DO Digital Output Control 
LED 

Relays enabled – LED ON – Green 
Relays disabled – LED OFF 
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LED Name Description Status 

BATT Battery LED No battery/thermistor - LED OFF  

Battery is fully charged (charging current 
<20mA) - LED ON - Green  

Battery is being charged (charging current  
>20mA and <600mA)- LED ON – 
Green/Yellow Blinking 

Battery is being charged (charging current 
>600mA)- LED ON – Yellow  

Battery is discharging (battery voltage is higher 
than voltage of power supply) - LED ON – Red. 

Battery charging current is stabilizing - LED 
ON – Yellow Blinking. 

When battery capacity test is being performed - 
the LED is lit in Green Blinking. 

Battery tests are performed using the STS 
Hardware Test function or the user application 
program. 

 

Battery Charger 
Power supply modules with a battery option support a 6.5 or 10 Ah Lead-Acid battery.  The 
power supply automatically switches to the backup battery as a 12V DC power source for the 
RTU and communications when the main AC or DC power source fails. 

Power supply modules with a 12 VDC smart battery charger option charge the backup battery 
when not in use, and protect the battery from over-discharge.  The charger performs battery 
tests/diagnostics, including controlled battery discharge, when requested by the user.  If the 
battery is failed, the charger will not charge it and will send a failed status signal to the CPU.  
If the battery is remotely located, long battery cables can be used.   

The DC power supply low-tier does not include a battery option. 

Charging the Battery 
The charging voltage of the Lead-Acid battery is controlled by the charger as a function of the 
battery temperature. The charging profile is set to comply with the temperature-compensated 
float-voltage of the ACE3600 battery. 

Diagnostics 
A battery test can be performed on the Lead-Acid battery, either from the ACE3600 STS 
Hardware Test utility or from the user application program.  The battery test includes disabling 
the battery charger, discharging the battery and measuring the capacitance.  For more 
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information, see the Hardware Test section or the Creating a User Application section of the 
ACE3600 STS User Guide.  

 

It is recommended to run a battery capacity test once per month (for more exact results 
perform at +10˚ to +30˚C), and a charge level test once per day.  The capacity test 
discharges the battery for 20 seconds and then measures the output.  If the capacity is 
below the manufacturer recommended level, the battery should be replaced with a new 
one.  (See Replacing the Backup Battery below.)  Note that the capacity test is only 
available for the battery types supplied by Motorola. 

The results of the battery capacity test can be:  

• Battery OK 

• Battery needs to be replaced 

• Test blocked - bad environment 

The battery capacity test will be blocked under the following conditions: 

1.  If the battery is discharging (battery is main power source of RTU), 

2.  If the battery or thermistor is disconnected, 

3.  If the battery temperature is outside the specified range (-30˚ to 60˚C),  

4.  If the battery is not fully loaded. 

Connecting the Power Supply to a Power Source 
The power supply can be connected to an AC or DC power source.  The DC power supply low-
tier can be connected to a DC power source only.   

For instructions on connecting the power supply to a power source, see the Power and Ground 
Connections section of the Installation chapter above. 

 

All power and ground connections must be in accordance with local standards and 
laws. 
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Power Supply Module Detailed Specifications 
The following four charts detail the specifications of the various power supply modules. 

12V DC Power Supply Module (Default) 

Input Voltage DC 10.8-16 V 
The low limit of the DC power supply (10.8-16V) can be configured to 10.5V.  
The default is 10.8. 

Outputs Motherboard connector (to CPU and I/O modules): equal to input voltage, max. 
4 A  
AUX1A/AUX1B: equal to input voltage, max. 8 A, on/off controlled by user 
program    
AUX2A/AUX2B (configurable): equal to input voltage (default), max. 8A,   
or 3.3, 5, 7.5, 9 V DC ±10%, max. 2.5A, on/off controlled by user program  

Note: max. 8 A total current consumption from all outputs 

No Load Power 
Consumption 

Max. 50 mA 

Diagnostic LEDs Status LED for: input voltage, AUX1 and AUX2 outputs, 12V control for DO 
modules 

Input Protection Internal Line Fuse, replaceable  

Output Protection AUX2A/B short circuit, automatic recovery on 3.3, 5, 7.5, 9 V 

Dimensions 56 mm W x 225 mm H x 180 mm D (2.2" W x 8.7" H x  7.1" D)  
Weight Approx. 0.43Kg  (0.95 Lb) 

  

12V DC Low-Tier Power Supply Module 

Input voltage 10.8-16 V DC 

Outputs Motherboard connector (to CPU and I/O modules): The same as input voltage / 
max. 4 A  
AUX1A/AUX1B: equal to input voltage max. 8A  
Note: max. 8 A total current consumption from all outputs 

Input Protection Internal Line Fuse, replaceable 

Dimensions 56 mm W x 225 mm H x 180 mm D (2.2" W x 8.7" H x  7.1" D)  
Weight Approx. 0.43Kg  (0.95 Lb) 

Specifications subject to change without notice. 
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18-72V DC Power Supply Modules 

Input Voltage 18-72 V DC  

Total Power 18-72 V DC Max. 60 W continuous; max. 105 W peak @ 25% duty cycle 

Outputs Motherboard connector (to CPU and I/O modules): 13.2 V DC ±20%, max. 4 A  
AUX1A/AUX1B: equal to input voltage, max. 8 A, on/off controlled by user 
program   
AUX2A/AUX2B (configurable): equal to input voltage (default), max. 8 A,   
or 3.3, 5, 7.5, 9 V DC ±10%, max. 2.5A, on/off controlled by user program  

Note: max. 8 A total current consumption from all outputs 

Battery Charger  12 V Lead Acid battery charger (in PS model with charger) 

Automatic charging of 6.5 or 10 Ah backup battery, battery temperature sensing, 
overcharging protection, battery capacity test and diagnostics, automatic battery 
switch-over 

Diagnostic LEDs Status LED for: input voltage, AUX1 and AUX2 outputs, 12 V Control DO for 
DO modules, and battery  

No Load Power 
Consumption 

Max. 250 mA 

Efficiency  80% typical, 76% with full load 

Inrush Current  10 A maximum, for 2 mSec. Max, cold start at 25°C 

Protection Internal line input fuse (replaceable), short circuit automatic recover  

Output Protection AUX2A/B short circuit, automatic recovery on 3.3, 5, 7.5, 9 V 

Insulation Input to case: 500 V DC, input to output 500 V DC 

Dimensions 56 mm W x 225 mm H x 180 mm D (2.2" W x 8.7" H x 7.1" D)  
Weight Approx. 1Kg  (2.2 Lb) 

Specifications subject to change without notice. 
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AC Power Supply Module 

Input voltage 90-264 V AC, 50/60 Hz  

90-264 V AC, 50/60 Hz with 12V smart battery charger   

Total Power Maximum 60 W continuous; maximum 105 W peak @ 25% duty cycle 

Outputs Motherboard connector (to CPU and I/O modules): 13.2 V DC ±20%, max. 4 A  
AUX1A/AUX1B: 13.2 V DC ±20%, max. 8 A, on/off controlled by user 
program   
AUX2A/AUX2B (configurable): equal to input voltage (default), max. 8 A,   
or 3.3, 5, 7.5, 9 V DC ±10%, max. 2.5A, on/off controlled by user program  

Note: max. 8 A total current consumption from all outputs 

Battery Charger  12 V Lead Acid battery charger (in PS with charger) 

Automatic charging of 6.5 or 10 Ah backup battery, battery temperature sensing, 
overcharging protection, battery capacity test and diagnostics, automatic battery 
switch-over 

Diagnostic LEDs Status LED for: input voltage, AUX1 and AUX2 outputs, 12V Control for DO 
modules, and battery  

No Load Power 
Consumption 

130 mA @ 220 V AC 

Efficiency  80% typical @230 V AC, 76% typical @115 V AC (full load) 

Inrush Current  25 A maximum, for 2 mSec. Max, cold start at 25°C 

Power Factor 0.98 typical at 230 V AC, 0.99 typical at 115 V AC 

Protection Internal Line Fuse, replaceable  

Output Protection AUX2A/B short circuit, automatic recovery on 3.3, 5, 7.5, 9 V 

Insulation Input to case: 1500 V AC, input to output: 3000 V AC 

Dimensions 56 mm W x 225 mm H x 180 mm D (2.2" W x 8.7" H x  7.1" D)  
Weight Approx. 1kg (2.2 lb) 

Specifications subject to change without notice. 
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Backup Battery 

Overview 
The ACE3600 backup 12V Lead-Acid battery provides backup for the main input power.  The 
battery is available in two capacities: 6.5 Ah and 10 Ah.  Switching from main input power to 
the battery and charging of the battery is performed by the ACE3600 power supply module.   

Sealed Lead Acid technology batteries can be recharged and discharged at a temperature range 
of -30º to +60ºC. Storage and operating temperatures affect the battery capacity and lifespan. 
ACE3600 power supply modules include a special charging power supply designed to fit the 
specific temperature-compensated float-voltage-charging curve of the battery.  

 

Lead Acid batteries will self-discharge if they are stored without charging. Self-
discharge below the manufacturer's recommended voltage will result in internal 
permanent damage to the battery rendering it inoperable. When this occurs, if 
connected to a power supply/charger, the battery may produce excessive internal heat 
and therefore deform and / or leak. 

The batteries are shipped disconnected from the power supply/charger. To ensure that 
there are no battery problems on your ACE3600 project, each Lead Acid battery 
MUST be fully charged and checked before connecting it to the ACE3600 power 
supply/charger. To verify that the battery is fit for use, measure the BATTERY OPEN 
CIRCUIT voltage (when the battery is not connected to the power supply/charger) 
with a digital voltmeter.  If the battery voltage is less than 12.5 V DC, DO NOT use 
the battery and replace it with a new ACE3600 battery that measures more than 12.5 V 
DC.  

Before transporting the battery, read and follow all safety information located on the 
battery case. 

 

ACE3600 batteries are shipped from the factory tested, fully charged and with a label 
stating the next time it should be recharged when stored at temperatures of 30ºC or 
less. 

Motorola battery warranty is valid only when the battery is charged with the original 
Motorola ACE3600 charging power supplies. Use of any other power supply/charger 
will void the battery warranty. 
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Under various state or local laws, the batteries must be recycled or disposed of 
properly and cannot be disposed of in landfills or incinerators. Environmental 
protection regulations classify used Lead Acid batteries as hazardous waste, unless 
certain exemptions apply. Consideration should be given to the methods of collecting, 
labeling, handling and shipping used Lead Acid batteries. Please consult the 
environmental protection authority for specific legal requirements and for recycling 
options in your country/area. 

Backup Battery Storage, Lifespan, Inspection and Replacement 
The manufacturer’s recommendations for handling during each of the battery’s life stages are: 

• Transportation: 

Batteries must be handled with care to prevent falls, impact, short circuit or exposure 
to high temperatures and fire.  

• Battery Storage: 

Storage of batteries in a warehouse requires a periodic recharge. The time between 
these recharge cycles depends upon the storage temperature. The minimum open 
circuit voltage allowed on the battery before recharging is 12.42 V, which represents 
remaining capacity of approximately 30%. Therefore it is recommended to perform a 
full charging cycle every few months depending upon the storage temperature of the 
battery. Please refer to Table 3-1 to determine the suggested maximal period between 
recharge cycles that suits the actual storage conditions. Improper storage may cause 
deep discharge of the battery, which might cause degradation of the battery operating 
life and lower the actual delivered capacity. Motorola performs a periodic full charge 
cycle procedure on stored batteries and a final full charge operation prior to shipment. 

• Lifespan: 

The average temperature of the battery environment affects the lifespan of batteries 
installed in the field. Please refer to the battery vendor information at the following 
website: 

·  (Sonnenschein  A512/6.5S and A512/10S): http://www.sonnenschein.org/A500.htm  

• Inspection and Replacement: 

It is important to inspect the batteries periodically (recommended every 6-12 month) 
and replace any battery that has corrosion on the leads or it is deformed or leaks. Such 
a battery should be disposed according to the local environmental laws. To assure the 
battery availability and proper operation, the battery should be replaced at the end of 
its lifespan (approximately 30% capacity) even if it is still functional. Measure the 
battery open circuit voltage using a digital voltmeter as described above. Please note 
that using a battery beyond its lifespan period may cause a battery heating, leakage 
and/or deformation.  
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Table 3-1: Recommended Time between Periodic Battery Recharge vs. Storage Temperature 
Average Storage 

Temp (°C) 
Recharge Interval 

(Months) 

25 12 

45 4 

60 1 
 

Replacing the Backup Battery 

 

A battery contains diluted sulfuric acid, a toxic and corrosive substance. Avoid any 
bodily contact with the leaking liquid when handling leaking batteries and affected 
parts. If the battery leaks and the liquid inside touch the skin or clothing, immediately 
wash it off with plenty of clean water. If the liquid splashes into eyes, immediately 
flush the eyes with plenty of clean water and consult a doctor. Sulfuric acid in the eyes 
may cause loss of eyesight and acid on the skin will cause burns. 

Procedure 3-1 How to Replace the Lead Acid Backup Battery 

To replace the Lead-Acid backup battery, follow the procedure below. 

1) Disconnect the battery cable from the Battery connector of the power supply (see 
Figure 3-2) and from the battery. 

2) Unscrew the battery holders (two screws in the small battery and four screws in the 
large battery) with the attached battery temperature sensor.  (See Figure 3-3 below.) 

               

Figure 3-3 Backup Batteries – Exploded View 
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3) Remove the old battery from the RTU. 

4) Check the replacement battery visually.  If the battery looks deformed, if you notice 
corrosion on the battery terminals, or the battery leaks, DO NOT use the replacement 
battery; get another replacement battery.   

5) Check the replacement battery terminal voltage level before connecting it. If the 
battery voltage is less than 12.42V DC, DO NOT use the battery and replace it. 

6) If the replacement battery passed the visual inspection and the terminal voltage is 
satisfactory, put the battery into place on the RTU and screw in the battery holders. 

7) Connect the battery cable to the battery terminals in the correct polarity. 

8) Connect the battery cable to the Battery In/Out connector on the front panel of the 
power supply module. 

9) Recharge the replacement battery for 10 hours to be fully charged. 
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CPU MODULE 

General Description 
The main element of the ACE3600 is the CPU module. It controls the I/O modules, processes 
the gathered data and communicates with the outside world. 

The core of the module is Freescale’s MPC8270 32-bit microprocessor which has extended 
communication capabilities, high speed core, DMA and floating point calculation support.  The 
module includes on-board memory, communication ports, I/O bus interface and other circuits.  
The firmware is based on Wind River’s VxWorks operating system. 

Module Location: The CPU is a removable module located in a dedicated slot in the RTU rack. 
The CPU module must be plugged into the wide slot to the right of the Power Supply module.  
(Inserting the module in the wrong slot will not cause any damage to the CPU.) 

Figure 4-1 provides a general view of the ACE3600 CPU (Models 3610 and 3640). 
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Model 3610     Model 3640 
                       Figure 4-1  ACE3600 CPU – General View 
 

 

The CPU panel includes status LEDs, user LEDs, communication port LEDs, two pushbuttons, 
and communication ports.  The panel is covered by the module door. 
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Figure 4-2 provides a detailed view of the CPU front panel. 
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Figure 4-2  ACE3600 CPU (Model 3610/3640) – Front Panel 

Front Panel 

Communication Ports 
The CPU module includes several communication ports: 

On Board ports: 

• Serial 1  (SI1) – RS232/RS485 serial port (configurable)  

• Serial 2  (SI2) – RS232 serial port 

• Eth1  (E1) - 10/100BaseT Ethernet port (CPU 3640 only) 

Plug-in ports bays, where different types of ports can be installed: 

• Plug-in 1  (PI1) – fits RS232, RS485, 10 MB Ethernet, 10/100 MB Ethernet, or Radio 
Modem Plug-in option 

• Plug-in 2 (PI2) – fits RS232, RS485, 10 MB Ethernet, or Radio Modem Plug-in port 
option. 

For the detailed specifications of each port, see CPU 3610/CPU 3640 Module Specifications 
below.  For information on the cables and connectors, see Appendix C. 
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Buzzer 
The CPU module includes a buzzer (audio indication), which is used to indicate task 
completion (such as end of download/upload, restart etc.) and can also be controlled from the 
user application program.   

Pushbuttons 
The CPU includes two pushbuttons on the front panel, PB1 and PB2.   

These pushbuttons are used for activating and testing the modules LED, restarting the unit, 
erasing the user Flash memory and activating memory test.  Table 4-2 describes the 
pushbuttons functionality. 

The pushbuttons can also be monitored by the user application program (when it is running) for 
the application purposes. 

LEDs 
The CPU includes CPU status LEDs, port status LEDs, and user LEDs.  Some of the LEDs are 
single color (green) and some are bicolor LEDs (red, green or orange).  

Status LEDS indicate the CPU status in startup (boot), run-time or when there is a failure. The 
communication LEDs are used to indicate the communication port status. The user LEDs can 
be used by the user application program. Note that during startup or failure, the communication 
and user LEDs are used to indicate various situations. Table 4-4 details the LEDs functionality. 

CPU Memory  
The ACE3600 CPU includes Flash, SDRAM, and optional SRAM Plug-in memory.     

The Flash stores the firmware, the user application program, and the user data.   

The SDRAM memory stores the temporary data. 

The optional SRAM memory expansion is used for logging user data.  The SRAM data is 
retained using an on-board rechargeable lithium battery.    See Backup Battery for SRAM and 
RTC for more information. 

The size of the CPU memory is determined by the model as shown in the table below. 
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Table 4-1 ACE3600 CPU Memory 
 

 Model 
3610 

Model 
3640 

Flash memory 16 MB 16 MB 

SDRAM 
memory:  

32 MB 32 MB 

User Flash:  3 MB 3 MB  

User SDRAM:  10 MB 10 MB  

SRAM Plug-In 4 MB 4 MB 

Real Time Clock (RTC)  
The CPU includes a low drift RTC.  The date and time are retained using an on-board 
rechargeable lithium battery.   

The CPU date and time can be set using the ACE3600 STS.  The CPU can also be 
synchronized with other RTUs in the system, using the system clock.  For more information, 
see the Setting/Getting a Site’s Date and Time section or the Creating a User Application 
section of the ACE3600 STS User Guide. 

Backup Battery for SRAM and RTC 
The CPU module includes a rechargeable lithium battery that provides backup power and data 
retention for the SRAM and RTC.  

The lithium battery is located on the CPU board and cannot be replaced. 

Typically, the battery will retain the SRAM data and RTC for 60 continuous days without 
power and no Lead-Acid backup battery.  When the SRAM option is not used, the Lithium 
battery will keep the Real Time Clock running for a longer period of time. 

CPU Firmware and Operation Modes 
The CPU firmware is a real-time multitasking operating system, based on the Wind River 
VxWorks OS.  The CPU shipped from the factory with the most recent firmware version, and it 
can be updated/replaced using a remote or local connection.  Downloading firmware updates is 
performed using the STS.  (See Downloading to a Site in the ACE3600 STS manual.)  If the 
new firmware download stops or fails, the CPU will restart with the existing firmware. 

 

 

 



CPU Module 

4-5 

Power-up and Restart 
The CPU requires DC voltage provided by the power supply module via the motherboard 
(when the PS switch is ON).  The CPU will power-up and restart in the range of 10.8V to 16V 
DC.  During power-up, the processor performs fast memory tests, initiates the RTU and starts 
the user program (if one was downloaded).  The end of the power-up sequence is indicated by 
the buzzer.  The length of time from the beginning of CPU power-up until the user program 
starts running is approximately 10-15 seconds.  

It is possible to perform a comprehensive memory test during power-up by pressing push-
button PB1 for few seconds while switching the power supply from OFF to ON. In this case 
the power-up period is about 30-35 seconds long. 

If the startup fails, the RTU will freeze (boot sequence stops), the PWR LED will blink and the 
four indicator LEDs (see LEDs Location in Table 4-3) will blink seven times.  The four LEDs 
will then display the failure error in binary code, as described in Table 4-3.   

Restart after Firmware Download 
The RTU will restart after downloading system firmware.  If the firmware is faulty or the 
firmware download failed, the RTU, if protected by the Safe Firmware Download feature, will 
restart and roll back to the previous firmware version.  A failure message will appear in the 
STS Downloader screen.  For information on using the Safe Firmware Download feature, see 
the Safe Firmware Download section of the ACE3600 STS Advanced Features manual. 

Restart after Configuration Download 
The RTU will restart after downloading a site configuration.  For information on downloading 
to the RTU, see the Operation chapter of the ACE3600 STS User Guide. 

If the RTU fails to restart after the user-defined site configuration was downloaded, a unique 
LED display (in the range of the PI1-TX and SI2-RX LEDs) and a series of buzzer tones will 
follow.  The RST LED will turn RED and the RTU will restart itself with the previous “good” 
configuration.  The following message will appear in the RTU Error Logger “Configuration 
file was deleted due to failure in startup. Rolling back to the last configuration file”.  Errors can 
be retrieved from the RTU using the ACE3600 STS Error Logger utility.   

If the startup succeeds after configuration download but has errors, these errors are reported in 
the RTU Error Logger.  It is, therefore, recommended to check for errors after downloading a 
configuration file to the RTU.  Errors can be retrieved from the RTU using the ACE3600 STS 
Error Logger utility.   

For information on retrieving errors from the RTU Error Logger, see the Operation chapter of 
the ACE3600 STS User Guide. 

Restart after Erase Flash 
After the User Flash is erased, the RTU will restart successfully with the default site 
configuration.   

Power-down 
When the voltage provided to the CPU module drops below the minimum level, the CPU will 
shut down in an orderly fashion.  This level is configurable for all power supply modules other 
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than the 12V DC power supply low-tier.  See the ‘Minimum DC operation voltage’ parameter 
in Appendix A: Site Configuration Parameters of the ACE3600 STS User Guide. 

CPU Status and Diagnostics 
The CPU status is indicated on the front panel LED.  Detailed CPU status and diagnostics 
information can be retrieved from the module using the CPU Hardware Test utility.  For more 
details, see the Hardware Test section of the ACE3600 STS User Guide. 

CPU Warnings and Errors 
CPU warnings and errors are logged in the CPU memory to indicate issues or errors during 
power-up, restart, user application program execution and other modes of CPU operation.  The 
existence of CPU warnings and errors are indicated in the ERR LED on the front panel of the 
module.  Green indicates a message, orange indicates a warning and red indicates an error.     

The CPU error logger information can be retrieved using the STS Error Logger utility.  For 
more details, see the Error Logger section of the ACE3600 STS User Guide. 

CPU Serial Number 
Each CPU has a unique serial number. This number is printed on a label on the side of the CPU 
module front panel.  The serial number can be read using the STS Hardware Test and is also 
available to the user application program.  For more information, see the Hardware Test section 
or the Creating a User Application section of the ACE3600 STS User Guide. 

Connecting Plug-In Ports to the CPU Module 
In general, the plug-in ports are ordered as options with the RTU and are installed in the 
factory.  However, it is also possible to add plug-in ports to the CPU after it is shipped from the 
factory.  Several plug-in ports are available.  See  Communication Ports above.  

Note: A TORX screwdriver is required for installation of the plug-in ports.  
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Figure 4-3 depicts a plug-in port board attached to the ACE3600 CPU module. 

Supporting 
Pins

Plug-in 1 

Plug-in 2 

Supporting 
Pins

 

                             Figure 4-3  Plug-In Port in CPU Module 
Procedure 4-1 describes how to connect a plug-in port to the CPU. 

Procedure 4-1 How to Connect a Plug-in Port to the CPU  

1) Remove the CPU module from the RTU. 

2) Remove the cover from the desired opening on the front panel.  

3) Connect two supporting pins with screws to the plug-in port. 

4) Place the plug-in board with the RJ-45 connector facing the panel.  Carefully insert the 
plug-in board connector into the appropriate connector on the CPU board. 
For Ethernet 10/100 MB, use the J14 connector on the CPU (Plug-in 1 only.) 
For all other plug-in ports, use the J5 (Plug-in 1) or J6 (plug-in 2) connector. 

5) Connect the two supporting pins with screws to the other side of the CPU board. 

6) Replace the CPU module in the slot. 

Connecting SRAM Expansion Memory to the CPU Module 
In general the plug-in SRAM is ordered as an option with the RTU and is installed in the 
factory. However, it is also possible to add plug-in SRAM to the CPU after it is shipped from 
the factory.  
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Note: A TORX screwdriver is required for installation of the SRAM.   

Figure 4-4 depicts the user SRAM Plug-in memory in the ACE3600 CPU module. 

 

                                Figure 4-4  SRAM Expansion in CPU Module 
 

Procedure 4-3 describes how to connect a plug-in SRAM memory card to the CPU. 

Procedure 4-2 How to Connect a Plug-in SRAM Memory Card to the CPU 

1) Remove the CPU module from the RTU. 

2) Remove the cover from the connector marked P12 on the CPU board.  

3) Place the plug-in SRAM memory card with the connector facing the panel.  Carefully 
insert the plug-in board connector into the connector on the CPU board. 

4) Secure the memory card to the CPU board with the supplied screw. 

5) Replace the CPU module in the slot. 
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Pushbutton Functionality 
The table below describes the use of the two pushbuttons in various scenarios, during power-up 
and run-time.  To press a pushbutton during startup, first press the pushbutton(s), then turn on 
the RTU using the On/Off switch on the front panel.  Keep the pushbutton(s) depressed for the 
required number of seconds, as specified in the scenarios below. 

Table 4-2 ACE3600 Pushbutton Functionality 
 

Scenario Trigger Action  

LEDs Test During run-time, press PB1 
for five or more consecutive 
seconds (but less than 30).   

All the LEDS on the CPU and I/O modules 
will be lit until let go of PB1 and then 
returned to their previous states. 

RTU Restart During run-time, press PB1 
for 30 consecutive seconds. 

All the LEDs will be lit. Then all the LEDs 
will blink once. 

The buzzer will buzz several short beeps.  
(If PB1 is released during this time the 
restart will not be performed.) 

At the long beep, release PB1 and the RTU 
will restart (and the buzzer will buzz.) 

Turn LEDs ON During run-time, press PB1 
for one second. 

Those LEDs which are currently active 
will be turned on for a period of time 
(configured in the RTU configuration 
using the STS.)  

RAM Test During startup, press PB1.  A detailed memory test of SDRAM and 
SRAM plug-in is performed. 

- At the beginning of the RAM test, the 
four indicator LEDs (see LEDs Location in 
Table 4-3) will blink three times.  During 
the RAM test, the LEDs may blink or be 
lit. 

If the RAM test succeeds, the four LEDs 
will blink three times and turn off and the 
restart sequence will continue.  

If the RAM test fails, the RTU will freeze 
(restart sequence stops), the PWR LED 
will blink and the four LEDs will blink 
seven times.  The failure error code will 
then be displayed on the LEDs, in binary 
code, as described in Table 4-3. 

- To exit/abort the RAM test in the middle, 
restart the RTU using the On/Off switch on 
the front panel. 
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Scenario Trigger Action  

Erase User 
Flash 

During startup, press both 
PB1 and PB2 simultaneously 
until the buzzer buzzes five 
times quickly, then 
continuously for three 
seconds.  

All the user Flash memory content 
excluding logging files (files tagged as 
data logging files) is erased, including the 
site configuration, user application 
programs, user tables, etc. 

Bootstrap During startup, press PB2 
continuously for five 
seconds. 

The RTU will start up in diagnostic mode.  
Communication with the RTU is for 
diagnostic purposes only (Error Logger/ 
SW Diagnostics.)  You cannot download to 
the RTU and no application will run. 

If the bootstrap fails, the four indicator 
LEDs (see LEDs Location in Table 4-3) 
will display the failure error in binary 
code, as described in Table 4-3. 

 

Table 4-3 ACE3600 Failure - Error Code Display on LEDs 
 

LEDs Location LED Error Code Description  

ERR Code 1

 

ERR Code 1 = Error in Flash 

ERR Code 2

 

ERR Code 2 = Error in SDRAM 

ERR Code 3

 

ERR Code 3 = Error in SRAM 

ERR Code 4

 

ERR Code 4 = Unable to boot.  
                        Corrupted bootstrap. 

Ethernet LEDs
in ACE 3640

 
On CPU 3640, the 
four LEDs begin 
with the group 
marked E1, as 
above.   
On CPU 3610, the 
four LEDs are 
unmarked, but can 
be found after the 
S2 group.  

ERR Code 6

 

-ERR Code 6 = Low voltage under 12V 

 

Where OFF LED = '0';   
           ON   LED = '1'  (very fast blink, almost  
           continuous);  
The highest LED is the most significant. 
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CPU LEDs Behavior 
The table below describes the behavior of the LEDs on the CPU module.  

Table 4-4 ACE3600 CPU LEDs Behavior 
 

LED Name Description Status 

PWR Power LED  

Bicolor LED (Red, Green) 

Flashing Red – Power exists; CPU FPGA not 
loaded. 

Green – Power exists; CPU is running from a 
recognized power supply (one of the six 
power supply options.) 

Red – Failure on power-up. CPU is running 
without power supply. 

ERR Error Logger Status LED 

Bicolor LED (Red, Green) 

OFF – No new errors or warnings. 

Green – New message logged. 

Orange – New warning logged.  

Red – New error logged. 

RST Reset LED  

Bicolor LED (Red, Green) 

Green – On startup 

OFF – Successful power-up or restart. 

Red – Power-up or restart failed. 

APPL Application LED 

Bicolor LED (Red, Green) 

OFF - No user application program in the 
Flash memory. 

Green - User application program is running. 

Orange - User application program was 
paused by user (during Hardware Test.) 

CONF Configuration LED 

Bicolor LED (Red, Green) 

OFF – Configuration was not loaded. 

Green - Configuration was loaded. 

Red - Configuration error. 

PI1 TX Plug-in Port 1 – TX 
(transmit)  

Green LED 

ON- Transmitting Data 

PI1 RX Plug-in Port 1– RX (receive) 

Green LED 

ON – Receiving Data 

PI1 CM Plug-in Port 1 – CM (channel 
monitor) 

Green LED 

ON – Channel Busy (if port is in use by radio, 
          RS485, or RS232) 
       – Network Connected (if an IP plug-in is 
          used) 
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LED Name Description Status 

SI1 TX Serial Port 1 – TX (transmit) 

Green LED 

ON – Transmitting Data 

SI1 RX Serial Port 1 – RX (receive) 

Green LED 

ON – Receiving Data 

SI1 CM Serial Port 1 – CM (channel 
monitor) 

Green LED 

ON – Channel Monitor is ON. 

S2 TX Serial Port 2 – TX (transmit) 

Green LED 

ON – Transmitting Data 

S2 RX Serial Port 2 – RX (receive) 

Green LED 

ON – Receiving Data 

S2 CM Serial Port 2 – CM (channel 
monitor) 

Green LED 

ON – Channel Monitor is ON 

E1 LNK* Ethernet Port 1 (link)  

Green LED 

ON – Network Connected 

In case of RAM test and startup failure, see 
Table 4-2 and Table 4-3. 

E1 RX* Ethernet Port 1 (receive)  

Green LED 

ON – Receiving Data 

In case of RAM test and startup failure, see 
Table 4-2 and Table 4-3. 

PI2 TX Plug-in Port 2 – TX 
(transmit) 

Green LED 

ON – Transmitting Data 

PI2 RX Plug-in Port 2 – RX (receive) 

Green LED 

ON – Receiving Data 

PI2 CM Plug-in Port 2 – CM (channel 
monitor) 

Green LED 

ON – Channel Busy (if port is in use by radio, 
          RS485, or RS232) 
       – Network Connected (if an IP plug-in is 
          used) 

USR1-
USR4 

User application program 
LEDs  

Green LED 

Controlled by the user application program. 

Light consecutively and repeatedly one after 
the other when entering boot mode. 

 
* The LED names E1 LNK and RX appear only in CPU 3640. 
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CPU 3610/CPU 3640 Module Specifications 
Microprocessor Freescale – Power PC II MPC8720, 32-bit, extended communication 

capability, DMA and floating point calculation support 

Microprocessor Clock 200 MHz 

Memory Flash: 16 MB/3 MB free for user 
DRAM: 32 MB/10 MB free for user 
SRAM plug-in (Optional): 4 MB total, all free for user 

Real-Time Clock Full calendar with leap year support (year, month, day, hours, minutes, 
seconds). 
Time drift: max. 2.5 Seconds per day (when power is on) 

SRAM and RTC 
Retention  

3 V Rechargeable lithium backup battery 

Serial Port 1 Configurable RS232 or RS485 port: 
 - RS232: Asynch, Full Flow Control, up to 230.4 kb/s, GPS receiver interface 
 - RS485, multi-drop 2-Wire up to 460.8 kb/s  

Serial Port 2 RS232, Asynch, Full Flow Control, up to 230.4 kb/s, GPS receiver interface 

Plug-In Port 1 Supports the following Plug-In ports: 
- Radio Modem, DPSK 1.2 kb/s, FSK 1.2/1.8/2.4 kb/s,  
    DFM 2.4/3.6/4.8 kb/s  
- RS232, Sync/Asynch, Full Flow Control, up to 230.4 kb/s,  
    GPS receiver interface 
- RS485, multi-drop 2-Wire up to 460.8 kb/s 
- Ethernet 10/100 Mb/s 

Plug-In Port 2 Supports the following Plug-In ports: 

- Radio Modem, DPSK 1.2 kb/s, FSK 1.2/1.8/2.4 kb/s,  
    DFM 2.4/3.6/4.8 kb/s  
- RS232, Sync/Asynch, Full Flow Control, up to 230.4 kb/s,  
    GPS receiver interface 
- RS485, multi-drop 2-Wire up to 460.8 kb/s 
- Ethernet 10 Mb/s 

Ethernet Port 1 10/100 Mb/s (on CPU 3640 only) 

LEDs Display 4 CPU diagnostic LEDS, Port status LEDs and user application LEDs  

Power Consumption 
(measured at power 
supply in) 

Typical: 4W (280 mA @ 13.8VDC); LEDs on: 4.4W (320mA @ 13.8VDC) 

Operating Voltage 10.8-16 V DC (from the motherboard connector) 

Dimensions 56 mm W x 225 mm H x 180 mm D (2.2" W x 8.7" H x 7.1" D)  

Weight Approx. 0.38 Kg  (0.84 Lb) 

Specifications subject to change without notice. 
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I/O MODULES 

General Description 
The ACE3600 RTU can include up to eight I/O modules, depending on the frame size.  A 
variety of I/O modules are available. 

The I/O modules can be positioned in the slots to the right of the CPU.  As with all ACE3600 
modules, the I/O modules can be replaced while the power is on (hot swap.) 

Figure 5-1 provides a general view of an ACE3600 I/O module. 
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I/O Module with Two TBs     I/O Module with Expanded TBs 
Figure 5-1  ACE3600 I/O Module – General View 

 

Each I/O module includes an ERR status LED, individual I/O status LEDs, an array of I/O 
connectors, and a coding mechanism for the terminal cable connector or TB holder option. 

Figure 5-2 provides a detailed view of the I/O front panel. 
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Figure 5-2  ACE3600 I/O Module – Front Panel (without TB Holder) 
 

I/O Module LEDs 
The ERR LED indicates an I/O module fault and errors.  It will remain lit until all the errors 
have been eliminated.  Diagnostic and error messages can be retrieved from the module using 
the ACE3600 STS Error Logger or SW Diagnostics.  For more information, see the ACE3600 
STS User Guide. 

The I/O status LEDs in Digital Input (DI) and Digital Output (DO) modules indicate ON and 
OFF (LED lit when the I/O is ON.)  In Analog Input (AI) modules, each input has two LEDs, 
indicating Overflow (OF) and Underflow (UF).  In Analog Output (AO) modules, each output 
has three LEDs, indicating voltage output (Vout), current output (Iout), and calibration (Cal). 

I/O Module Test 
The I/O modules can be tested using the STS Hardware Test utility.  For more information, see 
the ACE3600 STS User Guide. 

The I/O module LEDs can be tested using the STS Hardware Test utility– all the LEDS are lit 
for a number of seconds, and then turned back to their previous state. 

Panel Terminal Block (TB) Connectors 
Each I/O module can be ordered either with a set of two/four TB connectors or a TB holder.  
(See TB Holder and Cables below.)  Each TB connector has a fixed female side on the module 
and a male plug for the sensor/device wire connection.  The TB male side in all modules is 
screw type for up to 1mm (18 AWG) wire.  A TB extractor (FHN7063A) is available for easy 
removal of TBs. 
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Figure 5-3  TB Connector-Male/Female 
 

Procedure 5-1  Extracting the TB Connector from the I/O Module 

1) Open the door of the I/O module to expose the TB connectors (2-4).  

2) Position the TB extractor over the desired TB connector, with the small notch facing to the 
right.  (See Figure 5-4.)   

3) Press the center of the TB extractor from both sides to open the two sides of the clamp end.  

4) Clamp the open TB extractor over the desired TB connector and pull on the back handle to 
extract the TB connector from the I/O module. 
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Figure 5-4  TB Extractor 

TB Holder and Cables  
The TB holder secures the male TBs neatly in place and forms a single connector plug per 
module.  The wires connected to the TBs are concealed in the holder.  The module and the TB 
holder provide a coding mechanism to prevent cabling errors.  Ejector handles enable easy 
release of the TB holder connector from the module.  An optional three-meter cable braid, 
completely wired with holder and cable, is available.  

A TB holder kit is available to enable self-assembly of cables.  User assembled cables should 
use wires of up to 0.4mm (26 AWG).  The TB holder kit does not include a cable. 

Note that a TORX screwdriver is required for assembling the TB holder and a flat screwdriver 
is required for setting the code key pin. 
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               Figure 5-5  Terminal Block (TB) Holder-Front and Back View 
 

Assembling the TB Holder Parts 
Procedure 5-1  Assembling the TB Holder Parts  

If the TB holder kit is ordered, follow the procedure below: (See Figure 5-6) 

1) Prepare the cable by cutting the wires to fit the TBs.  Connect the wires of the user-
assembled cables to the TBs, following the pin descriptions on the module panel label 
(where pin 1 is at the top of first TB and so on downwards.) 

2) Place the TBs onto the left part of the TB holder plastic.  

3) Add the top ejector handle, the code key and the positioner.   

4) Close the right side of the plastic TB holder over the left side.  

5) Screw together the assembly using the three screws provided in the kit.     
Note the lower screw holds the positioner into place.) 

6) Insert the lower ejector handle at the bottom of the TB holder.   

7) Slide the metal axis into lower ejector handle from the side.   

Once the TB holder is assembled, it can be connected to the I/O module. 
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Figure 5-6 provides an exploded view of the TB holder assembly. 

 

Figure 5-6  Terminal Block (TB) Holder Assembly – Exploded View with Coding 
 

Attaching the TB Holder Clip to the I/O Module 
An optional TB holder clip can be added to the I/O module to secure the cable. 

Procedure 5-2  Attaching the TB Holder Clip to the I/O Module 

1) Remove the I/O module from the ACE3600 RTU. 
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2) Using the supplied screw, attach the TB holder clip to the bottom of the I/O module.  (see 
Figure 5-7) 

3) Replace the I/O module in the RTU slot. 

I/O Module

Cable Pipe

TB Holder 
Clip Screw

TB Holder 
Clip 

 

Figure 5-7  I/O Module with Terminal Block (TB) Holder Clip  
 

Connecting the TB Holder to the I/O Module 
Procedure 5-3  Connecting the TB Holder to the I/O Module 

1) Open the door of the I/O module. 

2) On the TB holder, loosen the screw and turn the positioner so that the arrow points to 
either A or B.   

3) Tighten the screw. 

4) With a flat screwdriver, set the code key pin to a number from 1 to 6.   

5) On the I/O module, using a flat screwdriver, set the pin to the same number (from 1 to 6.)  
This ensures that the TB holder will not be accidentally connected to the wrong I/O 
module. 

6) Slide the plastic lip on the bottom of the I/O module to either A (up) or B (down) (as in 
Step 2).  

7) Align the plastic lip with the flat edge of positioner on the TB holder and snap the TB 
holder into the I/O module, (see Figure 5-8), fitting the code key pin into the code key. 

8) If the ejector handles are extended, push them inwards, against the TB holder (see Figure 
5-8.) 

9) If a TB holder clip was attached to the I/O module, slide the cable between the two edges 
of the clip, and press the clip closed to secure the TB holder to the module. See Figure 5-7. 
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10) Label the TBs wires with any desired user notes.  The wires are numbered 1-20 or 1-40 
depending on the model.  The wire numbers correspond to the module pins.   

11) To extract the TB holder from the I/O module front panel, extend the ejector handles 
outward away from the module and pull on the handles. 

Figure 5-8 provides a general view of the TB holder and an I/O module. 

TB Holder

Terminal 
Blocks (TB)

Ejector
Handles

Code Key 

OF

OF

UF
16

24V

Positioner

Terminal Block (TB)

I/O Module

Code Key 

Positioner

Terminal Block (TB)

TB Holder

Screw 

I/O Module

 
 

Figure 5-8  Terminal Block (TB) Holder on I/O Module – General View with Coding 

Wired Cable Braid 
The optional three-meter cable braid is completely wired with a TB holder and either 20-wire 
or 40 wire cable.  Each wire in the cable is labeled with the corresponding pin number.  This 
information is useful when connecting the PGND to the grounding strip.  See the Connecting 
I/O Modules to Ground section of the Installation chapter. 

User Label 
Each I/O module is provided with a blank label on the module door for user notes. 
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Inserting/Removing an I/O Module from the Rack 
I/O modules support hot-swap and can be inserted and extracted while the system is powered 
up.  For instructions on removing/inserting an I/O module from/into a rack, see the Replacing 
an I/O Module section of the Break-Fix Procedures chapter below. 

Automatic Module ID 
Each I/O module has a unique module type ID number.  When the RTU is powered up or when 
an I/O module is inserted into a slot (hot-swap), the CPU automatically identifies the module 
type.   

The module ID can be viewed from the STS Hardware Test utility.  For more information, see 
the Hardware Test section of the ACE STS User Guide. 

24V DC Floating Plug-In Power Supply 
Up to two 24V DC floating plug-in power supplies can be added to certain I/O modules, as 
detailed in the table below. Up to four 24V DC floating plug-in power supplies can be added 
per rack.  (For guidelines on remaining within the maximum system power consumption, see 
Appendix D: ACE3600 Maximum Power Ratings below.) 

Table 5-1 Number of Plug-In Power Supplies in ACE3600 I/O Modules  
 

Module Type Number of Power 
Supplies 

32 DI 2 

16 DI 1 

16 AI 1 

8 AI 1 

Mixed I/O 1 

Mixed Analog 1 

 
The plug-in power supply is ordered separately.   

Before installing the 24V DC floating plug-in power supply card on the I/O module, please 
verify that the FPGA version of the I/O module is as follows: 

I/O Module Type FPGA Version 

AI module (all types) Version 1.5.002 or higher. 

DI module (all types) Version 2.1.004 or higher. 

Mixed I/O module (all types) Version 1.5.004 or higher. 
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Use the ACE36000 STS Hardware Test utility to retrieve the FPGA version from the unit.  If 
the FPGA version listed in the Module Diagnostics is lower than the version in the chart above, 
you must upgrade the I/O version by downloading a higher version FPGA file using the STS.  
Contact your local support team for the updated FPGA file. 

Procedure 5-4  Attaching the Power Supply to the I/O Module  

Attach the power supply to the I/O module using the following procedure.  Note that a TORX 
screwdriver is required. 

1) Remove the cap from the 40-pin connector on the power supply plug-in.  

2) Place the plug-in onto the board with the connector attached and the spacers over the holes 
on the board. 

3) Screw the four supplied metals screws into the spacers to secure the plug-in.    
The RTU will automatically recognize the 24V power supply. 

Each plug-in power supply output is controlled by the CPU module.  By default, the plug-in 
power supply is ON and can supply up to 150mA.  The power supply plug-in can be turned 
ON/OFF via the user application program or Hardware Test utility.   

Figure 5-9 provides a general view of an I/O module with one plug-in. 
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Figure 5-9 ACE3600 I/O Module with a 24V Floating Power Supply Plug-In 
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24V DC Floating Plug-In Power Supply Module Detailed 
Specifications 

 

Input Voltage 10.8-16 V (from I/O module) 

Outputs 24V floating, max. 150 mA 

Efficiency 75% typical 

Protection Automatic output shut down on over-voltage and over-current 

Insulation Input to output: 1500 V AC 

Dimensions 78 mm W x 15 mm H x 68 mm D (3.1" W x 0.6" H x 2.7" D) 
Weight Approx. 0.04Kg  (0.09 Lb)  

Specifications subject to change without notice. 
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DIGITAL INPUT MODULE 

General Description 
The ACE3600 Digital Input (DI) module can have 16 or 32 inputs. 

The following DI modules are available. 

• 16 DI Fast 24V  

• 32 DI Fast 24V  

• 16 DI Fast 24V IEC TYPE 2  

• 32 DI Fast 24V IEC TYPE 2 

Two types of voltage (“wet”) inputs are supported, IEC 61131-2 Type II compliant inputs and 
24V “MOSCAD compatible” inputs.  In the 32 DI module, the first 20 inputs can function as 
fast counters. In the 16 DI module, all inputs can function as fast counters.  A counter's 
maximum rate is dependent on the module type (see the specifications below.)  

All the inputs are optically isolated.  The DI modules support optional 24V DC floating plug-in 
power supplies (for contact “wetting” or other purposes). 

Each DI can be an event trigger (interrupt-driven) to a high priority fast process.  The high 
priority fast process enables very fast activation of an output in response to an input trigger and 
logical conditions.  This high priority fast process is not dependent on the I/O scan (refer to the 
STS Application Programmer manual.) 

For a description of I/O module construction, location, LEDs, TBs, and other common I/O 
module features, see the I/O Modules chapter above. 

Figure 6-1 provides a general view of the ACE3600 DI module. 
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16 DI Module        32 DI Module  
Figure 6-1  ACE3600 DI Module – General View 

 

Figure 6-2 provides a detailed view of the ACE3600 DI module front panel. 
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16 DI Module   32 DI Module  
Figure 6-2  ACE3600 DI Module – Front Panel 

 

DI Module Configuration 
The 16 DI Fast 24V and 32 DI Fast 24V modules can handle AC and DC input signals. The 
user can select DC or AC operation per module. When AC configuration is selected, the Fast 
Capture, Counter Function and Input Filters (see below) are disabled. 

Fast Capture (DC Configuration) 
When the DI module is in DC mode, each DI can be configured as a Fast Capture DI.  Fast 
capture causes the SCAN ladder output operation to get the first change that occurred since the 
previous scan. When fast capture is disabled, the scan gets the current value of the DI (in this 
case, any DI changes between scans are missed.) 

Input Filters (DC Configuration) 
When the DI module is in DC mode, each input has a HW input filter to make sure that the 
input reading is stable.  The range of the HW DI filter is  0 to 50.8 millisecond (in 0.2 mS 
steps). The Fast Counter DI filter range is 0 to 12.75 millisecond (in 0.05 mS steps).   

Event Time Tagging  
Each DI can be set in the user application program’s I/O link table to trigger recording of time 
tagged events upon any input change of state.  The time tagged events are recorded in the CPU 
memory and can be retrieved for various purposes.   
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Keep Last Value (KLV) and Predefined Value (PDV) 
Each input can be configured to KLV or to a PDV (0, 1). This value is shown to the user 
application program in the event of DI module failure.  The PDV can also be used during 
normal operation to force a value that masks the actual input value.  In this case the user 
program will get the PDV instead of the actual input value.  

DI Module Configuration Options 
The DI module features which can be configured are listed in the table below. Some parameters 
are per module and some are per input. 

Table 6-1  ACE3600 DI Module Configurable Features  
 

Feature Parameter 
Settings 

Default Setting Per Module / 
Input 

Parameter Setup 
Location 

DC or AC 
operation∗ 

AC / DC DC Module STS site 
configuration 

Fast Capture Disabled 
/Enabled 

Disabled Input STS site 
configuration 

DI Filter (DC) 0-254 (x 0.2 
mS) 

50 * 0.2 mS 
(=10 mS) 

Module STS site 
configuration; 
‘C’ User Program 

Counter Filter 
(DC) 

0-255 (x 0.05 
mS) 

20 * 0.2 mS  
(= 1 ms) 

Module STS site 
configuration 
‘C’ User Program 

Event Time 
Tagging 

Disabled/ 
Enabled 

Disabled Input User Program I/O 
link table 

Keep Last Value 
and Predefined 
Value 

KLV/PDV 
PDV=0/1 

KLV Input User Program I/O 
link table 

Mask No /Yes No Input User Program I/O 
link table 

Sleep Mode 
Each DI module can be switched by the user application program to Sleep Mode.  In Sleep 
Mode, the module does not function and the power consumption is minimized. During Sleep 
mode, the user application program will get the predefined values (PDV) for each I/O. 

                                                      
∗ in Fast 24V IEC TYPE II modules –only DC 
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Module Status and Diagnostics 
In the event of DI Module failure, the I/O module ERR LED will be lit.  This event is 
registered by the CPU in the Error Logger.  DI Module failure status is also visible to the user 
application program.  

The DI module can be diagnosed and monitored using the STS Hardware Test utility. This test 
verifies that the module is operational, presents the module configuration and shows the actual 
value of each input. It is also possible to change the input filter setup temporarily for the 
duration of the Hardware Test. 

In the Hardware Test utility, it is possible to set the DI module to Freeze Mode. In this mode 
the user application program will get the predefined value of each input in the module, instead 
of the actual input value. Freeze mode enables testing the inputs while the user application 
program is running. 

For details on configuring the DI modules, see the Site Configuration section, and the 
Application Programming section of the STS User Guide. 
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Module Block Diagram 
16 DI 
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32 DI 
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Connection Charts 
  16 DI        32 DI 

Pin Function Pin Function  Pin Function Pin Function 

1 DI1 11 DI11  1 DI1 21 DI17 

2 DI2 12 DI12  2 DI2 22 DI18 

3 DI3 13 DI13  3 DI3 23 DI19 

4 DI4 14 DI14  4 DI4 24 DI20 

5 DI5 15 DI15  5 DI5 25 DI21 

6 DI6 16 DI16  6 DI6 26 DI22 

7 DI7 17 +24V  7 DI7 27 DI23 

8 DI8 18 COM1  8 DI8 28 DI24 

9 DI9 19 PGND1  9 DI9 29 DI25 

10 DI10 20 PGND1  10 DI10 30 DI26 

     11 DI11 31 DI27 

     12 DI12 32 DI28 

     13 DI13 33 DI29 

     14 DI14 34 DI30 

     15 DI15 35 DI31 

     16 DI16 36 DI32 

     17 +24V 37 +24V 

     18 COM1 38 COM2 

     19 PGND1 39 PGND2 

     20 PGND1 40 PGND2 
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DI Module Specifications 
16/32 DI FAST 24V Module  

Total Number of Inputs 16 DI; 32 DI  

Input Arrangement Isolated groups of 16 inputs with shared common  

Fast Counter Inputs Inputs that can be used as fast counters: 
- All inputs in 16 DI module; - First 20 inputs in 32 DI module 

AC Input Frequency 45 – 65 Hz 

AC Input Delay Maximum 0.2 mS 

Fast Counter Input Frequency 0 - 12.5 KHz, minimum pulse width 40 µS 

Max. DC Input Voltage Max. ±40 V DC (relative to input common) 

“ON” DC Voltage Range +9 to +30 V DC,  -30 to -9 V DC  

“OFF” DC Voltage Range -3 to +3 V DC 

“ON” AC Voltage Range 10 to 27 V AC (RMS) 

“OFF” AC Voltage Range 0 to 5 V AC (RMS) 

Input Current Max. 2.5 mA 

Fast Capture Resolution 1 mS (Interrupt upon change of state) 

Event Time Tagging Resolution 1 mS (Interrupt upon change of state) 

Input Filtering 0 to 50.8 mS (DC, programmable in 0.2 mSec steps) 

Counter Input Filtering 0 to 12.75 mS (programmable in 0.05 mSec steps for inputs configured as 
high speed counters) 

24 V DC Output Supports optional isolated 24 V plug-in “Wetting” Power Supply  
(one in 16 DI, two in 32 DI) 

Diagnostic LEDs Status LED per each input, module error LED, 24V plug-in status LED 

User Connection 2 or 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG 

Cable and TB Holder 20 or 40 Wire Cable with TB Holder connector, 26 AWG wires 

Module Replacement Hot swap replacement – module extraction/insertion under voltage 

Input Isolation 2.5 kV DC/AC between input and module logic per IEC255-5 

Input Insulation Insulation resistance 100 MΩ @ 500 V DC,  
Insulation impulse 5 kV per IEC255-5 

Operating Voltage 10.8-16 V DC and 3.3 V DC (from the motherboard connector) 

Power Consumption 
(measured at power supply in) 

16 DI: 0.32 W typical with all LEDs on (23 mA @ 13.8 VDC) 
32 DI: 0.55 W typical with all LEDs on (40 mA @ 13.8 VDC) 
(Not including 24 V DC Plug-in Power Supply power consumption) 

Dimensions 37 mm W x 225 mm H x 180 mm D, (1.5“ W x 8.7“ H x  7.1“ D) 

Weight 16 DI: approx. 0.28 Kg  (0.62 Lb); 32 DI: approx. 0.29 Kg (0.63 Lb) 
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16/32 DI FAST 24V IEC 61131-2 TYPE II Module 

Total Number of Inputs 16 DI  
32 DI  

Input Arrangement Isolated groups of 16 inputs with shared common  

Fast Counter Inputs Inputs that can be used as fast counter: 
- All inputs in 16 DI module 
- First 20 inputs in 32 DI module 

Fast Counter Input Frequency 0 - 10 KHz, minimum pulse width 50 µS 

Max. DC Input Voltage Max. ±40 V DC (relative to input common) 

“ON” DC Voltage Range +11 to +30 V DC, -30 to -11 V DC 

“OFF” DC Voltage Range -5 to +5 V DC 

Input Current 6-10 mA 

Fast Capture Resolution 1 mS (Interrupt upon change of state) 

Event Time Tagging Resolution 1 mS (Interrupt upon change of state) 

Input Filtering 0 to 50.8 mS (DC, programmable in 0.2 mSec steps) 

Counter Input Filtering 0 to 12.75 mS (programmable in 0.05 mSec steps for inputs configured 
as high speed counter) 

24V DC Output Supports optional isolated 24 V plug-in “Wetting” Power Supply  
(one in 16 DI, two in 32 DI) 

Diagnostic LEDs Status LED per each input, module error LED, 24V Plug-in status 
LED 

User Connection 2 or 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG 

Cable and TB Holder 20 or 40 Wire Cable with Terminal Block Holder connector,  
26 AWG wires 

Module Replacement Hot swap replacement – module extraction/insertion under voltage 

Input Isolation 2.5 kV DC/AC between input and module logic per IEC255-5 

Input Insulation Insulation resistance 100 MΩ @ 500 V DC,  
Insulation impulse 5 kV per IEC255-5 

Operating Voltage 10.8-16 V DC and 3.3 V DC (from the motherboard connector) 

Power Consumption 
(measured at power supply in) 

16 DI: 0.32 W typical with all LEDs on (23 mA @ 13.8 VDC) 
32 DI: 0.55 W typical with all LEDs on (40 mA @ 13.8 VDC) 
(Not including 24 V DC Plug-in Power Supply power consumption) 

Dimensions 37 mm W x 225 mm H  x 180 mm D, (1.5“ W x 8.7“ H x  7.1“ D) 

Weight 16 DI: approx. 0.28 Kg  (0.62 lb) 
32 DI: approx. 0.29 Kg (0.63 lb) 

Specifications subject to change without notice. 
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DIGITAL OUTPUT/DIGITAL INPUT FET MODULE 

General Description 
The Digital Output/Digital Input (DO/DI) FET module has 16 or 32 configurable user 
connections, organized in four groups.  Each group can be configured as an 8 DO group or as 
an 8 DI group.  

The following Digital Output/Digital Input (DO/DI) FET modules are available. 

• 16 (DO/DI) FET 

• 32 (DO/DI) FET 

The outputs are optically isolated current sink FET type with back indication. The inputs are 
optically isolated Dry Contact type with internal “wetting” voltage. 

For a description of I/O module construction, location, LEDs, TBs, and other common I/O 
module features, see the I/O Modules chapter above. 

Figure 7-1 provides a general view of the ACE3600 DO/DI FET module. 

                        

    16 DO/DI FET Module   32 DO/DI FET Module 
    Figure 7-1  ACE3600 DO/DI FET Module – General View  
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Figure 7-2 provides a detailed view of the ACE3600 DO/DI FET module front panel. 

                               

16 DO/DI FET Module   32 DO/DI FET Module 
                     Figure 7-2  ACE3600 DO/DI FET Module – Front Panel 

Module Configuration 

Input/Output 
The following combinations can be configured in the STS site configuration (16 DO/DI). 

I/O combination DI location DO location 

16DO - 1-16 

8DI  + 8DO 1-8 9-16 

16DI 1-16 - 
 

The following combinations can be configured in the STS site configuration (32 DO/DI). 

I/O combination DI location DO location 

32DO - 1-32 

8DI  + 24DO 1-8 9-32 

16DI + 16DO 1-16 17-32 

24DI + 8DO 1-24 25-32 

32DI 1-32 - 
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The appropriate combination is selected as the I/O module type, when configuring the I/Os in 
the ACE3600 STS site configuration.  

DI Fast Capture 
Each DI can be configured as Fast Capture DI in the STS advanced I/O configuration. Fast 
capture causes the SCAN ladder output operation to get the first change that occurred since the 
previous scan. When fast capture is disabled (default), the scan gets the current value of the DI 
(in this case DI changes between scans are missed). 

DI Input Filters  
Each inputs has a hardware input filter to make sure that the input reading is stable. The 
hardware DI filter range is 0 to 50.8 mS (in 0.2 mS steps).  Counter DI filter range is 0 to 12.75 
mS (in 0.05 mS steps).  The DI filter can be set in the STS advanced I/O configuration. 

DI Event Time Tagging  
Each DI can be set in the Application Programmer I/O link table to trigger recording of time 
tagged events upon any input change of state. The time tagged events are recorded in the CPU 
memory and can be retrieved for various purposes.   

DI Keep Last Value (KLV) and Predefined Value (PDV)  
Each input can be configured to KLV or to a PDV (0, 1) in the Application Programmer I/O 
link table. This value is shown to the user application program in the event of DI module 
failure. Also, the predefined value can be used during normal operation to force a value that 
masks the actual input value.  In this case the user application program will get the PDV 
instead of the actual input value.  

DO Keep Last Value (KLV) and Predefined Value (PDV)  
Each output can be configured to KLV or to a PDV (0, 1). This value is executed when the user 
application program stops or when the module has no communication with the CPU module. 
Also, the predefined value can be used during normal operation to force a value on the output 
by ignoring the user application program value.   

DO/DI FET Module Configuration Options 
The DO/DI FET module features which can be configured are listed in the table below. Some 
parameters are per module and some are per input. 



Digital Output/Digital Input FET Module 

7-4 

Table 7-1  ACE3600 DO/DI FET Module Configurable Features  
 

Parameter Selection Default Setup Per Module/ 
Input 

Parameter 
Setup Location 

DI Fast Capture Disabled 
/Enabled 

Disabled Input RTU 
configuration 

DI Filter 0-254 (x 0.2 mS) 50 * 0.2 mS 
(=10 mS) 

Module RTU 
configuration;  
‘C’ Program 

DI Counter 
Filter 

0-255 (x 0.05 mS) 20 * 0.2 mS  
(= 1 ms) 

Module RTU 
configuration; 
‘C’ Program 

DI Event Time 
Tagging 

Disabled 
/Enabled 

Disabled Input Application 
Programmer I/O 
link table 

DI Keep Last 
Value & 
Predefined 
Value 

KLV/PDV 

PDV = 0/1 

KLV Input Application 
Programmer I/O 
link table 

DI Mask No /Yes No Input Application 
Programmer I/O 
link table 

DO Keep Last 
Value & 
Predefined 
Value 

KLV/PDV 

PDV = 0/1 

KLV Output Application 
Programmer I/O 
link table 

DO Mask No /Yes No Output Application 
Programmer I/O 
link table 

Sleep Mode 
Each DO/DI module can be switched by the user application program to Sleep Mode. In Sleep 
Mode, the module does not function and the power consumption is minimized. During Sleep 
mode, the user application program will get the KLV or PDV per each DI. 

Module Status and Diagnostics 
In the event of a DO/DI module failure, the ERR LED on the module will be lit.  This event is 
registered by the CPU in the Error Logger.  DO/DI module failure status is also visible to the 
user application program. 

The DO/DI module can be diagnosed and monitored using the STS Hardware Test utility.  The 
Hardware Test verifies that the module is operational, presents the module configuration and 
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shows the actual value of each input and output.  It is also possible to change the input filter 
setup for the duration of the Hardware test and change the value of the DOs. 

In the Hardware Test utility, it is possible to set the module to Freeze Mode. In this mode the 
user application program will get the KLV/PDV of each input in the module instead of the 
actual input value. The DO values will keep the last value they had when the module was 
switched to Freeze Mode. Freeze mode enables testing the inputs and outputs while the user 
application program is running. 

Module Block Diagram 
16 DO/DI FET 
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32 DO/DI FET 
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Connection Charts  
 16 DO/DI FET      32 DO/DI FET 

Pin Function Pin Function  Pin Function Pin Function 

1 DO/DI1 11 DO/DI9  1 DO/DI1 21 DO/DI17 

2 DO/DI2 12 DO/DI10  2 DO/DI2 22 DO/DI18 

3 DO/DI3 13 DO/DI11  3 DO/DI3 23 DO/DI19 

4 DO/DI4 14 DO/DI12  4 DO/DI4 24 DO/DI20 

5 DO/DI5 15 DO/DI13  5 DO/DI5 25 DO/DI21 

6 DO/DI6 16 DO/DI14  6 DO/DI6 26 DO/DI22 

7 DO/DI7 17 DO/DI15  7 DO/DI7 27 DO/DI23 

8 DO/DI8 18 DO/DI16  8 DO/DI8 28 DO/DI24 

9 COM1 19 COM2  9 COM1 29 COM3 

10 PGND1 20 PGND2  10 PGND1 30 PGND3 

     11 DO/DI9 31 DO/DI25 

     12 DO/DI10 32 DO/DI26 

     13 DO/DI11 33 DO/DI27 

     14 DO/DI12 34 DO/DI28 

     15 DO/DI13 35 DO/DI29 

     16 DO/DI14 36 DO/DI30 

     17 DO/DI15 37 DO/DI31 

     18 DO/DI16 38 DO/DI32 

     19 COM2 39 COM4 

     20 PGND2 40 PGND4 
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DO/DI FET Module Specifications 
Total Number of I/Os 16; 32   

I/O Arrangement Two or four group of 8 I/Os with shared common 
Each group can be configured as FET DO or dry contact DI. 
Selectable combinations (32 DO/DI): 32 DO/8 DI+24 DO/ 
16 DI+16 DO/24 DI+8 DO/32 DI 
Selectable combinations (16 DO/DI): 16 DO/8 DI+8 DO/16 DI+16 DI 

Counter Inputs 20 first inputs can be used as counter inputs  

Counter Input Frequency 0 - 1 KHz, minimum pulse width 500 µS.  Note: Although filters are 
defined in steps of 0.2mSec and 0.05mSec, it is relevant only from 1mSec 
and above. 

Max. DC Input Voltage Max. 30 V DC (relative to input common) 

Input “ON” Resistance 0-4 kΩ  

Input “OFF” Resistance ≥50 kΩ  

Fast Capture Resolution 1 mS (Interrupt upon change of state)  

Event Time Tagging 
Resolution 

1 mS (Interrupt upon change of state)   

Input Current Max. 0.3 mA (when the input is shorted)  

Input Filtering 0 to 50.8 mS (programmable in 0.2 mSec steps), relevant only from 1mSec  

Counter Input Filtering 0 to 12.75 mS (programmable in 0.05 mSec steps), relevant only from 
1mSec 

Output Type MOSFET  

Output Voltage Range 5-30 V DC (user supplied voltage) 

DO Frequency Max. 1 KHz (resistive load)  

DO Output Current Max. 500 mA sink current (resistive load) 

Output Fail State Configurable output state on CPU fail: On, Off or ‘last value’  

Diagnostic LEDs LED per each input / output status, module error LED 

User Connection 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG  

Cable and TB Holder 20 or 40 Wire Cable with Terminal Block Holder connector, 26 AWG  

Module Replacement Hot swap replacement– module extraction / insertion under voltage 

Input / Output Isolation  2.5 kV between input/output and module logic 

Input Insulation Insulation resistance 100 MΩ @ 500 V DC per IEC255-5 

Operating Voltage 10.8-16 V DC and 3.3 V DC (from the motherboard connector)  

Power Consumption 
(measured at power supply in) 

16 DO/DI: 0.55 W typical with all LEDs/all outputs on (40 mA @ 13.8 
VDC) 
32 DO/DI: 1 W typical with all LEDs/all outputs on (72 mA @ 13.8 VDC) 

Dimensions 37 mm W x 225 mm H  x 180 mm D (1.5" W x 8.7" H x  7.1" D) 
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Weight Approx. 0.25 Kg  (0.55 Lb) 

Specifications subject to change without notice. 
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DIGITAL OUTPUT RELAY MODULE 

General Description 
The DO Relay modules have 8 or 16 outputs.  

There are two types of DO relays: 

• Electrically Energized (EE) - the outputs return to the non-energized state in case of power 
off or module failure. 

• Magnetically Latched (ML) - Relay outputs are magnetically latched, the outputs maintain 
their state in case of power off or module failure. 

The following DO relays modules are available:  

• 8 DO EE Relay 2A  

• 16 DO EE Relay 2A  

• 8 DO ML Relay 2A  

• 16 DO ML Relay 2A  

For a description of I/O module construction, location, LEDs, TBs, and other common I/O 
module features, see the I/O Modules chapter above. 

Figure 8-1 provides a general view of the ACE3600 DO Relay Module. 
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8DO Relay       16 DO Relay 
Figure 8-1  ACE3600 DO Relay Module – General View 

 

Figure 8-2 provides a detailed view of the ACE3600 DO Relay Module front panel. 

                                                                   

8DO Relay   16DO Relay 
Figure 8-2  ACE3600 I/O Module – Front Panel 
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In the 8 DO modules, the relays of outputs 1 through 5 are Single Pole Single Throw (SPST) 
normally open (NO) and are referred to as the “Form A” relays.  The relays of outputs 6 
through 8 are Single Pole Double Throw (SPDT) and are referred to as the “Form C” relays. 

In the 16 DO modules, the relays of outputs 1 through 5 and 9 through 13 are Single Pole 
Single Throw (SPST) normally open (NO) “Form A” relays. The relays of outputs 6 through 8 
and 14 through 16 are Single Pole Double Throw (SPDT) “Form C” relays. 

The physical position of each relay is monitored by the module logic, using a back indication 
signal which is connected to the relay’s second contact set.  Any contradiction between the 
required position and the back indication signal is reported to the CPU and is available to the 
user program.  

In some applications it is necessary to inhibit relay output operation when attending the site for 
safety reasons.  In all DO relay modules, it is possible to inhibit all relays per DO module. 
When a module is configured to enable relay inhibiting, the power to the relays is provided 
from the power supply via a dedicated power line (12V DO), controlled from the “12V DO” 
input (TB located on the power supply module panel).  When the input’s terminals are shorted, 
the relays are operational.  When the input’s terminals are open, the relays are inhibited (EE 
relays in 0 position and ML relays do not change state.) 

The user program can monitor the relay inhibiting status and act accordingly.  Also, when the 
module’s relays are inhibited, any mismatch between the relay position and the output logical 
state is ignored. 

Module Configuration 

Relay Inhibiting 

 

When the dipswitch is set to 12V DO, the position of the 2-pin 12V DO 
Control connector on the front panel of the power supply module (see 
Power Supply Module chapter above) acts as a safety mechanism.  When 
the 2-pin TB is unplugged from the 12V DO Control (e.g. for maintenance), 
power is not supplied via the motherboard to the relays and the relays are 
disabled.  The 12V DO affects all relays in the system that are programmed 
to work from the 12V DO and not the (default) 12V Main. 
 
EE relays that are programmed for 12V DO operation will disconnect when 
12V DO power is shut down and cannot be changed in this state.   
ML relays that are programmed for 12V DO operation will freeze in their 
current state when 12V DO power is shut down and cannot be changed. 
Therefore, setting the dipswitch for ML will not necessarily inhibit them. 
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A dual selector dipswitch (S3) on the DO Relay module has 4 selectable positions as described 
in the following table: 

Table 8-1  DO Relay Module- Dipswitch Settings 
S3 
SW 1 

S3  
SW 2 

Configuration mode 

OFF OFF 12V_DO – Relay inhibiting enabled 

ON OFF Software selectable – inhibiting is set in site configuration 

OFF ON 12V_DO – Relay inhibiting enabled 

ON ON 12 V – (factory default) Relay inhibiting disabled 
 

O
  N

O
 F F

 

Figure 8-3  12V DO Dipswitch 

 

When S3 is set to Software Selectable mode, the inhibiting configuration is set using the 
module configuration in the STS Site Configuration (see Table 8-2 below). 

Procedure 8-1 describes how to set the 12V DO dipswitch to enable relay inhibiting. 

Procedure 8-1  How to Set the 12V DO Dipswitch to Enable Relay Inhibiting. 

1) If the 2-pin TB is plugged into the 12V DO Control on the front panel of the power supply 
module, unplug it.  

2) Remove the DO module from the slot in the rack. 
3) Carefully remove the plastic wrap covering from the S3 dipswitch (see Figure 8-3) on the 

DO module board.  Note: Ignore text on the board that OFF/OFF is the factory default. 
4) Set the S3 dipswitch to the desired position, according to the legend in Table 8-1.   
5) Replace the DO module in the rack. 
6) If the new dipswitch position causes DO relay power to be drawn from the 12VDO, plug 

the 2-pin TB back into the 12V DO Control on the front panel of the power supply module. 

DO Keep Last Value (KLV) and Predefined Value (PDV)  
Each output can be configured to KLV or to a PDV (0, 1).  This value is executed when the 
user program stops or when the module has no communication with the CPU module. Also, the 
PDV can be used during normal operation to force a value on the output by ignoring the user 
program value (mask).   
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Reset DO at Startup 
It is possible to configure the module to reset all the ML relays positions on startup.  This is set 
in the STS site configuration. 

Table 8-2  ACE3600 DO Relay Module Configurable Features  
 

Parameter Selection Default Setup Per Module/ 
Input 

Parameter 
Setup Location 

DO Keep Last 
Value & Pre 
Defined Value 

KLV/PDV 
PDV = 0/1 

KLV Output Application 
Programmer I/O 
link table 

DO Mask No /Yes No Output Application 
Programmer I/O 
link table 

Reset DO at 
Startup 

Disable/Enable Disable Module Site 
configuration 

Relay Inhibiting 
(SW selectable) 

Disable/Enable Disable Module Site 
configuration 

 

Sleep Mode 
Each DO module can be switched by the user program to Sleep Mode. In Sleep Mode, the 
module is not functioning and the power consumption is minimized.  

Module Status and Diagnostics  
In the event of module failure, the module’s ERR LED will be lit.  This event is registered by 
the CPU in the Error Logger.  Module failure status is also visible to the user program.  

The DO module can be diagnosed and monitored using the STS Hardware Test utility. This test 
verifies that the module is operational, presents the module configuration and shows the actual 
value of each output. It is also possible to change the DO’s value. 

In the Hardware Test utility, it is possible to set the module to Freeze Mode. In this mode, the 
DOs will keep the last value they had at the time they were frozen.  Freeze mode enables 
testing the inputs and outputs while the user program is running. 

For details on configuring the DO modules, see the Configuring a Site section and the 
Application Programmer section of the ACE3600 STS User Guide. 
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Module Block Diagram 
8 DO 
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16 DO 
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Connection Charts 
     8 DO               16 DO 

Pin Function Pin Function  Pin Function Pin Function 

1 NO1 11 NO6  1 NO1 21 NO9 

2 COM1 12 COM6  2 COM1 22 COM9 

3 NO2 13 NC6  3 NO2 23 NO10 

4 COM2 14 NO7  4 COM2 24 COM10 

5 NO3 15 COM7  5 NO3 25 NO11 

6 COM3 16 NC7  6 COM3 26 COM11 

7 NO4 17 NO8  7 NO4 27 NO12 

8 COM4 18 COM8  8 COM4 28 COM12 

9 NO5 19 NC8  9 NO5 29 NO13 

10 COM5 20 PGND1  10 COM5 30 COM13 

     11 NO6 31 NO14 

     12 COM6 32 COM14 

     13 NC6 33 NC14 

     14 NO7 34 NO15 

     15 COM7 35 COM15 

     16 NC7 36 NC15 

     17 NO8 37 NO16 

     18 COM8 38 COM16 

     19 NC8 39 NC16 

     20 PGND1 40 PGND2 
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DO Relay Module Specifications 
Total Number of Outputs 8 EE relay outputs  

16 EE relay outputs  

8 ML relay outputs  

16 ML relay outputs  

Output Arrangement 8 DO : 3 X Form C (SPDT) and 5 X Form A (SPST) 

16 DO: 6 X Form C (SPDT) and 10 X Form A (SPST) 

Contact Voltage Ratings Max. 60 V DC or 30 V AC RMS (42.4 V peak).  

Contact Power Ratings 2A @ 30 V DC, 0.6A @ 60V DC or 0.6A @ 30V AC (resistive load) 

Relay Back Indication Contact position - hardware back indication 

DO Frequency Max. 10 Hz  

Diagnostic LEDs LED per each output status, module error LED  

User Connection 2 or 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG  

Cable and TB Holder 20 or 40 Wire Cable with Terminal Block Holder connector, 26 AWG  

Fail State Configurable relay state on CPU fail: On, Off or ‘last value’  

All Relays Disable/Enable Selectable per module, controlled from the power supply  

Module Replacement Hot swap replacement – module extraction/insertion under voltage  

Output Isolation  Between open contacts: 1kV,  
Between contact and coil: 1.5 kV,  
Between contact sets: 1.5 kV 

Insulation Insulation resistance 100 MΩ @ 500 V DC per IEC255-5,  
Insulation impulse 1.5 kV between input and logic 

Operating Voltage 10.8-16 V DC and 3.3 V DC (from the motherboard connector)  

Power Consumption 
(measured at power supply 
in) 

8 DO: 0.2 W typical when all LEDs on/all relays off (14 mA @ 13.8 VDC)  
16 DO: 0.3 W typical when all LEDs on/all relays off (22 mA @ 13.8 VDC) 
For each EE Relay on: 0.2 W typical (15 mA @ 13.8 VDC) 

Dimensions 37 mm W x 225 mm H  x 180 mm D  
(1.5" W x 8.7" H x  7.1" D)  

Weight 8 DO  : approx. 0.29 Kg (0.64 Lb)  
16 DO: approx. 0.32 Kg (0.7 Lb) 

 

Specifications subject to change without notice. 
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ANALOG INPUT MODULE 

General Description 
The Analog Input (AI) modules have 8 or 16 inputs.  The modules sample and convert analog 
data into digital format and transfer the digital data to the CPU module.   

The following modules are available: 

• 8 AI  ±20 mA (supports 4-20 mA)  

• 16 AI  ±20 mA (supports 4-20 mA) 

• 8 AI  ±5 V (supports 0-5 V and 1-5 V)  

• 16 AI  ±5 V (supports 0-5 V and 1-5 V) 

The module’s analog-to-digital conversion resolution is 16 bit (including sign). Each input is 
fully isolated from the other inputs on the module and also optically isolated from the module 
internal circuits. The modules are fully calibrated and can be tested and recalibrated in the 
field. 

The measured values are digitally filtered to reduce the 50 or 60 Hz noise. The user can select 
the filtering frequency per module. 

The measured values can be smoothed by digital filtering. Smoothing is accomplished by 
calculating the running average values of a defined number of converted analog values 
(samples). The user can select the level of smoothing per module. The higher the smoothing 
level chosen, the more stable is the smoothed analog value and the longer it takes until the 
smoothed analog signal is applied after a step response.  

The user can select how the analog values are represented to the user application program as 
unit-less numeric values or as scaled values that represent certain Engineering Units (EGU).  

Each AI module can include an optional plug-in floating 24V DC power supply to power 
external devices.  

Each analog input has two status LEDs: 

• UF - indicates Underflow when lit 

• OF - indicates Overflow when lit 

For a description of I/O module construction, location, LEDs, TB holder, and other common 
I/O module features, see the I/O Modules chapter above. 

For details on specific AI parameters and configuration, see AI Module Configuration below. 
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Figure 9-1 provides a general view of the ACE3600 AI module. 
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8 AI Module       16 AI Module 
Figure 9-1  ACE3600 AI Module – General View 
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Figure 9-2 provides a detailed view of the AI module front panel. 
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8 AI Module   16 AI Module 
Figure 9-2  ACE3600 AI Module – Front Panel 

 

AI Module Configuration 

50/60 Hz Filtering 
This parameter enables the user to configure the module to use 50 or 60 Hz filter on all inputs. 

AI Filter (Smoothing) 
This parameter enables the user to configure the level smoothing (averaging) on all inputs. It 
can be set to 1, 2, 4, 8, 16, 32, 64,128 samples. 

Change Of State (COS) Delta 
This parameter sets a delta value to each input.  This enables the user application program to 
get an indication when the input value change is more than ± delta value. 

Input Range 
This parameter sets the overflow and underflow limits (refer to AI Module value representation 
below.) 
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In the current input modules, the ranges that can be selected are: ±20 mA (default) and 4-20 
mA.  

In voltage input modules, the ranges that can be selected are ± 5V (default), 0-5 V and 1-5 V. 

Keep Last Value (KLV) and Predefined Value (PDV)  
Each input can be configured to KLV or to a PDV.  This value is shown to the user application 
program in the event of AI module failure. The predefined value can also be used during 
normal operation to force a value that masks the actual input value.  In this case the user 
application program will get the PDV instead of the actual input value.  

I/O Legacy Resolution Parameter 
In systems with both ACE3600 RTUs and legacy (MOSCAD/MOSCAD-L) RTUs, some 
MOSCAD/MOSCAD-L applications can be upgraded to ACE3600 without modifying the 
references to analog values in the applications (‘C’ or ladder).  The I/O Legacy Resolution STS 
advanced parameter sets the Analog I/O bit resolution to either Actual (ACE3600) or Legacy 
(MOSCAD/MOSCAD-L).   

For values and restrictions, see Appendix A: Site Configuration Parameters in the ACE3600 
STS User Guide. 

AI Module Configuration Options 
The AI module features which can be configured are listed in the table below. Some parameters 
are per module and some are per input. 

Table 9-1  ACE3600 AI Module Configurable Parameters  
 

Parameter Selection Default setup Per Module / 
Input 

Parameter 
Setup location 

50/60 Hz 
Filtering 

50/60 50 Hz Module STS Site 
configuration 

AI Filter 
(Smoothing) 

1/2/4/8/16/32/64/128 
(x10 mS) 

32 Module STS Site 
configuration 

Input Range Current: ±20 mA/ 
4-20 mA 
Voltage: ±5 V/0-5V/ 
1-5V 

Current: ±20 mA 

Voltage: ±5 V 

Module STS Site 
configuration 

COS Delta value 0 (disabled) Input Application 
Programmer I/O 
link table 

KLV & PDV KLV/PDV 

PDV=value 

KLV Input Application 
Programmer I/O 
link table 
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Parameter Selection Default setup Per Module / 
Input 

Parameter 
Setup location 

Mask No /Yes No Input Application 
Programmer I/O 
link table 

Sleep Mode 
Each AI module can be switched by the user application program to Sleep Mode. In Sleep 
Mode, the module does not function and the power consumption is minimized. During Sleep 
mode the user application program will get the predefined values for each I/O. 

Module Status and Diagnostics 
In the event of AI Module failure, the I/O module ERR LED will be lit.  The event is registered 
by the CPU in the Error Logger.  AI Module failure status is also visible to the user application 
program.  

In addition to the ERR LED, the module includes an Underflow (UDF) and Overflow (OVF) 
LED for each input.  

• When the UDF LED is lit, it indicates that the signal level in the corresponding input is below 
the nominal range.  

• When the OVF LED is lit, this indicates that the signal level in the corresponding AI is above 
the nominal range.  

• If both the UDF and OVF LEDs of the same channel are lit, the channel is uncalibrated.  

The AI module can be diagnosed and monitored using the STS Hardware Test utility. The 
Hardware Test verifies that the module is operational, presents the module configuration and 
shows the actual value of each input, including overflow and underflow.  It is also possible to 
change the input filter setup for the duration of the Hardware test. 

In the HW Test utility, it is possible to set the AI module to Freeze Mode. In this mode the 
program user will get the KLV or PDV of each input in the module instead of the actual input 
value. Freeze mode enables testing the inputs while the user application program is running. 
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AI Module Value Representation 
In ± 20 mA 

current inputs 
Decimal Value Input Current Indication 

 < -32256 < -20.16 mA Underflow LED ON 

 -32000 -20 mA 

 0 0 mA 

 32000 +20 mA 

 

Rated range (no LED 
active) 

 > 32256 > +20.16 mA Overflow LED ON 

    

In 4 - 20 mA 
current inputs 

Decimal Value Input Current Indication 

 < 6144 < 3.84 mA Underflow LED ON 

 6400 +4 mA 

 0 0 mA 

 32000 +20 mA 

 

Rated range (no LED 
active) 

 > 32256 > +20.16 mA Overflow LED ON 

    

In ± 5 V current 
inputs 

Decimal Value Input Voltage Indication 

 < -32256 <-5.04V Underflow LED ON 

 -32000 -5 V 

 0 0 V 

 32000 +5 V 

 

Rated range (no LED 
active) 

 > 32256 > +5.04 V Overflow LED ON 

    

In 0 - 5 V 
current inputs 

Decimal Value Input Voltage Indication 

 < -256 < -0.04 V Underflow LED ON 

 0 0 V 

 32000 +5 V 

Rated range (no LED 
active) 

 > 32256 > +5.04 V Overflow LED ON 
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In 1 - 5 V 
current inputs 

Decimal Value Input Voltage Indication 

 < 6144 < 0.96 V Underflow LED ON 

 6400 1 V 

 32000 +5 V 

Rated range (no LED 
active) 

 > 32256 > 5.04 V Overflow LED ON 
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Module Block Diagram 
8 AI 
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16 AI 
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Connection Charts 
  8 AI         16 AI 

Pin Function Pin Function  Pin Function Pin Function 

1 AI1+ 11 AI5+  1 AI1+ 21 AI9+ 

2 AI1- 12 AI5-  2 AI1- 22 AI9- 

3 AI2+ 13 AI6+  3 AI2+ 23 AI10+ 

4 AI2- 14 AI6-  4 AI2- 24 AI10- 

5 AI3+ 15 AI7+  5 AI3+ 25 AI11+ 

6 AI3- 16 AI7-  6 AI3- 26 AI11- 

7 AI4+ 17 AI8+  7 AI4+ 27 AI12+ 

8 AI4- 18 AI8-  8 AI4- 28 AI12- 

9 PGND 19 +24V  9 PGND 29 GND 

10 PGND 20 -24V  10 PGND 30 PGND 

     11 AI5+ 31 AI13+ 

     12 AI5- 32 AI13- 

     13 AI6+ 33 AI14+ 

     14 AI6- 34 AI14- 

     15 AI7+ 35 AI15+ 

     16 AI7- 36 AI15- 

     17 AI8+ 37 AI16+ 

     18 AI8- 38 AI16- 

     19 +24V 39  

     20 -24V 40  
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AI Module Specifications 
Total Number of Inputs 8 AI ±20 mA (4-20 mA)   

16 AI ±20 mA (4-20 mA)   
8 AI ±5 V (0-5 V, 1-5 V)   
16 AI ±5 V (0-5 V, 1-5 V)   

Input Configuration Isolated (floating) analog inputs 
A to D Resolution 16 bit (including sign) 
Input Accuracy ±0.1% of full scale @ -40ºC to +70ºC 
Input Sampling Time 10 mSec @ 50 Hz filtering; 8.33 mSec @ 60 Hz filtering   
Smoothing Selectable input averaging:1,2,4,8,16,32,64,128 samples (x10 mS) 
Permitted Potential Between 
Inputs 

75 V DC, 60 V AC (RMS) 

Input Impedance ±20 mA input: Rin < 250 Ω 
±5 V input: Rin > 1 MΩ 

Crosstalk Rejection Better than 80 dB between any pair of inputs  
Temperature Stability 25 PPM/ºC 
Interference Suppression Selectable 50 or 60 Hz filtering,  

Common mode rejection > 80 dB, 
Differential mode rejection > 50 dB 

24 V DC Output Supports optional isolated 24V Plug-in Power Supply  (one in 16 DI, 
two in 32 DI)  

Diagnostic LEDs Overflow and Underflow LED per each input status, Module error 
LED, 24V Plug-in status LED 
The module Overflow and Underflow levels can be configured to: 
Current inputs: ±20mA / 4-20 mA 
Voltage inputs: ±5 V / 0-5 V /1-5 V 

User Connection 2 or 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG  
Cable and TB Holder 20 or 40 Wire Cable with TB Holder connector, 26 AWG  
Module Replacement Hot swap replacement– module extraction/insertion under voltage 
Input Isolation  1.5 kV between input and module logic  
Input Insulation Insulation resistance 100 MΩ @ 500 V DC, per IEC255-5 
Operating Voltage 10.8-16 V DC and 3.3 V DC (from the motherboard connector) 

Power Consumption 
(measured at power supply in) 

8 AI: 0.9 W typical with all LEDs on (65 mA @ 13.8 VDC) 
16 AI: 1.3W typical with all LEDs on (95 mA @ 13.8 VDC) 
(Not including 24 V Plug-in Power Supply) 

Dimensions 37 mm W x 225 mm H x 180 mm D, (1.5" W x 8.7" H x 7.1" D)  
Weight 8 AI  : approx.032 Kg   (0.71 Lb)  

16 AI: approx. 0.34 Kg (0.75 Lb) 

Specifications subject to change without notice. 
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ANALOG OUTPUT MODULE 

General Description 
The Analog Output (AO) modules have four optically-isolated analog output channels for 
controlling user devices (see Figure 10-1). Each channel has two possible outputs: 0-20 mA 
Interface industry standard current output and 0-10 V Interface industry standard voltage 
output. Only one of the outputs can be enabled in a particular channel - either current or 
voltage. 

The module’s digital to analog converter resolution is 14 bit.  The Analog Output channels are 
optically isolated from the module internal logic circuits. The modules are fully calibrated and 
can be tested and recalibrated in the field. 

Each analog output has three status LEDs, Vout, Iout, and CAL which represent the calibration 
status of each output for voltage/current.  See Module Status and Diagnostics below for the 
LEDs behavior. 

For a description of I/O module construction, location, LEDs, TBs, and other common I/O 
module features, see the I/O Modules chapter above. 

For details on specific AO parameters and configuration, see AO Module Configuration below. 
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Figure 10-1 provides a general view of the ACE3600 AO module. 
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Figure 10-1  ACE3600 AO Module – General View 
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Figure 10-2 provides a detailed view of the AO module front panel. 
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Figure 10-2  ACE3600 AO Module – Front Panel 
 

AO Module Configuration 

AO Type 
The analog outputs can be set to voltage, current, or raw data.  See Module Status and 
Diagnostics for details.  

AO Value 
The analog outputs can be set to a numeric value (in the range of 0 to 16000) or either in 
voltage or current according to the output type. The values for voltage are 0 to 10 V and the 
values for current are 0 to 20 mA.  See Module Status and Diagnostics for details.  
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The AO module value representation is as follows: 

In 0-20 mA current 
outputs 

Decimal Value Output 
Current 

 0 0 

 4000 5 mA 

 8000 10 mA 

 16000 20 mA 

In 0- 10 V voltage 
outputs  

Decimal Value  Output 
Voltage 

 0 0 V 

 4000 2.5 V 

 8000 5 V  

 16000 10 V 
 

AO Calibration 
The upper and lower limits of analog outputs can be calibrated - either as current (20mA upper 
limit and 4mA lower limit) or voltage (10V upper limit and 2V lower limit).  Default upper and 
lower calibration limits are provided from the factory.  See Module Status and Diagnostics for 
details. 

Keep Last Value (KLV) and Predefined Value (PDV)  
Each output can be configured to KLV or to a PDV.  This value is maintained in the event of 
AO module failure or communication failure with the CPU.  

The predefined value can also be used during normal operation to force a value that masks the 
actual output value.   

I/O Legacy Resolution Parameter 
In systems with both ACE3600 RTUs and legacy (MOSCAD/MOSCAD-L) RTUs, some 
MOSCAD/MOSCAD-L applications can be upgraded to ACE3600 without modifying the 
references to analog values in the applications (‘C’ or ladder).  The I/O Legacy Resolution STS 
advanced parameter sets the Analog I/O bit resolution to either Actual (ACE3600) or Legacy 
(MOSCAD/MOSCAD-L).   

For values and restrictions, see Appendix A: Site Configuration Parameters in the ACE3600 
STS User Guide. 
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AO Module Configuration Options 
The AO module features which can be configured are listed in the table below. Some 
parameters are per module and some are per output. 

Table 10-1  ACE3600 AO Module Configurable Parameters  
 

Parameter Selection Default setup Per 
Module / 
Output 

Parameter 
Setup location 

AO Type Voltage/Current User Defined Output STS HW 
Test/User 
application 
program 

AO Value Voltage  -  0 to 10 V  
Current  -  0 to 20 mA 

User Defined Output STS HW 
Test/User 
application 
program 

AO 
Calibration 

Voltage  -  2 to 10 V  
Current  -  4 to 20 mA 

Voltage - 2 to 10 V  
Current - 4 to 20 mA 

Output STS HW Test 

KLV & 
PDV 

KLV/PDV 

PDV=value 

KLV Output Application 
Programmer I/O 
link table 

Mask No /Yes No Output Application 
Programmer I/O 
link table 

Sleep Mode 
Each AO module can be switched by the user application program to Sleep Mode. In Sleep 
Mode, the module does not function and the power consumption is minimized. During Sleep 
mode the user application program will get the predefined values for each output. 
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Module Status and Diagnostics 
In the event of AO Module failure, the I/O module ERR LED will be lit.  The event is 
registered by the CPU in the Error Logger.  AO Module failure status is also visible to the user 
application program.  

In addition to the ERR LED, the module includes a voltage output (Vout), current output 
(Iout), and calibration (CAL) LED for each output.  

CAL Vout Iout Indication 

On On On Neither output is calibrated. 

On Off On Iout is uncalibrated. 

On On Off Vout is uncalibrated. 

Off On On Row value for testing purpose is defined by the user, 
either using HW test or user application program to send 
raw data. 

Off On Off Vout is defined by the user, either using HW test or user 
application program. 

Off Off On Iout is defined by the user, either using HW test or user 
application program. 

 

The AO module can be diagnosed and monitored using the STS Hardware Test utility. The 
Hardware Test verifies that the module is operational, shows the type and actual value of each 
output, enables calibration, and presents the ROM data calibration factors.  The AO type can be 
set either in the user application program or in the Hardware Test.  To set the output value in 
the Hardware test, the user application program must be stopped or the AO module frozen.  To 
calibrate the output in the Hardware test, the user application program must be stopped or the 
AO module frozen. 

In the Hardware Test utility, it is possible to set the AO module to Freeze Mode. In this mode, 
the AOs will keep the last value they had at the time they were frozen.  Freeze mode enables 
testing the inputs and outputs while the user program is running. 
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Module Block Diagram 
4 AO 
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Connection Charts 
     4 AO     

Pin Function  Pin Function 

1 Vout1   11 Vout3  

2 Ret1  12 Ret3 

3 Iout1  13 Iout3 

4 PGND1  14 PGND1 

5 PGND1  15 PGND1 

6 Vout2   16 Vout4  

7 Ret2  17 Ret4 

8 Iout2  18 Iout4 

9 PGND1  19 PGND1 

10 PGND1  20 PGND1 
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AO Module Specifications 
Total Number of Outputs 4 AO current (0-20 mA) or voltage (0-10 V)  
Output Arrangement Isolated floating channels, each channel can be connected as  

0-20 mA or 0-10 V DC voltage 
D to A Resolution 14 bit  
Output Accuracy ±0.1% full scale @ 25ºC  
Temperature Stability 25 PPM/ºC 
Internal Settling Time Max. 1.0 msec 
Output Load Voltage: > 1.0 kΩ, < 1.0 µf 

Current: < 750 Ω (internal power source) 
Crosstalk Rejection Better than 50 dB between any pair of outputs 
Interference Suppression Common mode rejection > 60 dB 
Output Protection Voltage output: short circuit current, max. 30 mA  

Current output: No-load voltage max. 22 V DC 
Diagnostic LEDs Module error LED, Voltage mode LED, Current mode LED, 

Calibration LED per channel 
User Connection 2 Terminal Blocks (3.5mm pitch), Maximum 18 AWG  
Cable and TB Holder 20 Wire Cable with TB Holder connector, 26 AWG  
Module Replacement Hot swap replacement– module extraction/insertion under voltage 
Isolation  1.5 kV between output and module logic 
Insulation Insulation resistance 100 MΩ @ 500 V DC, per IEC255-5 
Operating Voltage 10.8-16 V DC and 3.3 V DC (from the motherboard connector)  
Power Consumption 
(measured at power supply in) 

1.8 W typical with all LEDs on/all outputs off (130 mA @ 13.8 VDC) 
3.4 W typical with all LEDs on/all outputs 20 mA (250 mA @ 13.8 
VDC) 

Dimensions 37 mm W x 225 mm H x 180 mm D, (1.5" W x 8.7" H x 7.1" D)  
Weight Approx. 0.29 Kg   (0.64 Lb)  

Specifications subject to change without notice. 
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MIXED I/O MODULE 

General Description 
The ACE3600 Mixed I/O modules include a mixture of Digital Inputs, Relay Outputs and 
Analog Inputs on the same module. 

The available Mixed I/O modules are: 

• 16 Digital Inputs + 4 EE DO Relay Outputs + 4 Analog Inputs ( ±20 mA) 

• 16 Digital Inputs + 4 ML DO Relay Outputs + 4 Analog Inputs ( ±20 mA) 

Figure 11-1 provides a general view of the ACE3600 Mixed I/O module. 
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Figure 11-1  ACE3600 Mixed I/O Module – General View 
 

Another type of mixed I/O is found on the Digital Output/Digital Input (DO/DI) FET module.  
See the Digital Output/Digital Input (DO/DI) FET module chapter above for more information. 
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Figure 11-2 provides a detailed view of the Mixed I/O module front panel. 
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Figure 11-2  ACE3600 Mixed I/O Module – Front Panel 
 

The Digital Input (DIs) on the Mixed I/O modules are voltage (“wet”) inputs IEC 61131-2 
Type II compliant.  All DIs can function as fast counters.  All DIs are optically isolated.  

Each DI can be an event trigger (by interrupt) to a high priority fast process. A high priority 
fast process enables very fast activation of an output in response to an input trigger and logical 
conditions. This high priority fast process is independent of the I/O scan (refer to the STS 
Application Programmer manual). 

All four relay outputs are Single Pole Double Throw (SPDT) and are referred to as the “Form 
C” relays. The physical position of each relay is monitored by the module logic, by using a 
back indication signal which is connected to the relay’s second contact set.  Any contradiction 
between the required position and the back indication signal, is reported to the CPU and is 
available to the user application program.  

In some applications, it is necessary to inhibit relay output operation when attending the site 
for safety reasons. In all DO relay modules; it is possible to inhibit all relays per DO module. 
When a module is configured to enable relay inhibiting, the power to the relays is provided 
from the power supply via a dedicated power line (12V DO), controlled from the “12V DO” 
input (TB located on the power supply module panel). When the input’s terminals are shorted, 
the relays are operational. When the input’s terminals are open, the relays are inhibited (EE 
relays in the OFF (0) position and ML relays do not change state.) 

The user application program can monitor the relay inhibiting status and act accordingly. Also, 
when the module’s relays are inhibited, any mismatch between the relay position and the 
output logical state is ignored. 
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The Mixed I/O modules Analog-to-Digital conversion resolution is 16 Bit (including sign). 
Each input is fully isolated from the other inputs on the module and also optically isolated from 
the module internal circuits. The modules are fully calibrated. It is possible to test and re-
calibrate the module in the field. 

The measured values are digitally filtered to reduce the 50 or 60 Hz noise. The user can select 
the filtering frequency per module. 

The measured values can be smoothed by digital filtering. Smoothing is accomplished by 
calculating the running average values of a defined number of converted analog values 
(samples). The user can select the level of smoothing per module. The higher the smoothing 
level chosen, the more stable is the smoothed analog value and the longer it takes until the 
smoothed analog signal is applied after a step response.  

The user can select how the analog values are represented to the user application program, as 
unitless numeric values or as scaled values that represent certain Engineering Units (EGU).  

Each AI module can include an optional plug-in floating 24V DC power supply to power 
external devices.  

Each analog input has two Status LEDs:  

• UF - indicates Underflow when lit 

• OF - indicates Overflow when lit 

The Mixed I/O modules support an optional 24V DC floating plug-in power supply (for 
contact “wetting” or other purposes). 

For a description of I/O module construction, location, LEDs, TB holder, and other common 
I/O module features, see the I/O Modules chapter above. For details on Mixed I/O Module 
specific parameters and configuration, see the Mixed I/O Module Configuration section below. 

Mixed I/O Module Configuration 
For configuration of the DIs, refer to the DI Module chapter. 

For configuration of the DOs, refer to the DO/DI FET Module or DO Relay Module chapter. 

For configuration of the AIs, refer to the AI Module chapter. 

Sleep Mode 
Each Mixed I/O module can be switched by the user application program to Sleep Mode. In 
Sleep Mode, the module does not function and the power consumption is minimized. During 
Sleep mode the user application program will get the predefined values per each I/O. 
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Module Status and Diagnostics 
In the event of Mixed I/O Module failure, the ERR LED will be lit. This event is registered by 
the CPU in the Error Logger.  DI Module failure status is also visible to the user application 
program.  

The Mixed I/O module can be diagnosed and monitored using the STS Hardware Test utility.  

For Hardware Test of the DIs, refer to the DI Module chapter. 

For Hardware Test of the DOs, refer to the DO/DI FET Module or DO Relay Module chapter. 

For Hardware Test of the AIs, refer to the AI Module chapter.  
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Module Block Diagram 
Mixed I/O 
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Connection Charts 
  Mixed I/O 

Pin Function Pin Function  

1 DI1 21 COM1  

2 DI2 22 NC1  

3 DI3 23 NO2  

4 DI4 24 COM2  

5 DI5 25 NC2  

6 DI6 26 NO3  

7 DI7 27 COM3  

8 DI8 28 NC3  

9 DI9 29 NO4  

10 DI10 30 COM4  

11 DI11 31 NC4  

12 DI12 32 AI1+  

13 DI13 33 AI1-  

14 DI14 34 AI2+  

15 DI15 35 AI2-  

16 DI16 36 AI3+  

17 24V+ 37 AI3-  

18 COM1 38 AI4+  

19 PGND1 39 AI4-  

20 NO1 40 PGND  
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Mixed I/O Module Specifications 
Total Number of Inputs / 
Outputs 

16 Digital Inputs + 4 EE Relay Outputs + 4 Analog Inputs  
( ±20 mA)  
16 Digital Inputs + 4 ML Relay Outputs + 4 Analog Inputs  
( ±20 mA)  

I/O Arrangement 1 group of 16 DIs with shared common 
4 relay outputs  - Form C 
4 isolated analog inputs 

DI Counter Inputs All inputs can be configured as fast counters  

DI Frequency 0 - 1 KHz  

DI Fast Counter Frequency 0 - 5 KHz, minimum pulse width 100 µS 

DI Max. DC Voltage Max. 40 V DC 

DI “ON” DC Voltage Range +11 to +30 V DC, -30 to -11 V DC 

DI “OFF” DC Voltage Range -5 to +5 V DC 

DI Current 6-10 mA  

Fast Capture Resolution 1 mS (Interrupt upon change of state)  

Event Time Tagging 
Resolution 

1 mS (Interrupt upon change of state) 

DI Filtering 0 to 255 mSec (DC, programmable in 1 mSec steps) 

DI Counter Filtering 0 to 6.375 mSec  (programmable in 0.025 mSec steps for inputs 
configured as high speed counter)  

DO Contact Voltage Ratings Max. 60 V DC or 30 V AC RMS (42.4 V peak).  

DO Contact Power Ratings 2A @ 30 V DC, 0.6A @ 60V DC or 0.6A @ 30V AC  
(resistive load) 

DO Relay Back Indication Contact position - hardware back indication 

DO Fail State Configurable relay state on CPU fail: On, Off or ‘last value’  

AI Resolution 16 Bit (including sign) 

AI Accuracy ±0.1% of full scale @ -40ºC to +70ºC 

AI Sampling Time 10 mSec @ 50 Hz filtering  
8.33 mSec @ 60 Hz filtering 

AI Smoothing Selectable input averaging: 1, 2, 4, 8, 16, 32, 64 or 128 samples  
(x10 mS) 

AI max. Potential between 
AIs 

75 V DC, 60 V AC (RMS) 

AI Impedance Rin < 250 Ω  

AI Crosstalk Rejection Better than 80 dB between any pair of inputs  
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AI Temperature Stability 25 PPM/ºC 

AI Interference Suppression Selectable 50 or 60 Hz filtering, common mode rejection > 80 dB, 
differential mode rejection > 50 dB 

Diagnostic LEDs Module error LED, Status LED per each DO and DI. 
Overflow and Underflow LED per each AI,  
24V Plug-in status LED (AI) 

AI Overflow and Underflow levels can be configured to: 
            Current inputs: ±20mA / 4-20 mA 
            Voltage inputs: ±5 V / 0-5 V /1-5 V 

24 V DC Output Supports one isolated 24V A plug-in “wetting” power supply  

User Connection 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG  

Cable and TB Holder 40 wire cable with Terminal Block Holder connector, 26 AWG  

Module Replacement Hot swap replacement– module extraction/insertion under voltage  

Input / Output Isolation  DI:  2.5 kV DC/AC between input and module logic per IEC255-5 
DO: Between open contacts: 1kV, between contact and coil: 1.5 kV,  
        between contact sets: 1.5 kV 
AI:  1.5 kV between input and module logic  

Input Insulation Insulation resistance 100 MΩ @ 500 V DC per IEC255-5 

Operating Voltage 10.8-16 V DC and 3.3 V DC (from the motherboard connector)  

Power Consumption 
(measured at power supply in) 

1.5 W typical with all LEDs on and outputs off (110 mA @ 13.8 V DC) 
For each EE Relay on: 0.2 W typical  (15 mA @ 13.8 VDC) 
(Not including 24 V Plug-in Power Supply) 

Dimensions 37 mm W x 225 mm H  x 180 mm D        
(1.5" W x 8.7" H x  7.1" D) 

Weight Approx. 0.31 Kg  (0.68 Lb) 
 

Specifications subject to change without notice. 
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MIXED ANALOG MODULE 

General Description 
The ACE3600 Mixed Analog modules include a mixture of Analog Inputs and Analog Outputs 
on the same module. 

The available Mixed Analog modules are:  

• 4 Analog Outputs + 8 Analog Inputs (±20 mA)  (supports 4-20 mA) 

• 4 Analog Outputs + 8 Analog Inputs (±5V) (supports 0-5 V and 1-5V) 

Figure 12-1 provides a general view of the ACE3600 Mixed Analog module. 
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Figure 12-1  ACE3600 Mixed Analog Module – General View 
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Figure 12-2 provides a detailed view of the Mixed Analog module front panel. 
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Figure 12-2  ACE3600 Mixed Analog Module – Front Panel 
 

For a description of the AIs in the Mixed Analog modules, see the Analog Input Module 
chapter. For a description of the AOs in the Mixed Analog modules, see the Analog Output 
Module chapter. 

The Mixed Analog modules support an optional 24V DC floating plug-in power supply to 
power external devices. 

For a description of I/O module construction, location, LEDs, TB holder, and other common 
I/O module features, see the I/O Modules chapter above. For details on Mixed Analog Module 
specific parameters and configuration, see the Mixed Analog Module Configuration section 
below. 

Mixed Analog Module Configuration 
For configuration of the AIs, refer to the AI Module chapter. 

For configuration of the AOs, refer to the AO Module chapter. 

Sleep Mode 
Each Mixed Analog module can be switched by the user application program to Sleep Mode. 
In Sleep Mode, the module does not function and the power consumption is minimized. During 
Sleep mode the user application program will get/set the predefined values per each I/O. 
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Module Status and Diagnostics 
In the event of Mixed Analog Module failure, the ERR LED will be lit. This event is registered 
by the CPU in the Error Logger.  AI Module failure status is also visible to the user application 
program.  

The Mixed Analog module can be diagnosed and monitored using the STS Hardware Test 
utility.  

For Hardware Test of the AIs, refer to the AI Module chapter.  

For Hardware Test of the AOs, refer to the AO Module chapter.  
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Module Block Diagram 
Mixed Analog 
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Connection Charts 
        4AO/8AI   

Pin Function  Pin Function 

1 Vout1   21 AI1+ 

2 Ret1  22 AI1- 

3 Iout1+  23 AI2+ 

4 PGND1  24 AI2- 

5 PGND1  25 AI3+ 

6 Vout2   26 AI3- 

7 Ret2  27 AI4+ 

8 Iout2  28 AI4- 

9 PGND1  29 PGND2 

10 PGND1  30 PGND2 

11 Vout3   31 AI5+ 

12 Ret3  32 AI5- 

13 Iout3  33 AI6+ 

14 PGND1  34 AI6- 

15 PGND1  35 AI7+ 

16 Vout4   36 AI7- 

17 Ret4  37 AI8+ 

18 Iout4  38 AI8- 

19 PGND1  39 +24V 

20 PGND1  40 -24V 
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Mixed Analog Module Specifications 
Total Number of I/Os 4 Analog Outputs + 8 Analog Inputs ( ±20 mA)  or 

4 Analog Outputs + 8 Analog Inputs ( ±5V DC)  

I/O Arrangement AO - each channel can be connected as 0-20 mA or 0-10 V,  
AI - Isolated (floating) analog inputs 

AO D to A Resolution 14 bit  

AO Accuracy ±0.1% full scale @ 25ºC  

AO Temperature Stability 25 PPM/ºC 
AO Internal Settling Time Max. 1.0 msec 
AO Load Voltage: > 1.0 kΩ, < 1.0 µf 

Current: < 750 Ω (with internal power supply) 
AO Crosstalk Rejection Better than 50 dB between any pair of outputs 
AO Interference Suppression Common mode rejection > 60 dB 
AO Voltage Output Protection Short circuit protection, max. 30 mA (all other operating channels 

remain fully functional) 
AO Current Output No-load Voltage  Max. 22.0 V DC  

AO Isolation  1.5 kV between output and module logic 

AO Insulation Insulation resistance 100 MΩ @ 500 V DC per IEC255-5 

AI A to D Resolution 16 Bit (including sign) 

AI Accuracy ±0.1% full scale  

AI Sampling Time 10 mSec @ 50 Hz filtering  
8.33 mSec @ 60 Hz filtering 

AI Smoothing Selectable input averaging: 1, 2, 4, 8, 16, 32, 64 or 128 samples 
(x10 mS) 

Permitted. Potential between Inputs 75 V DC, 60 V AC (RMS)  

AI Input Impedance ±20 mA input: Rin < 250 Ω 
±5 V input: Rin > 1 MΩ 

AI Crosstalk Rejection Better than 80 dB between any pair of inputs  

AI Temperature Stability 25 PPM/ºC 

AI Interference Suppression Selectable 50 or 60 Hz filtering, common mode rejection > 80 
dB, differential mode rejection > 50 dB 

24 V DC Output Supports one isolated 24V Plug-in “wetting” power supply  
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Diagnostic LEDs AO  - Voltage mode LED, Current mode LED, Calibration LED 
per channel  

AI - Overflow and Underflow LED per each input, 24V Plug-in 
status LED 

The module Overflow and Underflow levels can be configured to:
Current inputs: ±20mA / 4-20 mA 
Voltage inputs: ±5 V / 0-5 V /1-5 V 

General - Module error LED 

AI Input Isolation  1.5 kV between input and module logic  

AI Input Insulation Insulation resistance 100 MΩ @ 500 V DC per IEC255-5 

User Connection 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG 

Cable and TB Holder 40 wire cable with Terminal Block Holder connector, 26 AWG  

Module Replacement Hot swap replacement– module extraction/insertion under voltage 

Operating Voltage 10.8-16 V DC and 3.3 V DC (from the motherboard connector)  

Power Consumption 
(measured at power supply in) 

1.9 W typical with all LEDs on/outputs off (140 mA @ 13.8 
VDC) 
3.4 W typical with all LEDs on/all outputs 20 mA (250 mA @ 
13.8 VDC) 

Dimensions 37 mm W x 225 mm H  x 180 mm D (1.5" W x 8.7" H x  7.1" D) 

Weight Approx. 0.34 Kg  (0.75 Lb) 
 

Specifications subject to change without notice. 
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RADIO TYPES AND INSTALLATION KITS 

ACE3600 Radio Types 

 

In order to prevent overheating of the radio and degradation of radio 
performance, the radio should not exceed operating duty factors of 30% 
transmission and 70% receive mode. 

Note that the operating temperature range of ACE3600 RTU models that 
include a radio is from -30 ºC to +60 ºC (-22 ºF to +140 ºF).  (The operating 
temperature range of the ACE3600 RTU models without a radio is from -40 
ºC to +70 ºC (-40 ºF to +158 ºF)).   

The ACE3600 RTU supports conventional, analog trunked radios and digital trunked radios.  It 
also supports data radios and various wireless modems.  Conventional and analog trunked 
radios are connected to a plug-in radio modem port.  Digital trunked radios and wireless 
modems are connected to an RS232 port.  For information on configuring CPU ports for 
various radios/modems, see the ACE3600 STS User Guide.  For information on IP 
communications over such modems, see the ACE3600 STS Advanced Features manual. 

The following conventional/trunked mobile analog and digital radios and conventional portable 
analog and digital radios can be used with the ACE3600 RTU:  

 Analog Motorola Radios Digital Motorola 
Radios 

Third Party Radios 

Trunked XTL5000/XTL2500 XTL5000/XTL2500   

  XTS2500  

CM200/CM140/EM200/ 
GM3188 

 MDS 9810/MDS 4710/ 
MDS 9710 

GP320/GP328/HT750/ 
PRO5150 

 TransNET 900™* 
OEM 

Conventional 

CDM750  iNET 900™ 
 
For complete radio specifications such as modulations, standards, Tx power output, Rx 
sensitivity, supply voltage, and power consumption, see the specific radio owner’s manual.  
Please note that third party radios are not provided with the RTUs. 

The following table lists all the ACE3600 models that include radios. 

                                                      
* TransNET 900 and iNET 900 are trademarks of GE MDS. 
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Conventional VHF Radio ACE3600 Model 

ACE3600 for CM200/CM140/EM200/GM3188 VHF F7573A 

ACE3600 with CDM750 136-174 MHz F7563A 

ACE3600 for HT750/GP320/GP328 /PRO5150 VHF F7553A 

Conventional UHF Radio  

ACE3600 for CM200/CM140/EM200/GM3188 UHF F7574A 

ACE3600 with CDM750 403-512 MHz F7564A 

ACE3600 for HT750/GP320/GP328 /PRO5150 UHF F7554A 

Trunked VHF Radio  

ACE3600 with XTL5000 136-174 MHz Analog F7523A 

ACE3600 with XTL5000 136-174 MHz Digital F7513A 

ACE3600 with XTL2500 136-174 MHz Analog F7533A 

ACE3600 with XTL2500 136-174 MHz Digital F7593A 

ACE3600 with XTS2500 136-174 MHz  Digital  F7543A 

Trunked UHF Radio  

ACE3600 with XTL5000 380-520 MHz Analog F7524A 

ACE3600 with XTL5000 380-520 MHz Digital F7514A 

ACE3600 with XTL2500 380-520 MHz Analog F7534A 

ACE3600 with XTL2500 380-520 MHz Digital F7594A 

ACE3600 with XTS2500 380-520 MHz Digital  F7544A 

Trunked 800MHz Radio  

ACE3600 with XTL5000 800MHz Analog F7585A 

ACE3600 with XTL5000 800MHz Digital F7586A 

ACE3600 with XTL2500 800MHz Analog F7538A 

ACE3600 with XTL2500 800MHz Digital F7598A 

ACE3600 with XTS2500 800 MHz Digital F7548A 
 

For a list of the radio models and regional options for the CM/EM/GM radios, see CM/EM/GM 
Radio Models and Regional Options for ACE3600 below. For a list of the radio models and 
regional options for the GP/HT/PRO radios, see GP/HT/PRO Radio Models and Regional 
Options for ACE3600 below. 

IMPORTANT: Only model F7509A and all its options, including radio installation kits, may 
be shipped to European Union (EU) countries.  The installer must confirm that there are no 
emissions or harmful interference to the spectrum due integrating the radio into this model.  

The radios in the models listed in the table above are installed on the RTU using the 
installation radio kits described below. 
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Radio Installation Kits 
The following radio installation kits enable the user to install a radio in the ACE3600 RTU. 

     Option/Kit  

CDM750 V143AH/ 
FLN3638A 

MDS 9810, MDS 4710, MDS 9710 V152AK/ 
FLN3853A 

TransNET 900 OEM VA00225AA/ 
FLN3852A 

iNET 900 V680AH/ 
FLN3854A 

NA EMEA APAC LA  

Conventional 
Mobile Radios 

CM200 CM140 GM3188 EM200 V148AC/ 
FLN3635A 

NA EMEA APAC LA  Conventional 
Portable Radios 

HT750 GP320 GP328 PRO5150 V154AE/ 
FLN3637A 

      

Analog Trunking 
Mobile Radios 

XTL5000/XTL2500 V157AB/ 
FLN3640A 

XTL5000/XTL2500 V681AT/ 
FLN3649A 

Digital Trunking 
Mobile Radios 

XTS2500 V156AG/ 
FLN3814A 

 

For instructions on mounting the radio on the ACE3600 frame, see the desired installation 
instructions below. 

For general instructions on mounting a radio on the wall, see Mounting the ACE3600 Radios 
on a Wall below. 

Note: A TORX screwdriver is required for the installation kits. 
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XTL5000/XTL2500 Radio Installation Kit 
The XTL5000/XTL2500 radio installation kit (ACE3600 option V681AT or V157AB) enables 
the user to install the XTL5000/XTL2500 radio in ACE3600 Remote Terminal Units (RTU).  
The ACE3600 can use the XTL5000/XTL2500 in two operation modes, depending on the 
system used. 

• Digital mode (ACE3600 option V681AT) - suitable for Astro 6.x/7.x system trunked 
ASTRO IV&D only  

• Analog mode (ACE3600 option V157AB) - suitable for SmartNet 3.x system or Astro 
4.x system (on the analog part only) 

The following hardware and firmware are required: 

• Radio firmware version 6.3E and above for digital trunked ASTRO IV&D.  (For 6.3E, 
HOST R04.51.01 DSP R04.50.00; for 6.5 HOST R05.00.00 and DSP R05.00.00)  

• Radio firmware version 6.5E and above for analog trunked system (DSP version 
R06.00.00 for radio firmware R06.01.00)   

• ASTRO Infrastructure version SR6.3 and above for trunked ASTRO IV&D 

• Smartnet version 3.x or Astro version 4.x for analog trunked system 

• ACE3600 firmware 10.00 and above  

• ACE3600 System Tools Suite (STS) version 10.50 and above 

The FLN3649A/FLN3640A installation kits include a bracket, cables, and screws. 

IMPORTANT: The XTL5000/XTL2500 radio control head must be radio option O5 for 
revolving power button control head. 

 

Installation 
The XTL5000/XTL2500 radio can be mounted on the ACE3600 RTU using the metal bracket 
and cables as follows: 

Procedure 13-1 How to Install the XTL5000/XTL2500 Radio on the Metal Chassis 

1. Attach the radio plug-in port from the installation kit (FLN3696A) to the desired opening 
on the ACE3600 CPU module.  For instructions on attaching plug-in ports, see 
Connecting Plug-In Ports to the CPU Module in the CPU Module chapter above. 

2. Attach the XTL5000/XTL2500 radio to the metal bracket (#0789422V41 from 
FHN6895A) using the four supplied radio screws (#0310906A67), two on each side.  
(See Figure 13-1.)  The wider side of the bracket should be on the right side of the radio 
(closer to the knobs.) 

3. Connect the 26-pin connector of the signal cable (FKN8432A for digital mode or 
FKN8438A for analog mode) to the Accessory connector on the radio.  In analog mode 
only, place one Fair-Rite soft ferrite (#7683477X01 from the supplied ferrite kit 
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FHN7007A) on the signal cable (FKN8438A) near the bottom of the CPU door, loop the 
cable one turn around it, and clamp the ferrite on the cable.   
Connect the other end of the communication cable to the ACE3600 CPU module port 
configured for the radio. (See Figure 13-2 and Figure 13-4.)  For digital mode use any of 
the serial on-board or plug-in ports.  For analog mode only the plug-in ports may be used.  
See RTU Port Configuration for the Astro IV&D Digital Radio and RTU Port 
Configuration for the Astro IV&D Analog Trunked Radio below. 

4. Connect the DC power cable (FKN8436A) to the Power connector on the radio and the 
free red wire to the ignition pin on the FKN8432A/FKN8438A cable.  Connect the 
opposite end of the power cable to the AUX2A or AUX2B connector on the ACE3600 
power supply unit.  (See Figure 13-2 and Figure 13-4.) 

 

 

               

 

Figure 13-1  XTL5000/XTL2500 Radio and Metal Bracket 
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Figure 13-2  XTL5000/XTL2500 Radio Cable Connections- Rear View 
 

5. Mount the bracket on the RTU chassis above the CPU and I/O modules, using the four 
built-in screws.  (See Figure 13-4.)  The wider side of the bracket is attached to the 
chassis. 

6. Connect the antenna cable (FKN8437A) to the Antenna connector on the radio.  Run the 
cable through the small white clips along the edge of the chassis and attach the connector 
to the opening on the bottom of the ACE3600 RTU housing.  (See Figure 13-2 and 
Figure 13-4.) 

  

 

Figure 13-3  XTL5000/XTL2500 Radio Bracket with Four Bracket Mounting Screws 
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Figure 13-4  XTL5000/XTL2500 Radio 
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Port Type (for Astro IV&D Digital Radio) 
Procedure 13-2 How to Configure the ACE3600 Port for the Astro IV&D Digital Radio 

1. In the ACE3600 STS click on the desired site, and open the site view.   

2. In the Port Tab, click on the on-board or plug-in port through which the RTU will 
communicate with the XTL5000/XTL2500 radio.   

3. Confirm that the port parameters and data speed are as shown in the screen below. 

4. Define desired links. 

5. If you plan to synchronize the RTU time from the Front End Processor (FEP) in the 
Customer Enterprise Network (CEN), specify the IP address of the FEP in the NTP field.  
This IP address information is provided by your ASTRO IV&D system operator.  

6. Save the changes. 

 

Figure 13-5  RTU Site Configuration for MDLC over ASTRO IV&D – Port Type Parameters 
 

Advanced Parameter Configuration (for Astro IV&D Digital Radio) 

 

Figure 13-6  RTU Site Configuration for MDLC over ASTRO IV&D – Advanced Parameters 
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Generally no other changes are required to Advanced Physical or Link Layer parameters.  For 
information on these parameters, see the MDLC over IP chapter of the ACE3600 STS 
Advanced Features manual. 

Procedure 13-3 How to Configure the Advanced Parameters of the ACE3600 Port for the Astro 
IV&D Digital Radio 

1.  (ASTRO System 6.3-6.5 only) Make sure that the Advanced Link parameter 
Registration life time to 28800 seconds (default) in order to restart the radio periodically.   

2. If any changes are required, click on the appropriate screen in the Port Tab.   

3. Change the settings as necessary.  
Note:  The Default Group ID Address should be left 000.000.000.  The actual values will 
be read by the RTU from the radio upon connection.  

4. Save any changes. 

5. Save the project. 

6. Download the site configuration to the ACE3600 RTU. 

IP Conversion Table (for Astro IV&D Digital Radio) 
Prepare an IP conversion table if the RTU must communicate with another RTU or an IP 
Gateway.  In the IP conversion table, specify the IP address of each RTU port (site ID + link 
ID).  This IP address is assigned by the infrastructure operator. 

Note that an IP address is obtained from the radio once it is connected to the RTU port over 
PPP. The IP address obtained from the radio is not the real IP address set by the infrastructure, 
but rather a dummy address.  This dummy is configured in the radio via the CPS Mobile 
Computer IP address parameter (by default 192.168.128.2).   

When device LINxL level 0 is retrieved using the ACE3600 STS Software Diagnostics tool, 
the IP Address displayed is this dummy address and not the actual IP address assigned by the 
infrastructure operator.   

It is recommended to create two IP conversion tables:  

1. The first is downloaded to the FIU or IP Gateway on the LAN and includes the site and 
IP information for each RTU. 

2. The second is downloaded to all RTUs which are connected to the infrastructure with 
ASTRO IV&D radios, and includes the site and IP information for the FIU and IP 
Gateway. 

For detailed instructions on preparing the IP conversion table, refer to the IP Communications 
chapter of the ACE3600 STS Advanced Features manual. 

Radio Programming using CPS for the Astro IV&D Digital 
The XTL5000/XTL2500 radio is programmed for ACE3600 in the factory and is ready for 
ASTRO IV&D communication.  For user programming of site-specific parameters, the radio 
should be brought to the Motorola Service Center.   
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Radio Connections 
To program the XTL5000/XTL2500 radio with Customer Programming Software (CPS), the 
radio must be connected to a PC.   

Procedure 13-4 How to Connect the XTL5000/XTL2500 Radio to the CPS 

1. Connect one end of the programming cable (HKN6155) to the microphone connector on 
the front of the radio.  This cable is not supplied and must be ordered separately. 

2. Connect the other end to the serial port of a PC on which the ASTRO CPS software 
(RVN4185) is installed. 

Radio Disassembly 
If the XTL5000/XTL2500 radio is to be programmed outside of the ACE3600 housing, 
disassemble the radio as follows:  

Procedure 13-5 How to Disassemble the XTL5000/XTL2500 Radio from the ACE3600 Metal 
Chassis 

1. Disconnect the antenna cable (FKN8437A) from the Antenna connector on the radio. 

2. Remove the radio/bracket unit from the RTU chassis by unscrewing the four built-in 
screws. 

3. Disconnect the DC power cable (FKN8436A) from the Power connector on the radio. 

4. Disconnect the 26-pin connector of the signal cable (FKN8432A/FKN8438A) from the 
Accessory connector on the radio. 

5. Detach the metal bracket (#0789422V41 from FHN6895A) by unscrewing the four radio 
screws (#0310906A67), two on each side. (See Figure 13-1.) 

6. Take the radio to a laboratory for programming, as described in CPS Programming 
Settings below. 

CPS Programming Settings 
Before programming the radio, read the codeplug file from the radio and save it to your PC 
using the File >Read Device command in the CPS (R04.01.01 for radio firmware 6.3E; 
R05.00.00 for firmware 6.5).  Open the codeplug file in the CPS and set the parameters as 
follows. 

Procedure 13-6 How to Program the XTL5000/XTL2500 Digital Radio 

1. In the CPS, click on the codeplug in the tree view to view and select the items below or 
select them from the Feature menu. 

2. Under Radio Configuration, double-click on Radio Wide.  

a. In the Transmit Power Levels tab, reduce the radio power level to low: Change 
TX Power Level Low for Freq. Range A from 16.5 to 10. (Range A 700Mhz 
UHF and VHF). 

1) Change TX Power Level Low for Freq. Range B from 19.0 to 10. (Range B 
800Mhz and UHFR2 (470-520Mhz). 
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2) Change TX Power Level High for Freq. Range A from 33.0 to 15. 

3) Change TX Power Level High for Freq. Range B from 38.5 to 15. 

b. In the General tab, set the Out of Range Indicator and Imbalanced Coverage 
Indicator to Alert & Display. 

c. (Recommended) In the Data tab, enable SNMP Traps.  (You can disable it, but 
the RTU will only detect a loss of context activation the next time it polls the 
radio (every 10 seconds by default). 

d. (Optional) Specify the Mobile Computer IP address. This is the dummy IP 
address assigned to the RTU by the radio (by default it is 192.168.128.2).  For 
each radio, it is recommended to change the last digit in the Mobile Computer IP 
address (e.g. to the Unit ID in Trunking systems.)  

e. (CPS R05.00.00 only) In the Advanced tab, make sure that "MOSCAD Data 
Enable" is not enabled (not checked.)  (For IV&D only.  For communication over 
analog ASTRO Trunking, leave it enabled.)  Set Extended DEK to Enable and 
Ignition Switch to Soft Power Off. 

3. Double-click on NAT List -> NAT List Entry 1. 

a. Add an entry to the NAT List: 

1) WAN port =  MDLC over IP port number (e.g. 2002) 

2) LAN port = MDLC over IP port number (e.g. 2002) 

3) Static NAT IP Address = Mobile Computer IP Address (e.g. 192.168.128.2).  

4) The Mobile Computer address should match the Mobile Computer IP Address 
assigned on the Radio Configuration>Radio Wide>Data tab in Step 2 above. 

4. Double-click on Trunking ->Trunking System ->Trunking System 1. 

a. In the General tab, set the Type to ASTRO 25.  If the proper system key was 
loaded, the System Key field should already be enabled. 

b. Set the ASTRO 25 Home System ID, Home WACN ID and Unit ID to values 
obtained from the radio system administrator.  

c. Under Coverage Type, set the type to SmartZone. 

d. In the Astro 25 Channel ID tab, enable the first channel. 

e. In the 700/800 Astro 25 Control Channels tab (700_800 or OBT depending on 
the band), enter the control channels with which the data subscriber should be 
able to affiliate. Consult your radio system administrator for the list of control 
channels.  

f. In the Data tab, enable Packet Data Capable System (PDS), and Terminal Data 
and disable (uncheck) Rx Voice Interrupts Data. 

5. Double-click on Trunking ->Trunking Personality ->Trunking Personality 1. 
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a. In the General tab, set the Protocol Type to ASTRO 25 and set the System & ID 
to 1. 

b. In the 700/800 Failsoft tab, data only subscribers should set Failsoft Type to 
disabled.  (There is no data service unless the subscriber is affiliated to a wide-
area trunking site.) 

c. In the Talkgroup tab, set the radio talkgroup value in hexadecimal.  Consult your 
radio system administrator for the talkgroup information. 

d. (Recommended) In the Preferred Sites tab, set the status of the first record to 
None.  (This means that data only subscribers are not locked into preferred sites.) 

6. Double-click on Zone Channel Assignment ->Zone Channel Assignment. 

a. In the Zone tab, set the Zone to the desired zone name (e.g. ZONE1). 

b. In the Channels tab, set the Channel to the name which will be displayed on the 
radio screen (if the radio is Model II or III).  

c. Select the Personality type of that channel.  

d. Specify the Personality # of that channel. 

e. Specify the Talkgroup # of that channel. 

7. From the Tools menu, select the Change Control Head command.  Make sure the Control 
Head Type is set to O5(M5) for new models and to W4 for old models, and click OK.  

8. From the File Menu, select Save to save changes to the radio. 

9. From the File Menu, select Write Device to download the configuration to the radio. 

Infrastructure Configuration for the Astro IV&D Digital Radio 
In order for the ACE3600 RTU to communicate over the ASTRO IV&D infrastructure (6.4 or 
later) using the XTL5000/XTL2500 digital radio, the infrastructure must be properly 
configured using the UCM (User Configuration Manager) tool.  

Note: If configuring a border router or any firewall within the CEN (Customer Enterprise 
network), make sure that the ACE3600’s MDLC over IP UDP port number 2002 is enabled for 
inbound and outbound messages. 

Note: In the UCM Radio User Data Settings tab, be sure to set the IP address as Static, to 
enable Generate ICMP and Source Address Checking, and the Ready timer set to 10 seconds.  

 

RTU Port Configuration for the Astro IV&D Analog Trunked Radio 
To enable MDLC communication using Astro XTL5000/XTL2500 radios, use the ACE3600 
STS site configuration utility to configure the ACE3600 RTU port (either on-board serial or 
plug-in port) connected to the radio.  For more information, refer to the IP Communications 
chapter of the ACE3600 STS Advanced Features manual.    
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Port Type (for Analog Trunked Radio) 
Procedure 13-7 How to Configure the ACE3600 Port for the Astro IV&D Analog Radio 

1. In the ACE3600 STS click on the desired site, and open the site view.     

2. In the Port Tab, click on the plug-in port through which the RTU will communicate with 
the XTL5000/XTL2500 radio.   

3. Set the port parameters as shown in the screen below.  The Trunk system parameter 
should reflect the type of trunking system (e.g. SmartNet, SmartZone.) 

4. Save the changes. 

 

Figure 13-7  RTU Site Configuration for MDLC over Analog Trunked System – Port Type 
Parameters 

 

Programming the XTL5000/XTL2500 Analog Trunked Radio using CPS 
The XTL5000/XTL2500 radio is programmed for ACE3600 in the factory and is ready for 
analog trunked communication.  For user programming of site-specific parameters, the radio 
should be brought to the Motorola Service Center.   

Radio Connections 
Follow the Radio Connections instructions described under Radio Programming using CPS for 
the Astro IV&D Digital above.  

Radio Disassembly 
Follow the Radio Disassembly instructions described under Radio Programming using CPS for 
the Astro IV&D Digital above.   

CPS Programming Settings 
Before programming the radio, read the codeplug file from the radio and save it to your PC 
using the File >Read Device command in the CPS (DSP version R06.00.00 for radio firmware 
R06.01.00.)  Open the codeplug file in the CPS and set the parameters as follows. 

Procedure 13-8 How to Program the XTL5000/XTL2500 Analog Radio 

1. In the CPS, click on the codeplug in the tree view to view and select the items below or 
select them from the Feature menu. 

2. Under Radio Configuration, double-click on Radio Wide.  

a. In the Transmit Power Levels tab, reduce the radio power level to low: Change 
TX Power Level Low for Freq. Range A from 28.0 to 10.  

1) Change TX Power Level High for Freq. Range A from 53.5 to 15.  



Radio Types and Installation Kits 

13-14 

b. In the Advanced tab, make sure that "MOSCAD Data Enable" is enabled.  Set 
Extended DEK to Enable and Ignition Switch to Soft Power Off. 

c. In the Time Out Timer tab, make sure the Time # is set to 3 (for 60 sec).  

3. Double-click on Controls. 

a. Click on Control Head. 

b. Make sure the Control Head is O5(M5) for new models and W4 for old models. 

c. Click on Radio VIP.   

1) Set VIP In for VIP 1, VIP 2, and VIP 3 to Blank. 

2) Set VIP Out for VIP 1 to MOSCAD CG. 

3) Set VIP Out for VIP 2 to MOSCAD TXE/CM. 

4) Set VIP Out for VIP 3 to NULL. 

4. Double-click on Conventional ->Conventional Personality -> Conventional Personality 1. 

a. In the Rx Options tab, set Unmute/Mute Type to UnMute, Or Mute. 

b. Set Rx Voice/Signal Type to Non-Astro. 

c. Enable (check) Rx Emphasis and Busy LED. 

d. In the Tx Options tab, make sure that the Time Out Timer is set to 3 (for 60 sec). 

e. Set Tx Voice/Signal Type to Non-Astro. 

f. Set Transmit Power Level to High. 

5. Double-click on Trunking ->Trunking System ->Trunking System 1. 

a. In the General tab, if the proper system key was loaded, the System Key field 
should already be enabled. 

b. Set the Type to II. 

c. Set the Type II System ID, and Connect Tone to values obtained from the radio 
system administrator for the site. 

d. Under Coverage Type, set the type to Disabled. 

e. In the Type II tab, set the Individual ID to the value obtained from the radio 
system administrator for the site. 

f. Set the Affiliation type to Automatic. 

g. In the Channel Assignment tab, enter the Rx and Tx channel ranges. Consult 
your radio system administrator for the list of values. 
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h. In the OBT Control Channels tab, set the RX Frequency and TX Frequency of 
each control channel with which the data subscriber should be able to affiliate. 
Consult your radio system administrator for the list of control channels. 

6. Double-click on Trunking ->Trunking Personality ->Trunking Personality 1. 

a. In the General tab, set the Protocol Type to II and set the System ID to the value 
obtained from the radio system administrator for the site.  Make sure that the 
Time Out Timer is set to 3 (for 60 sec).  Check that the Type II Individual ID is 
set to the value obtained from the radio system administrator for the site. 

b. In the Talkgroup tab, set the radio talkgroup value in hexadecimal.  Consult your 
radio system administrator for the talkgroup information.  (Note: Talkgroup for 
voice in analog trunking is the same for voice and data on analog trunk. 

7. From the File Menu, select Save to save changes to the radio. 

8. From the File Menu, select Write Device to download the configuration to the radio. 

XTL5000/XTL2500 Radio Models and Options for ACE3600 
The XTL5000/XTL2500 radio installation kit is used with one of the following 
XTL5000/XTL2500 radio:  

Description Nomenclature Band 

XTL5000 Mobile 10-35 W, 764-870MH M20URS9PW1 N 764 - 870 MHz 

XTL5000 UHF R1 Mobile 10-40 W 380-470 M20QSS9PW1 N 380 - 470Mhz 

XTL5000 UHF R2 450-520 MHZ 10-45 W M20SSS9PW1 N 450 - 520Mhz 

XTL5000 VHF Mobile 10-50 W 136-174 MHZ M20KSS9PW1 N 136 - 174Mhz 

XTL2500 Mobile 10-35 W, 764-870MHz  M21URM9PW1N 764-870 MHz 

XTL2500 Mobile 10-40 W, 380-470MHz   M21QSM9PW1 N 380-470MHz 

XTL2500 Mobile 10-45 W, 450-520MHz    M21SSM9PW1 N 450-520 MHz 

XTL2500 Mobile 10-50 W, 136-174MHz   M21KSM9PW1 N 136-174 MHz 
 

All of the following options may be ordered with the XTL5000/XTL2500 radio:  

Option Name Option Number 

ADD: O5 CONTROL HEAD G442 

ADD: NO MICROPHONE NEEDED G90 

ENH: SOFTWARE ASTRO DIGITAL CAI OPERATION G806 

ENH: ASTRO PROJECT 25 TRUNKING SOFTWARE G361 

ADD: CONTROL HEAD SOFTWARE, O5 G444 

ENH: SMARTZONE OPERATION G51 

ENH: RS232 PACKET DATA INTERFACE W947 
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Option Name Option Number 

ADD: DASH MOUNT G66 

ADD: NO SPEAKER G142 

ADD: NO ANTENNA G89 
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XTS2500 Radio Installation Kit 
The XTS2500 radio installation kit (ACE3600 option V156AG or kit FLN3814A) enables the 
user to install the XTS2500 radio in ACE3600 Remote Terminal Units (RTU).  The RTU can 
use the XTS2500 in digital mode to communicate over the ASTRO 6.x/7.x system.  The 
following hardware and firmware are required: 

• Radio firmware version 6.4 and above for trunked IV&D 

• ASTRO Infrastructure version SR6.5 and above for trunked IV&D 

• ACE3600 firmware 10.00 and above 

• ACE3600 System Tools Suite (STS) version 10.50 and above  

The installation kit includes brackets, cables, screws and installation instructions. 

After the XTS2500 radio is installed in the RTU, the RTU port is configured, the IP address 
information is downloaded, the radio is context activated and finally, communication from the 
RTU over the air is verified.  For more information on MDLC over ASTRO IV&D (Integrated 
Voice & Data), refer to the MDLC over IP chapter of the ACE3600 STS Advanced Features 
Manual. 

Installation 

 

Before installing the XTS2500 radio on the RTU, configure the power supply AUX2A/B 
connector to 7.5V DC in the ACE3600 STS site configuration (using the Power Supply <n> 
Auxiliary 2 voltage parameter.)  Download the updated site configuration to the RTU.  Failure 
to do so might damage the radio.  

The installation kit includes a radio bracket, metal bracket with built-in screws, power cables, 
communication cable, antenna cable and plastic strips.  The XTS2500 can be mounted on the 
ACE3600 RTU using the kit as follows: 

Procedure 13-9 How to Install the XTS2500 Radio on the Metal Chassis 

1. Attach the XTS 2500 radio to the radio bracket (from FHN6674A).  (See Figure 13-8.)   

2. Connect the programming cable (RKN4106A) provided with the radio to the Accessory 
connector on the radio.  (See Figure 13-10.)  Connect the other end of the programming cable 
to the 9-pin D-type (Radio) connector on the communication cable (FKN8516A) and tighten 
the screws attached to the programming cable.  Do not use the 25-pin connector; it is for 
programming only. 

3. Connect the other end of the communication cable (RJ45 connector) to the plug-in port of 
the ACE3600 CPU.  

4. Connect the 7.5V DC power cable (FKN8515A) to the AUX2A or AUX2B auxiliary 
power output connector on the RTU power supply.  Connect the other end of the power cable 
to the DC adapter on the radio bracket (FHN6674A).  (See Figure 13-9 and Figure 13-10.) 
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Figure 13-8  XTS2500 Radio and Metal Bracket 
 

5. Add the BNC adapter (#5871143Y04) to the XTS2500 radio antenna connector.  (See 
Figure 13-9.) 

6. Attach the BNC connector of the antenna cable (FKN8434A) to the radio's BNC adapter.  
Route the antenna cable through the small wire clamps along the left side edge of the RTU 
chassis, according to the placement of the radio on the chassis. Attach the N-type connector at 
the other end to the opening on the bottom of the RTU housing using the supplied locking 
washer and nut.  (See Figure 13-9.) 

7. Mount the radio/bracket unit on the metal bracket (#0789422V40 from FHN6674A) 
using the four supplied screws.    

8. Mount the metal bracket on the RTU chassis above the I/O modules, using the three built-
in screws, with the bottom of the radio towards the chassis. (See Figure 13-9.)  

9. Attach all cables to the chassis using the supplied wire clamps. 
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XTS25000 
Radio 

Adapter 
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Figure 13-9  XTS2500 Radio Installed on ACE3600 Chassis 
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Figure 13-10  XTS2500 Radio Installed on ACE3600 Chassis - Cable Connections 
 

RTU Port Configuration 
To enable MDLC communication over ASTRO IV&D, use the ACE3600 STS (≥V10.50) to 
configure the RTU port connected to the XTS25000 radio.  For more information, refer to the 
MDLC over IP chapter of the ACE3600 STS Advanced Features manual. 

The following figures show the port configuration and advanced parameter configuration.  
Although these show Port SI1, the same values can be applied to other ports, where relevant.   

Port Type 
Procedure 13-10 How to Configure the ACE3600 Port for the Astro XTS2500 Digital Radio 

1. In the ACE3600 STS click on the desired site, and open the site view.   

2. In the Port Tab, click on the on-board or plug-in port through which the RTU will 
communicate with the XTS2500 radio.   

3. Confirm that the port parameters and data speed are as shown in the screen below. 

4. Define desired links. 

5. If you plan to synchronize the RTU time from the Front End Processor (FEP) in the 
Customer Enterprise Network (CEN), specify the IP address of the FEP in the NTP field.  
This IP address information is provided by your ASTRO IV&D system operator.  

6. Save the changes. 
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Figure 13-11  RTU Site Configuration for MDLC over ASTRO IV&D – Port Type Parameters 
 

Advanced Parameter Configuration 

 

Figure 13-12  RTU Site Configuration for MDLC over ASTRO IV&D – Advanced Parameters 
 

Generally no other changes are required to Advanced Physical or Link Layer parameters.  For 
information on these parameters, see the MDLC over IP chapter of the ACE3600 STS 
Advanced Features manual. 

Procedure 13-11 How to Configure the Advanced Parameters of the ACE3600 Port for the 
Astro XTS2500 IV&D Digital Radio 

1. (ASTRO System 6.3-6.5 only) Make sure that the Advanced Link parameter Registration 
life time to 28800 seconds (default) in order to restart the radio periodically.   

2. If any changes are required, click on the appropriate screen in the Port Tab.   

3. Change the settings as necessary.  
Note:  The Default Group ID Address should be left 000.000.000.  The actual values will 
be read by the RTU from the radio upon connection.  

4. Save any changes. 

5. Save the project. 
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6. Download the site configuration to the ACE3600 RTU. 

 

IP Conversion Table (for Astro XTS2500 IV&D Digital Radio) 
Prepare an IP conversion table if the RTU must communicate with another RTU or an IP 
Gateway.  In the IP conversion table, specify the IP address of each RTU port (site ID + link 
ID).  This IP address is assigned by the infrastructure operator. 

Note that an IP address is obtained from the radio once it is connected to the RTU port over 
PPP. The IP address obtained from the radio is not the real IP address set by the infrastructure, 
but rather a dummy address.  This dummy is configured in the radio via the CPS Mobile 
Computer IP address parameter (by default 192.168.128.2).   

When device LINxL level 0 is retrieved using the ACE3600 STS Software Diagnostics tool, 
the IP Address displayed is this dummy address and not the actual IP address assigned by the 
infrastructure operator.   

It is recommended to create two IP conversion tables:  

1. The first is downloaded to the FIU or IP Gateway on the LAN and includes the site and 
IP information for each RTU. 

2. The second is downloaded to all RTUs which are connected to the infrastructure with 
ASTRO IV&D radios, and includes the site and IP information for the FIU and IP 
Gateway. 

For detailed instructions on preparing the IP conversion table, refer to the IP Communications 
chapter of the ACE3600 STS Advanced Features manual. 

Radio Programming using CPS for the Astro XTS2500 IV&D Digital 
The XTS2500 radio is programmed for ACE3600 in the factory and is ready for ASTRO 
IV&D communication.  For user programming of site-specific parameters, the radio should be 
brought to the Motorola Service Center.   

Radio Connections 
To program the XTS2500 radio with Customer Programming Software (CPS), the radio must 
be connected to a PC.   

Procedure 13-12 How to Connect the XTS2500 Radio to the CPS 

1. Power on the radio. 

2. Disconnect the programming cable (RKN4106A) from the 9-pin D-type (Radio) 
connector on the data cable (FKN8516A). 

3. Connect the D-type connector of the programming cable (RKN4106A) to the serial port 
of a PC on which the ASTRO CPS software is installed.  

4. Program the radio using the CPS, as described in CPS Programming Settings below. 

5. After radio programming, reconnect the communication and programming cables as 
described in the Installation section above. 
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Radio Disassembly 
If the XTS2500 radio is to be programmed outside of the ACE3600 housing, disassemble the 
radio as follows:  

Procedure 13-13 How to Disassemble the XTS2500 Radio from the ACE3600 Metal Chassis 

1. Disconnect the antenna cable (FKN8434A) from the Antenna connector on the radio. 

2. Remove the radio/bracket unit from the RTU chassis by unscrewing the three built-in 
screws. 

3. Disconnect the DC power cable (FKN8515A) from the Power connector on the radio. 

4. Disconnect the 13-pin connector of the programming cable (RKN4106A) from the 
Accessory connector on the radio. 

5. Detach the metal bracket (#0789422V40 from FHN6674A) by unscrewing the four radio 
screws (#0310906A67), two on each side. (See Figure 13-9.) 

6. Take the radio to a laboratory for programming, as described in CPS Programming 
Settings below. 

CPS Programming Settings 
Before programming the radio, read the codeplug file from the radio and save it to your PC 
using the File->Read command in the CPS (R05.00.00 or above).  Open the codeplug file in 
the CPS and set the parameters as follows. 

Procedure 13-14 How to Program the XTS2500 Digital Radio 

1. In the CPS, click on the codeplug in the tree view to open the items below. 

2. Under Radio Configuration, double-click on Radio Wide.  

a. In the General tab, set the Out of Range Indicator and Imbalanced Coverage 
Indicator to Alert & Display. 

b. (Recommended) In the Data tab, enable SNMP Traps.  (You can disable it, but 
the RTU will only detect a loss of context activation the next time it polls the 
radio (every 10 seconds by default). 

c. (Optional) Specify the Mobile Computer IP address. This is the dummy IP 
address assigned to the RTU by the radio (by default it is 192.168.128.2).  For 
each radio, it is recommended to change the last digit in the Mobile Computer IP 
address (e.g. to the Unit ID in Trunking systems.) 

3. Double-click on NAT List -> NAT List Entry 1. 

a. Add an entry to the NAT List: 

1) WAN port =  MDLC over IP port number (e.g. 2002) 

2) LAN port = MDLC over IP port number (e.g. 2002) 

3) Static NAT IP Address = Mobile Computer IP Address (e.g. 192.168.128.2).  
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The Mobile Computer address should match the Mobile Computer IP Address 
assigned on the Radio Configuration>Radio Wide>Data tab in Step 2 above. 

4. Double-click on Trunking ->Trunking System ->Trunking System 1. 

a. In the General tab, set the Type to ASTRO 25.  If the proper system key was 
loaded, the System Key field should already be enabled. 

b. Set the ASTRO 25 Home System ID, Home WACN ID and Unit ID to values 
obtained from the radio system administrator. 

c. Under Coverage Type, set the type to SmartZone. 

d. In the Astro 25 Channel ID tab, enable the first channel. 

e. In the 700/800 Astro 25 Control Channels tab (700_800 or OBT depending on 
the band), enter the control channels with which the data subscriber should be 
able to affiliate. Consult your radio system administrator for the list of control 
channels.  

f. In the Data tab, enable Packet Data Capable System (PDS), and Terminal Data 
and disable (uncheck) Rx Voice Interrupts Data. 

5. Double-click on Trunking ->Trunking Personality ->Trunking Personality 1. 

a. In the General tab, set the Protocol Type to ASTRO 25 and set the System & ID 
to 1. 

b. In the 700/800 Failsoft tab, data only subscribers should set Failsoft Type to 
disabled.  (There is no data service unless the subscriber is affiliated to a wide-
area trunking site.) 

c. In the Talkgroup tab, set the radio talkgroup value in hexadecimal.  Consult your 
radio system administrator for the talkgroup information. 

d. (Recommended) In the Preferred Sites tab, set the status of the first record to 
None.  (This means that data only subscribers are not locked into preferred sites.) 

6. Double-click on Zone Channel Assignment ->Zone Channel Assignment. 

a. In the Zone tab, set the Zone to the desired zone name (e.g. ZONE1). 

b. In the Channels tab, set the Channel to the name which will be displayed on the 
radio screen (if the radio is Model II or III).  

c. Select the Personality type of that channel.  

d. Specify the Personality # of that channel. 

e. Specify the Talkgroup # of that channel. 

7. From the File Menu, select Save to save changes to the radio. 

8. From the File Menu, select Write Device to download the configuration to the radio. 
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Infrastructure Configuration for the Astro IV&D XTS2500Digital Radio 
In order for the ACE3600 RTU to communicate over the ASTRO IV&D infrastructure (6.4 or 
later) using the XTS2500 digital radio, the infrastructure must be properly configured using the 
UCM (User Configuration Manager) tool.  

Note: If configuring a border router or any firewall within the CEN (Customer Enterprise 
network), make sure that the ACE3600’s MDLC over IP UDP port number 2002 is enabled for 
inbound and outbound messages. 

Note: In the UCM Radio User Data Settings tab, be sure to set the IP address as Static, to 
enable Generate ICMP and Source Address Checking, and the Ready timer set to 10 seconds.  

XTS2500 Radio Models and Options for ACE3600 
The XTS2500 radio installation kit is used with one of the following XTS2500 radio:  

Description Nomenclature Band 

XTS2500 PORTABLE 1-3 WATTS, 764-870MH H46UCC9PW5 N 764-870 MHz 

XTS2500 VHF PORTABLE 1-5 WATTS 136-174 H46KDC9PW5 N 136-174 MHz 

XTS2500 UHF R1 PORTABLE 1-5 WATTS 380-470 H46QDC9PW5 N 380-470 MHz 

XTS2500 UHF R1 PORTABLE 1-5 WATTS 450-520 H46SDC9PW5 N 450-520 MHz 
 

All of the following options may be ordered with the XTS2500 radio:  

Option Name Option Number 

ENH: SOFTWARE TRUNKING 9600 BAUD Includes: 9600 
Baud, Wide Area SmartZone, OmniLink, ASTRO Digital CAI, 
& PTT-ID Display 

Q574 

ENH: RADIO PACKET DATA Q947 

DEL: ANTENNA H112 

DEL: BATTERY ALL TOGETHER H207 

DEL: BELT CLIP H301 

ADD: DATA CABLE Q157 
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CDM750 Radio Installation Kit 
The CDM750 radio installation kit (ACE3600 option V143AH/kit FLN3638A) enables the 
user to install the CDM750 radio series in ACE3600 Remote Terminal Units (RTU).  The 
FLN3638A installation kit includes a bracket, adapter, and cables. 

Installation 
The CDM750 radio can be mounted on the ACE3600 RTU as follows: 

Procedure 13-15 How to Install the CDM750 Radio on the Metal Chassis 

1. Attach the radio plug-in port from the installation kit (FLN3696A) to the desired opening 
on the ACE3600 CPU module.  For instructions on attaching plug-in ports, see 
Connecting Plug-In Ports to the CPU Module in the CPU Module chapter above. 

2. Connect the radio adapter (FLN3639A) 16-pin connector to the radio Accessory 
connector (See Figure 13-13.) 

3. Connect the power cable (FKN8436A) to the radio power connector, and the opposite 
end of the cable to the AUX1A or AUX1B connector on the ACE3600 power supply 
module. 

4. Connect the communication cable (FKN8427A) to the rear connector (8-pin RJ45 
connector) of FLN3639A.  Place one Fair-Rite soft ferrite (#7683477X01 from the 
supplied ferrite kit FHN7007A) on the cable near the bottom of the CPU door, loop the 
cable one turn around it, and clamp the ferrite on the cable. 
Connect the other end of the communication cable to the plug-in port of the ACE3600 
CPU module.  

 

 

 

 

 

Figure 13-13  CDM750 Antenna, Power and Communication Cable Connections 
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4. Connect the antenna cable (FKN8437A) to the Antenna connector on the radio and to the 
opening on the bottom of the ACE3600 RTU housing, using the four supplied screws. 
See Figure 13-13 and Figure 13-15.) 

5. Attach the radio to the bracket (0789422V45 from FHN6898A) by using screws and 
washers from kit FHN6898A. See Figure 13-14 below. 

 

 

Figure 13-14  CDM750 Radio and Metal Bracket 
 

6. Attach the complex (radio + bracket) using the four supplied screws to the ACE3600 
chassis.  See Figure 13-15 below. 
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Figure 13-15  CDM750 Radio Installed on ACE3600 C
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RTU Port Configuration for the CDM750 Radio 
To enable MDLC communication using CDM750 radios, use the ACE3600 STS site 
configuration utility to configure the ACE3600 RTU plug-in port connected to the radio.     

The following figures show the port configuration and advanced parameter configuration.  
Although these show Port PI1, the same values can be applied to port PI2 as well, where 
relevant.  

Port Type 
Procedure 13-16 How to Configure the ACE3600 Port for the CDM750 Radio 

1. In the ACE3600 STS click on the desired site, and open the site view.   

2. In the Port Tab, click on the plug-in port through which the RTU will communicate with 
the radio.   

3. Confirm that the port parameters and data speed are as shown in the screen below. 

4. Define desired radio links and zones if necessary.   

5. Save the changes.  Generally no other changes are required to Advanced Physical or Link 
Layer parameters. 

 

Figure 13-16  RTU Site Configuration for MDLC over CDM750 Radio – Port Type Parameters 
 

Programming the CDM750 Radio using CPS 
The CDM750 radio is programmed for ACE3600 in the factory and is ready for 
communication.  For user programming of site-specific parameters, follow the instructions 
below.   

Radio Connections 
To program the CDM750 radio with Customer Programming Software (CPS), the radio is 
connected to a PC using the standard Radio Interface Box (RIB).   

Procedure 13-17 How to Connect the CDM750 Radio to the CPS 

1. Connect one end of the programming cable (PMKN4004) to the radio Accessory 
connector and the other end to the 25-pin connector on the RIB (RLN4008).  The RIB 
and cable are not supplied and must be ordered separately. 

2. Using the 9-pin interface cable (3080369B72), connect the RIB to the serial port of a PC 
on which the CDM750 CPS software (HVN9025) is installed. 

3. Connect the RIB to a power RIB power supply or 9V battery. 



Radio Types and Installation Kits 

13-30 

Radio Disassembly 
If the CDM750 radio is to be programmed outside of the ACE3600 housing, disassemble the 
radio as follows:  

Procedure 13-18 How to Disassemble the CDM750 Radio from the ACE3600 Metal Chassis 

1. Disconnect the antenna cable (FKN8437A) to the radio Antenna connector. 

2. Remove the radio/bracket unit from the RTU chassis by unscrewing the four built-in 
screws. 

3. Disconnect the DC power cable (FKN8436A) from the radio Power connector. 

4. Disconnect the radio adapter (FLN3639A) 16-pin connector from the radio Accessory 
connector. 

5. Detach the metal bracket (FHN6898A) by unscrewing the two radio screws 
(#0387839V89), one on each side. (See Figure 13-14.) 

CPS Programming Settings 
The following programming instructions must be performed before connecting a CDM750 
radio to the ACE3600 family Remote Terminal Units (RTU). These instructions define 
miscellaneous settings and the function of each pin in the radio’s general purpose I/O 
connector.  

Procedure 13-19 How to Program the CDM750 Radio 

1. Before programming the radio, read the codeplug file from the radio and save it to your 
PC using the File >Read Device command in the CPS.   

2. Open the codeplug file in the CPS.  Click on the codeplug in the tree view to view and 
select the items below or select them from the Feature menu. 

3. Under Radio Configuration, change the settings on the Basic, Tx Power, Accessory 
Configuration, and Accessory Pins tabs, as shown in the screens below.   

4. Under Controls and Menus->Conventional Buttons, change the settings to the Mobile 
Key Buttons and Programmable Buttons tabs, as shown in the screens below. 

5. Under Conventional Personality 1, change the settings to the Basic, Options and 
Advanced tabs, as shown in the screens below. 

6. Under Personality Assignment to Zone 1, make sure that the desired channel(s) appear on 
the list on the Channels tab.  If not all the assigned channels are required, remove them 
from the assignment list.  

7. From the File Menu, select Save to save changes to the radio. 

8. From the File Menu, select Write Device to download the configuration to the radio. 
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Figure 13-17 Radio Configuration- Basic Settings 

 

Figure 13-18 Radio Configuration- Tx Power 
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Figure 13-19 Radio Configuration - Accessory Connector Configuration 

 

Figure 13-20 Radio Configuration - Accessory Pins Definition 
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Figure 13-21 Conventional Buttons Configuration – Mobile Key Buttons 

  

Figure 13-22 Conventional Buttons Configuration – Programmable Buttons 
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Figure 13-23 Conventional Personality Configuration – Basic Settings 

 

Figure 13-24 Conventional Personality Configuration – Options 
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Figure 13-25 Conventional Personality Configuration – Advanced Settings 

 

Figure 13-26 Radio Channel Assignment - Personality Assignment to Zone 
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GP/HT/PRO Radio Installation Kit 
The GP/HT/PRO Radio Installation Kit for ACE3600 (V154AE, FLN3637A) enables the user 
to install the GP320/GP328/HT750/PRO5150 portable radios in ACE3600 Remote Terminal 
Units (RTU). Each kit includes a bracket, radio interface, adapters, and cables. 

Volume Knob Retainer 
The volume knob retainer sets a fixed position for the volume knob on the GP/HT/PRO radios, 
for optimal operation in an ACE3600 RTU installation. To implement this option, follow the 
procedure below. 

Procedure 13-20 How to Attach the Volume Knob Retainer for the GP/HT/PRO Radio 

1. Remove the original plastic volume knob cover from the radio by pulling it out with 
pliers, as shown in Figure 13-27. 

Figure 1
 

2. Place the hole of the vo
metal volume rod on the

Figure
 

3. Fasten the bottom of the
Volume Knob 
13-36 

 

3-27 Removing the Volume Knob 

lume knob retainer (shown in Figure 13-28) over the exposed 
 radio (shown in Figure 13-29.) 

 

 13-28 Volume Knob Retainer 

 volume knob retainer to the radio body. (See Figure 13-29.) 
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Figure 13-29 Attach Retainer to Radio 

 

re installing the GP/HT/PRO radio on the RTU, configure the power supply AUX2A/B 
ector to 7.5V DC in the ACE3600 STS site configuration (using the Power Supply <n> 
liary 2 voltage parameter.)  Download the updated site configuration to the RTU.  Failure 
 this might damage the radio. 

P/HT/PRO radio can be mounted on the ACE3600 RTU as follows: 

ttach the radio plug-in port from the installation kit (FLN3696A) to the desired opening 
n the ACE3600 CPU module.  For instructions on attaching plug-in ports, see Connecting 
lug-In Ports to the CPU Module in the CPU Module chapter above. 

onnect the audio accessory adapter (HLN9716) (Item 1) to the radio.  See Figure 13-30. 

nsert the communication cable (FKN8431A) (Item 2) into the audio accessory adapter. 

nsert the BNC antenna adapter (FTN6045B) into the radio antenna connector (Item 3). 

nap the radio into the DC adapter (FCN5516B) (Item 4). 

nsert the 7.5V DC power cable (FKN8515A) into the DC connector of the DC adapter 
Item 5). 



Radio Types and Installation Kits 

13-38 

 

 

 

 

Figure 13-30 GP/HT/PRO Radio Installation 
 

7. Using the two screws, attach the radio assembly to the radio bracket (FHN6899A). 

8. Using the three screws on the bracket, attach the bracket with the radio to the chassis of the 
ACE3600. (See Figure 13-31.) 

9. Connect the audio communication cable (FKN8431A) to the audio adapter (attached to the 
radio).  Place one Fair-Rite soft ferrite (#7683477X01 from the supplied ferrite kit 
FHN7007A) on the cable near the bottom of the CPU door, loop the cable one turn around 
it, and clamp the ferrite on the cable.  Connect the other end of the communication cable to 
the plug-in port on the front panel of the CPU module.  

10. Connect the DC power cable (FKN8515A) from the DC adapter (attached to the radio) to 
the AUX2A or AUX2B connector of the power supply module. 

11. Route the antenna cable (FKN8434A) from the bottom of the RTU box to the BNC adapter 
on the radio. 

12. Use the clamps provided in the kit to route and secure the audio communication and DC 
power cables. (See Figure 13-31.) 

1 

2 

3 

4 

Fit radio into 
adapter 
base and 
press radio 
to adapter. 

5 
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Figure 13-31 GP/HT/PRO Radio Installed on ACE3600 Chassi
 

TU Port Configuration for the GP320/GP328/HT750/PRO5150 Radio 
To enable MDLC communication using GP320/GP328/HT750/PRO5150 
ACE3600 STS site configuration utility to configure the ACE3600 RTU p
connected to the radio.   

The following figures show the port configuration and advanced paramete
Although these show Port PI1, the same values can be applied to port PI2 a
relevant.  

ort Type 
Procedure 13-21 How to Configure the ACE3600 Port for the GP/HT/PRO

1. In the ACE3600 STS click on the desired site, and open the site view

2. In the Port Tab, click on the plug-in port through which the RTU wil
the radio.   

3. Confirm that the port parameters and data speed are as shown in the 
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4. Define desired radio links and zones if necessary. 

5. Save the changes.  Generally no other changes are required to Advanced Physical or Link 
Layer parameters. 

 

Figure 13-32  RTU Site Configuration for MDLC over GP320/GP328/HT750/PRO5150 Radio –  
Port Type Parameters 

 

GP/HT/PRO Radio Models and Regional Options for ACE3600 
The GP/HT/PRO models of the ACE3600 RTU, F7553A (VHF) and F7554A (UHF) include 
the following regional options: 

Option Region Radio 
V951 North America (NA)  HT750 

V952 EMEA GP320 

V953 Asia GP328 

V954 Latin America (LA)  PRO5150 

V154AE     GP/HT/PRO INSTALL KIT  

FLN3637A GP/HT/PRO INSTALL KIT  

 

Note: 

1. When ordering ACE3600 model with a GP/HT/PRO radio, a V95x option must be added. 

2. For models/options availability, see the latest sales price list. 

3. Orders to EMEA should be placed as model without radio and radio as a kit 
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CM/EM/GM Radio Installation Kit 
The CM/EM/GM Installation Kit for ACE3600 (V148AC/FLN3635A) enables the user to 
install the CM/EM/GM mobile radio (CM200, CM140, EM200, GM3188) in ACE3600 
Remote Terminal Units (RTU).  Each kit includes a bracket, adapter, and cables. 

Installation 
The CM/EM/GM can be mounted on the ACE3600 RTU as follows: 

Procedure 13-22 How to Install the CM/EM/GM Radio on the Metal Chassis 

1. Attach the radio plug-in port from the installation kit (FLN3696A) to the desired opening 
on the ACE3600 CPU module.  For instructions on attaching plug-in ports, see Connecting 
Plug-In Ports to the CPU Module in the CPU Module chapter above.  

2. Connect the 16-pin connector radio adapter (FLN3636A) to the accessory connector on the 
radio. (See Figure 13-33.) 

 

Figure 13-33 CM/EM/GM Radio, Adapter and Power Cable 
 

3. Connect the power cable (FKN8428A) to the radio’s power connector. (See Figure 13-33 
and Figure 13-34.)  Connect the other end of the power cable to the AUX1A or AUX1B 
connector on the ACE3600 RTU Power Supply unit. (See Figure 13-35.)  
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Figure 13-34 CM/EM/GM Radio Cable Connections 
 

4. Connect the communication cable (FKN8427A) to the back of the radio adapter 
(FLN3636A) connector (10-pin RJ45 connector). (See Figure 13-34.) Place one Fair-Rite 
soft ferrite (#7683477X01 from the supplied ferrite kit FHN7007A) on the cable near the 
bottom of the CPU door, loop the cable one turn around it, and clamp the ferrite on the 
cable.  Connect the other end of the communication cable to the plug-in port of the 
ACE3600 CPU.  

5. Mount the CM/EM/GM radio onto the metal bracket (#0789422V45) using the two 
supplied radio mounting screws from kit FHN6894A, # 0387839V89 on the top and 
bottom of the radio. (See Figure 13-33, Figure 13-34 and Figure 13-35.) 

6. Connect the antenna cable (FKN8429A/FKN8430A*) to the antenna connector on the radio 
and to the opening on the bottom of the ACE3600 housing using the four supplied screws. 
(See Figure 13-34 and.)  Mount the complex (bracket and radio) on the RTU chassis above 
the CPU and I/O modules, using the four built-in screws. (See Figure 13-35.) 

                                                      
*  Antenna Cable FKN8429A with UHF connector is for Latin and North America. 
   Antenna Cable FKN8430A with BNC connector is for Asia and Europe. 
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Figure 13-35 CM/EM/GM Radio Installed on ACE3600 Chassi

 

RTU Port Configuration for the CM/EM/GM Radio 
To enable MDLC communication using CM/EM/GM radios, use the ACE
configuration utility to configure the ACE3600 RTU plug-in port connecte

Follow the instructions for RTU Port Configuration for the CDM750 Radi

Programming the CM/EM/GM Radio using CPS 
The following programming instructions must be performed before connec
radio to an ACE3600 RTU.  These steps define miscellaneous settings and
pin in the radio’s general purpose I/O connector.  
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Radio Information 
The picture below shows the radio model information screen in the CPS. 

 

Figure 13-36 CM/EM/GM CPS Radio Information Screen 
 

Radio Power Settings 
The picture below shows the TX power setting (1-25 W) in CPS. 

 

Figure 13-37 CM/EM/GM CPS General Settings Screen 
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Radio Accessory Connector Pins Definition 
The picture below shows the setting of the radio’s accessories pins required for interfacing with 
the ACE3600. 

 

Figure 13-38 CM/EM/GM CPS Radio Accessories Screen 
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Frequency and Bandwidth Settings 
The picture below shows the setting of the radio’s frequency, bandwidth and power level. 

 

Figure 13-39 CM/EM/GM CPS Radio Personality Tx/Rx Screen 
 

Note: The Power Level should be set according to the power output. 
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CM/EM/GM Radio Models and Regional Options for ACE3600 
The CM/EM/GM models of the ACE3600 RTU, F7573A (VHF) and F7574A (UHF) include 
the following regional options: 

Option Region Radio 
V851 North America (NA)  CM200, 1-25W 

V852 EMEA* CM140, 1-25W 

V853 Asia* GM3188, 1-25W 

V854 Latin America (LA)  EM200, 1-25W 

V148AC     CM/EM/GM INSTALL KIT  

FLN3635A CM/EM/GM INSTALL KIT  

 

Note: 

1. When ordering an ACE3600 model with a CM/EM/GM radio, a V95x option must be 
added. 

2. For models/options availability, see the latest sales price list. 

 

 

                                                      
*  Antenna Cable FKN8429A with UHF connector is for Latin and North America. 
   Antenna Cable FKN8430A with BNC connector is for Asia and Europe. 
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TransNET 900 OEM Radio Installation Kit 
The TransNET™ 900 OEM radio installation kit (VA00225AA/FLN3852A) enables the user 
to install MDS TransNET 900 OEM (board version) radio modems in ACE3600 Remote 
Terminal Units (RTU).  Each kit includes a bracket, adapter, and cables. 

Installation 
The TransNET 900 radio modem is housed in a plastic housing, as shown below: 

  

Figure 13-40 TransNET 900 Radio Modem and Connectors 
 

The TransNET 900 can be mounted on the ACE3600 RTU as follows: 

Procedure 13-23 How to Install the TransNET 900 Radio on the Metal Chassis 

1. Attach the TransNET 900 radio modem to the metal bracket (#0789971V39 from 
FHN7067A) using the four supplied screws, inserting the screws from above. (See Figure 
13-41 below.) 
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Figure 13-41 TransNET 900 Radio Modem Mounted on Metal Bracket - Front and Rear View 
 

2. Mount the bracket on the RTU chassis above the I/O modules, using the four built-in 
screws.  (See Figure 13-42 and Figure 13-43 below.) 

3. Connect one end of the power cable (FKN8508A) to the TransNET’s PWR (9-30VDC) 
connector and tighten the attached screws.  Connect the other end of the cable to the 
AUX1A connector on the RTU’s power supply module. 

4. Connect one end of the data cable (FKN8514A) to the TransNET’s DATA connector 
using the attached screws.  Connect the other end of the communication cable to the 
ACE3600 CPU module port configured for the radio.  

5. Connect the small end of the antenna cable (FKN8511A) to the TransNET’s ANT 
(Antenna) connector.   
Unscrew the nut and locking washer from the other end of the antenna cable.  
If the RTU is inside an enclosure, thread the end of the cable through the opening on the 
bottom of the enclosure and screw on the nut and locking washer from outside the 
enclosure.   

6. Connect the antenna cable to an external antenna.  
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Figure 13-42 TransNET 900 Radio Modem Installed on ACE3600 Chassis 
 

 

Figure 13-43 TransNET 900 Radio Modem Installed on ACE3600 Chassis – Cable Connections 
 

Setting Radio Parameters 
The TransNET 900 radio has certain parameters which are set in the MDS factory. 
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• The radio address ADDR = xx, where xx is the same number for all radios in the 
system The address appears on the radio itself. 

• Mode - either MASTER or REMOTE (Slave). The mode setting appears on the radio 
itself. 

• Baud rate (factory default = 9600 8N1) 

These radio settings are determined in the MDS factory and are not generally changed by the 
user.  If it is necessary to change these settings, refer to the TransNET 900 radio 
documentation. 

RTU Configuration 
The RTU port is configured using the ACE3600 STS as follows:  

Procedure 13-24 How to Configure the ACE3600 Port for the TransNET 900 Radio 

1. In the ACE3600 STS click on the desired site, and open the site view.   

2. In the Port Tab, click on the on-board or plug-in port through which the RTU will 
communicate with the TransNET radio.   

3. Confirm that the port parameters and data speed are as shown in the screen below.   
Note: If the baud rate of the radio is not the default value (9600), the baud rate of the port 
should be configured accordingly. 

4. Define desired links. 

5. Save the changes.  

 

Figure 13-44  RTU Site Configuration for TransNET Radio– Port Type Parameters 
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iNET 900 Radio Installation Kit 
The iNET™ 900 installation kit (V680AH/FLN3854A) enables the user to install MDS iNET 
900 (board version) radio modems in ACE3600 Remote Terminal Units (RTU).  Each kit 
includes a bracket, adapter, and cables. 

Installation 
The iNET 900 radio modem is housed in a plastic housing, as shown below: 

  

Figure 13-45 iNET 900 Radio Modem  
 

The iNET 900 can be mounted on the ACE3600 RTU as follows: 

Procedure 13-25 How to Install the iNET 900 Radio on the Metal Chassis 

1. Attach the iNET 900 radio modem to the metal bracket (#0789971V39 from FHN7067A) 
using the four supplied screws, inserting the screws from below. (See Figure 13-46 below.) 
Note: The radio must be placed in the bracket with the connectors to the left side, so that 
the bracket can be mounted on the RTU chassis and the cables can reach the CPU.  

  

Figure 13-46 iNET 900 Radio Modem Mounted on Metal Bracket – Front and Rear View 
 

2. Mount the bracket on the RTU chassis above the I/O modules, using the four built-in 
screws.  (See Figure 13-47 below.) 
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3. Connect one end of the power cable (FKN8508A) to the iNET’s PWR connector and 
tighten the attached screws.  Connect the other end of the cable to the AUX1A connector 
on the RTU’s power supply module.  See Figure 13-47 and Figure 13-48 below.) 

4. Connect one end of the data cable (FKN8512A) to the iNET’s COM2 connector using the 
attached screws.  Connect the other end of the communication cable to the ACE3600 CPU 
module port configured for the radio. 

5. Connect the small end of the antenna cable (FKN8511A) to the iNET’s ANT (Antenna) 
connector.   
Unscrew the nut and locking washer from the other end of the antenna cable.  
If the RTU is inside an enclosure, thread the end of the cable through the opening on the 
bottom of the enclosure and screw on the nut and locking washer from outside the 
enclosure.   

6. Connect the antenna cable to an external antenna. 

 
 

Figure 13-47 iNET 900 Radio Modem Installed on ACE3600 Chassis 
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Figure 13-48 iNET 900 Radio Modem Installed on ACE3600 Chassis – Cable Conn
 

Configuring the iNET 900 to Work with ACE3600 
The iNET 900 radio modem can be configured to work with ACE3600 RTUs in s
as described below.  Configurations 1-3 below represent External Modem configu
Configurations 4-7 represent MDLC over IP configurations. 

With iNET radios (firmware version ≥ V4.4.0) any remote can communicate with
remote.  An MDLC network (with zones) is no longer needed.  The iNET should b
Multipoint to Multipoint topology, in order to enable communication between RT
zones. 

Notes:  

• It is recommended to enable flow control on the RS232 serial port.  

• An RTU configured for MDLC over IP cannot communicate with an RTU
for External Modem over the iNET network. If both exist, they should be 
different Link IDs. 
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External Modem Port Configurations 
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Configuration 3
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MDLC over IP Port Configurations 
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Configuration 5
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Configuration 7
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Radio Configuration 
External Modem Port 

iNET radios can be configured to work with the External Modem port on ACE3600 RTUs (see 
Configurations 1, 2 and 3 above.) 

Use the iNET radio programming software to program the AP (Access Point) and then the 
remote with the following settings.   

Note: 

• Radio firmware should be 4.4.0 or above. 

• IP Address refers to the Ethernet port IP and not the “over the air” IP. 

The initial screen is as follows: 

 MDS iNET 900 
  Starting Information Screen 
  -==================================================================- 
 
    Device Mode:   Access Point 
 
       Device Name:   AP Demo Set I 
 
       Network Name:  Demo Set l 
 
       IP Address:   169.254.0.12 
 

Device Status:   Operational 
 
     Uptime:     01 hrs, 51 min 
 

Firmware Version: 4.4.0 
 

Hardware Version:  1.0.3 
 
  Serial Number:   1069975 
 
 
   Press 'G' to go to Main Menu 
 

1. Press 'G' and the Main Menu will be displayed. 

2. Press 'D' and the Serial Gateway Configuration Menu will be displayed. 

3. Press 'D' to enable COM2 (if it is not enabled). Use the SPACE bar to cycle between  
  Enabled and Disabled. COM2 should be Enabled and COM1 Disabled. Press ENTER  
 once Enabled is shown. 

4. Press 'E' and the Serial Configuration Wizard will be displayed.  This wizard will assist  
you in the configuration of your available Serial Data Ports. 
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5. Press 'A' and the IP Protocol selection menu will appear.   

6. Select the IP Protocol you would like to use.  The following modes are supported: 

• TCP – Cannot be used for ACE3600.  

• UDP – to be used as ACE3600external modem.  

• PPP – to be used for MDLC over IP (Not relevant for External Modem.) 

Press 'B' to select the UDP port. 

7. If you selected UDP above, you will be prompted to select the Topology.  You have the  
 following choices: 

• Point to Point is used if you have a single AP and a single remote unit. 

• Point to MultiPoint is used if you transmit to a single radio. This radio is the point, and 
all radios are the multipoint. For example: An FNE is a point, and all other RTUs are 
multipoint. No RTU to RTU is provided. 

• MultiPoint to MultiPoint works like a real radio where any radio (RTU) can 
communicate with another. 

Press 'C' (Multipoint to MultiPoint) to enable routing between any RTU to any RTU. 

8. Next, set the values for the Multicast IP Address and Multicast Port.  These are the  
 addresses used when transmitting and receiving. They should be the same on all radios.   
 Press 'A' and enter “224.254.1.1” for the Multicast IP Address.  

9. Press 'B' and enter “30011” for the Multicast Port.  

10. Press 'C' to continue the wizard until the final screen, or abort it by pressing 'Q'. 

11. When the final wizard screen appears prompting you to “Change values (if necessary)  
 for UDP Data Connection Settings”, do not change any values.  Press 'Q' to quit wizard. 

12. The COM2 Serial Data Port values will be displayed.  Press 'G' and set the appropriate  
 Baud Rate (from 1200 bps to 115200 bps.) 

13. The Hardware Configuration values will be displayed.  Press 'G' to select the 8N1  
 hardware configuration for the port. 

14. It is recommended to have Hardware Flow Control on the serial port enabled.  When  
 prompted, press 'A' to enable Hardware Flow Control.   

15. When prompted to select the Serial Packet Mode, press 'A' to use the default value  
 (Seamless Mode.)  Press Q to exit wizard. 
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The settings for the COM2 Serial Data Port should appear as follows: 

 AP Demo Set I 
  Serial Configuration Wizard 
  -==================================================================- 
 
     COM2 Serial Data Port 
 
  A) Status      enabled 
  B) IP Protocol        UDP Multipoint to Multipoint 
  C) Multicast IP Address      224.254.1.1 
  D) Multicast Port     30011 
  E) Time to Live       1 
  F) Packet Redundancy Mode    Single Packet Mode 
  G) Data Baud Rate     9600 
  H) Configuration      8N1 
  I) Flow Control       enabled 
  J) Serial Mode        Seamless 
  K) Seamless Inter-Frame Delay 4 
 
  X) Commit Changes and Exit Wizard 
 
 
   These changes will take effect immediately... 
      Are you sure (y/n)? 
  Select a letter to choose an item, <ESC> for the prev menu, 'Q' to quit wizard 
 

16. Press 'X' to save the changes and exit the wizard.   When prompted with "These changes  
will take effect immediately... Are you sure (y/n)?", press 'y' and ENTER.  There is no 
need to power up the iNET radio. Note that these settings are saved and you do not need 
to reset them when powering up the radio unit again.  

17. Press ESC to return to the Main Menu.  

18. From the Main Menu, press 'B' to select Network Configuration. This is needed if you  
want to set an IP connection to the radio unit (recommended). Ethernet port is needed if 
you are using an IP Interface on RTUs and Ethernet port on IP Gateway (MDLC over 
IP). In any case, it is recommended that you set it. 

19. Next press 'G' for IP Address configuration. 

20. In the IP Address Configuration Menu, press 'B' to set the Static IP Address to  
169.254.0.12. 

21. Next press 'C' to set the Static IP subnet mask to 255.255.0.0. It is recommended that all  
units having the same AP (Access Point) be on the same subnet mask.  

22. Press ESC to return to the Network Configuration Menu. 

23. Finally press 'D' and enter the maximum number of remotes. By default this value is 50.   
If the AP has more than that, you must change the value.  
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24. Your configuration of the AP is complete. Return to the Starting Information screen  
(Step 1 above) and repeat all steps with the remote unit. All of the settings/values are the 
same. 

 

MDLC over IP Port 
iNET radios can be configured to work with the MDLC over IP port on ACE3600 RTUs (see 
Configurations 4-7 above.) 

MDLC over IP supports: 

• IP Gateway 4.xx configured with MDLC over IP over Ethernet port. 

• ACE3600 RTU Ethernet port 

• ACE3600 RTU RS232 port configured as MDLC over IP over PPP connected to 
Standard modem. 

When using an RTU with EP Ethernet port, connect the RTU Ethernet port to the iNET 
Ethernet port. The IP Port should be on the same subnet as the iNET. Its Subnet mask and IP 
Gateway should be the same.  The rest of the configuration should be the same as an MDLC 
over IP port (i.e. configuring the port and setting the appropriate baud rate and Link ID, and 
downloading the IP Conversion Table.)  The P Conversion Table is needed to communicate 
with other RTUs connected over PPP or Ethernet. 

The rest of the configuration should be the same as an MDLC over IP port (as above). All IP 
settings are obtained dynamically from the modem when connecting to it.  The RTU PPP port 
should be connected to COM2 on the iNET radio using a computer adapter. The following 
describes how to configure iNET COM2 modem for PPP. 

After configuring the IP Gateway, EPIB for Ethernet, and RTU (for PPP) with MDLC over IP 
port, they can all communicate on the iNET network as if they all reside on a LAN. All routing 
between them is done via the iNET network, and if a LAN is involved, using other routers as 
well. Any RTU can communicate with any other RTU or IP Gateway. A single Link ID should 
be set for all RTUs/ IP Gateways on these ports. 

Note however, that if the MDS radio was connected via External Modem port (serial), or via a 
Terminal Server (e.g. Equinox) over serial port, it is a completely different MDLC 
link/protocol. A different Link ID should be set in the RTU/IP Gateway when using this 
configuration. If both coexist on the same iNET network, each should have its own Link ID 
with MDLC network configuration downloaded to all units. 

Use the iNET radio programming software to program the AP (Access Point) and then the 
remote with the following settings.   

Note: 

• Radio firmware should be 4.4.0 or above. 

• IP Address refers to the Ethernet port IP and not the “over the air” IP. 

The following shows Access point configuration for MDLC over IP but it is exactly the same 
for Remote. 
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The initial screen is as follows: 

 MDS iNET 900 
  Starting Information Screen 
  -==================================================================- 
 
    Device Mode:   Access Point 
 
       Device Name:   AP Demo Set I 
 
       Network Name:  Demo Set l 
 
 IP Address:   169.254.0.12 
 

Device Status:   Operational 
 

     Uptime:     01 hrs, 51 min 
 

Firmware Version: 4.4.0 
 
Hardware Version:  1.0.3 
 

  Serial Number:   1069975 
 
   Press 'G' to go to Main Menu 
 

1. Press 'G' and the Main Menu will be displayed. 

2. Press 'B' and the Network Configuration Menu will be displayed.   

3. Press 'G' for IP Address configuration. 

4. In the IP Address Configuration Menu, press 'B' to set the Static IP Address to  
169.254.0.12. 

5. Next press 'C' to set the Static IP subnet mask to 255.255.0.0. It is recommended that all  
units having the same AP (Access Point) be on the same subnet mask. 

Note that the Static (sub)Net Mask and Static IP Gateway addresses should be the same  
as those of the IP Gateway and EPIB. Their IP Address should be on the same subnet. 
For example 169.254.0.100 for an IP Gateway address of 169.254.0.012 is suitable. 

Also note that when using PPP it is recommended to have the IP Address of PPP on the  
same subnet, for example 169.254.0.13. See Configuring for PPP below. 

6. Press 'E' to commit changes.  Press ESC to return to the Network Configuration Menu. 

7. Finally press 'D' and enter the maximum number of remotes. By default this value is 50.   
If the AP has more than that, you must change the value.  
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8. Your configuration of the AP is complete. Return to the Starting Information screen  
(Step 1 above) and repeat all steps with the remote unit. All of the settings/values are the 
same. 

Configuring for PPP 
9. From the Main Menu, press 'D' and the Serial Gateway Configuration Menu will be  

displayed. 

10. Press 'D' to enable COM2 (if not enabled). SPACE to cycle between Enabled and  
Disabled. COM2 should be Enabled and COM1 Disabled. Press ENTER once Enabled is 
shown. 

11. Press 'E' and the Serial Configuration Wizard will be displayed.  This wizard will assist  
you in the configuration of your available Serial Data Ports. 

12. Press 'A' to begin the Wizard and the IP Protocol selection menu will appear.   

13. Select the IP Protocol you would like to use.  The following modes are supported: 

• TCP - to be used as a Terminal Server. (IP Gateway does not support this option.) 

• UDP - to be used as External Modem. 

• PPP - to be used as PPP port (same as Ethernet). 

Press 'C' to select PPP. 

14. The wizard will prompt you to change the value of the IP Address.  Press 'A' and enter  
the Remote IP Address.  This is the address that is uniquely assigned to the RTU.  It 
should be different from the other addresses used in the iNET network and in the LAN (if 
connected to LAN).   

A good scheme is to add 1 to the Static IP Address set in the Network Configuration  
screen above.  For example, if the address 169.254.0.12 was assigned to the iNET 
Ethernet port, the PPP would be assigned 169.254.0.13.  Both addresses reside in the 
same subnet 255.255.0.0 as was set in the Network Configuration.  When using a PPP 
port, two IP addresses are set for iNET, one for the Ethernet port, and another (on the 
same subnet) for PPP.  It is recommended to make those addresses consecutive where 
possible. 

15. Press 'B' and the Data Baud Rate screen is displayed.  

16. Select the baud rate according to the RTU, e.g. 'D' for 9600. 

17. Next press 'G' to select the 8N1 hardware configuration. 

18. It is recommended to have Hardware Flow Control on the serial port enabled.  When  
prompted, press 'A' to enable Hardware Flow Control.   

19. When prompted to select the Serial Packet Mode, press 'A' to use the default value  
(Seamless Mode.) 

 

The settings for the COM2 Serial Data Port should appear as follows: 
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  Serial Configuration Wizard 
  -==================================================================- 
     COM2 Serial Data Port 
 
  A) Status        enabled 
  B) IP Protocol     Point to Point Protocol (PPP) 
  C) Device IP Address  169.254.0.13 
  D) Data Baud Rate      9600 
  E) Configuration         8N1 
  F) Flow Control         enabled 
  G) Serial Mode        Custom 
  H) Custom Inter-Frame Delay 4 
  I) Custom Data Buffer Size   64 
 
 
 
 
 
  Select a letter to choose item, <ESC> for the prev menu, 'Q' to quit wizard 
 

20. Press 'X' to save the changes and exit the wizard. There is no need to power up the iNET  
radio. Note that these settings are saved and you do not need to reset them when 
powering up the radio unit again. 

21. From the Serial Gateway Configuration, press ESC to return to the Main Menu.  

Your configuration of the PPP is complete. 

RTU Configuration 
The RTU port is configured using the ACE3600 STS.  

Site Configuration 
Procedure 13-26 How to Configure the ACE3600 Port for the iNET 900 Radio 

In the ACE3600 STS click on the desired site, and open the site view.   

2. In the Port Tab, click on the on-board or plug-in port through which the RTU will  
communicate with the iNET radio.   

3. Confirm that the port parameters and data speed are as shown in the screen below.   
Note: If the baud rate of the radio is not the default value (9600), the baud rate of the port 
should be configured accordingly. 

4. Define desired links. 

5. Save the changes.  
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Figure 13-49  RTU Site Configuration for iNET Radio– External Modem Port 
Port Type Parameters  

 

 

Figure 13-50  RTU Site Configuration for iNET Radio– MDLC over IP Port 
Port Type Parameters  

 

 

Figure 13-51  RTU Site Configuration for iNET Radio– MDLC over IP Port 
Advanced Link Layer Parameters  

 

IP Conversion Table 
Prepare an IP Conversion Table and download it to the RTU. The IP Address of the RTU is the 
one assigned by the iNET 900 to the RTU, referred to as Remote IP Address in Configuring for 
PPP above.  This IP address can be retrieved using the ACE3600 STS SW Diagnostics & 
Loggers utility in Device LIN1L, level 0. 

Verify that the connection succeeded using the SW Diagnostics & Loggers utility.  In Device 
LIN1L, level 101, make sure that the "State of configuration task" field is set to "connected and 
registered". This may take between 30-60 seconds. 
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MDS Radio Installation Kit 
The MDS installation kit (V152AK/FLN3853A) enables the user to install the 9810 Spread 
Spectrum, 9710A- 900 MHz and 4710 UHF Transceiver radio modems in ACE3600 Remote 
Terminal Units (RTU).  The kit includes a bracket and cables. 

Installation 
The MDS radio can be mounted on the ACE3600 RTU as follows: 

Procedure 13-27 How to Install the MDS 900 Radio on the Metal Chassis 

1. Connect the radio to the bracket provided in the Hardware Kit (#0789971V39 from 
FHN7066A) using the four screws, supplied with the bracket. (See Figure 13-52 below.) 

 

Figure 13-52 MDS Radio Mounted on Metal Bracket - Front and Rear View 
 

2. Connect the communication cable (FKN8513A) to the 25-pin connector on the side of the 
radio and tighten the screws.  
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3. Insert the DC power cable (FKN8510A) connector into the DC power connector on the 
radio. 

4. If the RTU is to be installed inside an enclosure, screw the antenna cable (FKN8509A) 
into the antenna connector on the radio.  Otherwise, an external antenna can be connected 
directly to the antenna connector on the radio. 

5. Mount the bracket (#0789971V39 from FHN7066A) on the RTU chassis above the I/O 
modules, using the four built-in screws.  (See Figure 13-53 below.) 

6. Route the antenna cable (FKN8509A) cable through the small wire clamps along the left 
side edge of the RTU chassis, according to the placement of the radio on the chassis, as in 
Figure 13-53 and Figure 13-54.   

7. Unscrew the nut and locking washer from the N-type connector at the other end of the 
antenna cable.  Thread the end of the cable through the opening on the bottom of the 
enclosure and screw on the nut and locking washer from outside the enclosure.   

8. Connect the other end of the DC power cable (FKN8510A) to the AUX1A/B connector 
on the RTU’s power supply module. 

9. Connect the other end of the communication cable (FKN8513A) to the ACE3600 CPU 
module port configured for the radio.  See RTU Configuration below. 

10. Connect the antenna cable to an external antenna.   
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Figure 13-53 MDS Radio Modem Installed on ACE3600 Chassis 
 

 

Figure 13-54 MDS Radio Modem Installed on ACE3600 Chassis – Cable Connections 
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RTU Configuration 
The RTU port is configured using the ACE3600 STS as follows:  

Procedure 13-28 How to Configure the ACE3600 Port for the MDS Radio 

1. In the ACE3600 STS click on the desired site, and open the site view.   

2. In the Port Tab, click on the on-board or plug-in port through which the RTU will 
communicate with the MDS radio.   

3. Confirm that the port parameters and data speed are as shown in the relevant screen 
below.   
Note: If the baud rate of the radio is not the default value (9600), the baud rate of the port 
should be configured accordingly. 

4. Define desired links. 

5. Save the changes.  

 

Figure 13-55  RTU Site Configuration for MDS 9810 Spread Spectrum/4710 UHF Transceiver 
Radio– Port Type Parameters 

 

 

Figure 13-56  RTU Site Configuration for MDS 9710A- 900 MHz Radio– Port Type Parameters 
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Mounting the ACE3600 Radios on a Wall 
ACE3600 radios can be mounted on a wall near the ACE3600 frame/housing, using a special 
metal bracket.  This bracket is part of the specific radio installation kit and must be ordered. 

80

75

P/N:0789422V45

17
9.

8

223

  

145
80

P/N:0789422V4175
18

2.
5

250    

CM/EM/GM/CDM750 Bracket              XTL5000/XTL2500 Bracket 
74

 

GP/HT/PRO Bracket  
Figure 13-57  Radio Wall Mount Brackets 

 
Procedure 13-29  How to Mount a Radio on a Wall 

The following installation procedure should be followed to install radios on a wall near the 
ACE36000 frame.  A special wall mount bracket is provided with the radio installation kit, 
which can be ordered separately from the frame.  Allow extra space around the bracket for the 
radio and wires. 

1. Drill four holes in the wall at the horizontal and vertical distances (in mm) shown in 
Figure 13-57 for the desired radio wall mount bracket, at the desired angle/orientation. 

2. Place the bracket on the wall, lining up the bracket holes with the drilled holes. 
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3. Insert four M3 Phillips 10mm screws (not supplied) into the holes and tighten with a 
screwdriver to secure the bracket firmly against the wall. 

4. Attach the radio to the bracket using the supplied screws.  
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RS485 CONNECTION BOX 

General Description 
The RS485 Connection Box (V186AD/FLN3641A) provides an interface to up to seven RS485 
connections.  (See Figure 14-1.) 

MOTOROLA

RS485     HUB

RS485 Port 1

RS485 Port 2

RS485 Port 3

RS485 Port 4

RS485 Port 5

RS485 Port 6

RS485 Port 7

 

Figure 14-1  RS485 Connection Box – Front Panel 
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Installation 
The RS485 Connection Box can be easily installed on the RTU chassis.  

Mounting the RS485 Connection Box on the RTU Chassis 
1) To connect the plastic box interface to the metal chassis, place the box on the metal plate 

and click the two pegs on the back of the plastic box into the desired holes on the metal 
chassis.   

Wire Connections 
1) To interface to an RTU, connect the communication cable (FKN8427A) between the 

connection box input port and the ACE3600 RS485 port.  

2) To interface to an external device, connect the communication cable (FKN8427A) between 
the connnection box port and an external RS485 modem with an RJ45 connector. 

MOTOROLA

RS485 HUB 

 

Figure 14-2  RS485 Connection Box – Wire Connections 
 



 

AUDIO CONTROL AND TONE (ACT) MODULE 

Introduction 
The Audio Control and Tone (ACT) module (V155AE/FLN3851A) serves as a player of 
recorded voice and alarm sounds in ACE3600 based alert systems. The ACT module also 
routes low-level sound signals to high-level amplifiers. The high-level sound can be directed to 
specified alert speakers in a set of six speakers, mounted in different locations. 

The ACT module contains an internal audio memory that allows custom tones or audio sounds 
to be recorded and stored in the ACT module. Recording of audio may be done directly from a 
low-level output source (tape recorder, laptop or radio output). 

Front Panel Description 
The ACT module is enclosed in a compact plastic box.  See the ACT module below. 
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High-level Audio Inputs (amplified audio from a power 
amplifier) - Normally Open and Normally Closed (C). 
High-level Audio Outputs 1-6 (Speakers 1-6). 
LEDs - Indicate the number of signals that are manually 
recorded (up to eight). 
Record pushbutton - Used for manual recording. 
Low-level Audio Output - Marked as SIG OUT and GND. 
Low-level Audio Input - Marked as SIG IN and GND.  
COM OUT port - an extension of the COM IN RS232 port 
and can be routed to any serial interfaced device (For 
example, serial dot matrix printer). 
COM IN port - an RS232 communication interface port to the 
ACE3600 CPU. This line is used by the RTU for controlling 
the unit. 
Power inlet - Connected to a DC supply voltage source of 9 
to 16 VDC (the AUX port on the ACE3600 power supply). 

 

 
         Figure 15-1  ACT Module – Front Panel 

 

ACT Module Features 
The ACT module features are described below: 
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• Controlled by the RTU via an RS232 serial port using a simple instruction set. 

• Digitally records audio signals (alarm tones, voice announcements, etc). 

• Plays stored audio signal. 

• Interface to an external low-level audio signal source (microphone, radio audio out, 
etc.). 

• Interface to input of one audio amplifier and up to two outputs of audio amplifiers. 

• Connects to up to six speakers. 

• Selective output to any combination of six speakers. 

• Routes the audio signals from the amplifier(s) output to selected speakers. 

• Routes data coming from the RTU to a serial printer to allow printing of information 
by alternative use of the RTU serial port. 

The ACT module block diagram is shown below: 
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Figure 15-2  ACT Module – Simplified Block Diagram  
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Audio Handling Capabilities 
The ACT module has built-in hardware which records and stores audio signals by digitizing the 
signal from an audio source connected directly to the module’s low-level audio input. The 
module can play these pre-recorded audio signals once or repeatedly. 

To facilitate the recording process, audio signals may be formed or saved in "WAV" file format 
on a PC (or on any other audio format provided it can be played by a PC) and then downloaded 
to the module through the PC audio out. 

The module’s total recording capacity is 240 seconds. As default, the recording space is 
divided into eight "cells” (each of which holds up to 30 seconds). The number of cells is 
configurable and can be set to 1, 2, 4, 8, 16, 30 and 60. 

NOTE: Recording will automatically terminate 2 seconds after the module detects silence. 
Recording will also be stopped when the "cell" has run out of recording capacity. 

The module’s low-level audio input also enables the connection of an external low-level audio 
source (such as a radio audio output) for direct routing to an audio amplifier. Thus the audio 
routed to this output can be either a pre-recorded audio signal or an external source, connected 
to the low-level audio input. 

Two high-level audio inputs are used to route amplified audio signals into the module. The 
ACT module has six high-level audio outputs that can be routed to selected speakers. 

Interface to the RTU 
The ACT module interfaces to the RTU via an RS232 port, marked as COM IN. The 
communication with the RTU is based on an 8-bit code protocol. 

The ACT module also enables the RTU to have more than one use for its RS232 port. The 
application on board the RTU may select its serial port connected to COM IN to control the 
ACT module or to send data to COM OUT. This is very useful for connecting a dot matrix 
printer to the RTU without requiring an additional serial port which could necessitate the 
another CPU. 

The destination of the serial data sent to the COM IN port is selected via the following 
mechanism: 

• Set DTR signal "Off" – Data is routed to COM OUT. 

• Set DTR signal "On" – Data protocol controlling the ACT. 

The ACT module operates on 9 to 16 VDC, usually supplied by the RTU's auxiliary power 
supply. 

An RTU application program controls the ACT module via a user port using an 8-bit 
instruction set. 

The ACT module returns simple 8-bit codes as a response to instructions. 



Audio Control and Tone (ACT) Module 

15-5 

The instruction set is comprised of the following set of operations: 

• Play 

• Repeat Play # times 

• Stop - Play 

• Enable low-level Audio Output 

• Disable low-level Audio Output 

• Configure the number of recorded signals (cells) 

• Record 

• Report Status 

• Connect/Disconnect Speakers 

For the ACT module instruction set, see ACT Instruction Set below. 
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Installation and Wiring 
The ACT can be installed in various locations on the RTU chassis (mounted on holes prepared 
for installation). 

Note: Connect the ACT to the High Power Audio Amplifier only via the Isolation Board - 
FCN6294A (connected to the SIG IN/SIG OUT connector). 

Procedure 15-1  How to Install the ACT Module  

1) Place the ACT module on the metal plate and click the two pegs on the back of the plastic 
box into the desired holes on the metal chassis.  

2) Connect one end of the power cable (FKN8433A) to the PWR connector on the ACT 
module.  Connect the other end of the cable to the one of the AUX connectors (configured 
to 12V) on the ACE3600 power supply module. 

3) Connect one end of the communication cable (FKN8427A) to the COM IN port on the 
ACT module.  Connect the other end of the cable to the RS232 port on the ACE3600 CPU. 

4) To use high-level audio speakers, connect up to six speakers to the High-Level Audio Out 
(1-6) relays on the top of the ACT module front panel.  See Figure 15-3 below. 

5) To enable playing prerecorded tones, connect the input of the first high power audio 
amplifier to the SIG OUT/GND connectors, using the Isolation Board (FCN6294A).  
Connect the output of the amplifier to the Normally Open connector on the top left corner 
of the ACT module front panel.  See Figure 15-3 below. 

6) To enable radio voice channel audio (low level signal), connect the external speaker of the 
voice radio to the SIG IN/GND connectors, using a simple wire cable (can be shielded).  
See Figure 15-3 below. 

7) To add a second high power audio amplifier for local microphone, connect the output of 
the second amplifier Normally Closed (C) connector on the top of the ACT module front 
panel.  Also connect the output of the second amplifier to the output of the first amplifier.  
See the warning in Figure 15-3 below.  

8) To use a local microphone (low-level audio signal), connect the microphone to the second 
amplifier. 

9) To attach a dot matrix printer or other serial device, connect the device to the COM OUT 
connector on the ACT module using a data cable (with connector adaptors as necessary.)  
See Figure 15-3 below. 
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ACT Module
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Warning! Usually, when two amplifiers
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"common" outputs are joined by one
wire (see wire connected between G1
and G2 points in the picture). Avoid
using amplifiers with "double push-
pull" output. Such amplifiers may be
damaged if connected this way.

 

Figure 15-3  ACT Module – Wiring Diagram 
 

Table 15-1 ACT Module Communication Ports Connection Chart 
 

COM IN COM OUT 

RxD - In  1 TxD 

TxD - Out  2 RxD 

DTR - Out  3 CTS 

GND  4 GND 

RTS - Out  5 CD 
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CD - In  6 RTS 

Not Used  7 Not Used 

CTS - In  8 DTR 

RTU Port Configuration 
Before using the ACT module with the RTU, configure the communication port to which the 
ACT module is connected. 

Procedure 15-2  How to Configure the ACE3600 Port for the ACT Module  

1) In the ACE3600 STS click on the desired site, and open the site view. 

2) In the Port Tab, click on the on-board or plug-in port through which the RTU will 
communicate with the ACT Module. 

3) Set Media to RS-232, Operation Mode to Async, Connection Type to User Port (Ladder 
Controlled). 

4) Save the changes. 

Generally no other changes are required to Advanced Physical or Link Layer parameters.  For 
information on the RTU port parameters, see Appendix A: Site Configuration Parameters of 
the ACE3600 STS User Guide. 
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Controlling the Module 
The RTU (or PC) is interfaced to the ACT via the RS232 port. The communication parameters 
of the RTU (or PC) port must be set to: 9600 BPS, 1 stop bit, no parity. 

The ACT is operated using a simple instruction set. Each instruction must be sent twice. If the 
second instruction sent does not correspond to the first, that instruction is rejected. When the 
ACT recognizes a valid instruction, it echoes an acknowledgement. While the module is 
playing a stored audio signal, the instructions should be sent only once. 

ACT Instruction Set 
Instruction Code Description 

Play Signal #  “01XXXXXX” 

(XXXXXX=1 - 60) 

Plays recorded audio signal number #. 

The recorded audio is played into the low-level Output. 
The low-level Output is disabled. Example: Play 
signal 6 = "01000110” 

Record Signal # 10XXXXXX 

(XXXXXX=1-60) 

Records audio signal number #. 

Example: Record signal 6 = “10000110” 

Connect/Disconnect 
Speakers 

11X5X4X3X2X1X0 

Xn= Speaker n (n=0-5) 

0= disconnect 

1= connect 

Connects or disconnects speakers. 

Repeat the Played 
Signal #  times 

001XXXXX 

XXXXX=1-31 

Repeats playing the audio signal # times. 

Note: This command can be instructed and performed 
only while the unit plays a signal.   

Example: Repeat playing the played signal 4 times = 

“00100100” 

Stop Play “00011111” Stops the played signal. 

Enable Low-level 
Audio Output 

“00100000” Low-level Audio Input is routed to Low- Audio Output

Disable Low-level 
Audio Output 

“00000000” Low-level Audio Output is disabled (no audio is routed 
to the output). Played signal is stopped. 

Configure the 
number of recorded 
signals  

“000XXXXX” 

XXXXX=1,2,4,8,15, 30 

N=2*(XXXXX) 

Configures the number of different signals that can be 
recorded to n= 2, 4, 8, 16, 30, 60 

Example: Set to 16 signals = “00001000” 

One signal “00000011” Configures the number of recorded signals to only one. 

Report Status “01000000” Use this command to interrogate the ACT. The ACT 
then returns the following 4 byte sequence with the 
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module status: 

Byte 1: Instruction Echo (“01000000”) 

Byte 2:  

   Bit 0-5 = Speaker status (0=disconnect) 

   Bit 6 = Play status (1 = play) 

   Bit 7 = Low-level Audio Output status  

   (1= Low-level Input routed to Low-level Out) 

Byte 3: Possible number of recorded signals 

Byte 4: The number of recorded audio signal that is 
currently playing (will be reported only when a signal 
is played.) 

 

Response to Instructions 
The ACT acknowledgements are the 8-bit codes described below: 

Response Code Description 

Record completed “01111110” Recording has been completed. 

Play started “10000000” Signal is currently being played. 

Play completed “01111101” Signal play has been completed. 

Instruction 
inconsistency 

“01111111” Instruction was not the same as the first one 
(when not playing); the instruction is not 
performed. 

Instruction time out ”01000000” Instruction received only once, (when not 
playing); the instruction is not performed. 

 

Recording Audio Signals 
Manual recording enables the recording of up to eight audio signals using the pushbutton (PB) 
and LEDs on the ACT unit front panel.  Follow the steps below to record audio from 
PC/Laptop/Recorder: 

Procedure 15-3  How to Manually Record Audio Signals 

1) Connect the "Speaker Out” of the PC/Laptop/Recorder to the "Audio In” port (Use Mono 
adapter if needed). 

2) Pause the audio and tune the volume to approximately ¾ of full scale. 

3) Press the PB for more than two seconds; all four LEDs will light up. 
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4) Press the PB to select the audio cell (from a selection of eight) to which you want to 
record. (The audio signal number is displayed as a binary number represented by four 
LEDs). 

5) Start playing the audio. The unit will identify the input as audio and start recording. 
The LEDs will start to blink and will stop when audio input ceases (or when the maximum 
recording time has elapsed). 

6) Repeat steps 4 and 5 to record additional audio signals (up to eight). 

7) When recording is completed, all the LEDs will turn off. 
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ACT Module* Specifications 
General  

Operation Voltage 9 to 16VDC 

Power Consumption 140 mA max (when all relays energized) 
35 mA max (when all relays non energized) 

Dimensions (H x W x L) 25mm x 95mm x 115mm (1” x 3.6” x 4.5”) 

Operating Temperature -30º to +60º C (-22º to +140ºF) 

Relative Humidity 0-95% @ 50° C without condensation 

User Connection  

Power connector Molex 2 pin with polarity 

COM IN RS232 Phone 8-pin 

COM OUT RS232 Phone 8-pin 

Low-level Audio In/Out 4 screw TB connector 

High-level In/Out 8 screw TB 

Audio  

Low-level Audio Input 0.8 to 1.5 Vp-p, 300-3300 Hz, Minimum 50 kW ±10%  
input impedance – 4.6KV isolated. 

Low-level Audio Output 1Vp-p ±60% - 4.6KV isolated, via Isolation Board. 

High-level Audio Input Maximum 30 VAC RMS, 0.5A RMS 
Maximum 0.05 W-output Impedance 
Minimum signal: 100 mV, 100 µA. 

High-level Audio Output 30 V RMS, 0.5 A RMS maximum per one output 

EMC  

Electrostatic Discharge IEC 1000-4-2, level 3 

Radiated Electromagnetic 
Field 

IEC 1000-4-3, level 3 

Electrical Fast Transient / 
Burst 

IEC 1000-4-4, level 3 

Radiated Emission EN55022 

Specifications subject to change without notice. 

                                                      
* The ACT module is not compliant with ROHS European Directive no. 2002/95/EC. 



 

16-1 

CONFIGURATION 

General 
For information on setting the 12V DO dipswitch in the DO relay module board, see the 
Digital Output Relay chapter above.  
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OPTIMIZATION 

General 
No optimization is required for the ACE3600 units. 
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OPERATION 

General 
The operational functions of the ACE3600 unit are performed using the ACE3600 System 
Tools Suite (STS).  These are administrative and diagnostic tasks, generally performed by 
technicians and administrators.  The functions available depend on the specific software 
applications installed in the unit. 

Opening/Closing the Housing Door 
For instructions on opening and closing the housing door and locking the door with the 
optional padlock accessory, see the Opening/Closing the Housing Door section in the 
Installation chapter. 
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MAINTENANCE 

General 
The following maintenance procedures are recommended for the ACE3600 RTU. 

Lead Acid Battery Maintenance 
It is recommended to perform the following maintenance procedures for the lead acid battery 
using the ACE STS Hardware Test utility or the user application program: 

• Once per month - run a full battery test (battery capacity) of the lead acid battery. 

• Once per day - read the charge level of the lead acid battery. 

If the capacity is below the manufacturer recommended level, replace the battery.  See the 
Power Supply Module and Backup Battery chapter above. 
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TROUBLESHOOTING 
 

Symptom Action  
The PWR LED on the CPU module 
front panel is not lit. 

Check power connections to the unit.   
If all connections are correct, check cables. 

The Power LED on the CPU 
module front panel is red. 

The CPU has received an error from the power 
supply (AC fail, Bat Error etc.)  Check the AC power 
supply, backup battery, etc. 

The ERR LED on the CPU module 
front panel is red. 

The unit has a problem.  Check the Error Logger to 
read error message. 

The ERR LED on the CPU module 
front panel is orange. 

The unit has a warning.  Check the Error Logger to 
read warning.  

The ERR LED on the CPU module 
front panel is green. 

The unit has a message.  Check the Error Logger to 
read message.  

The APPL LED on the CPU 
module front panel is red. 

The user application is not running.  Check the Error 
Logger to read error. 

The CONF LED on the CPU 
module front panel is red. 

There is a configuration error (such as an 
incompatible plug-in.)    Check the Error Logger to 
read error. 

The PWR LED on the CPU module 
front panel is flashing red. 

The boot did not complete and the FPGA is not 
loaded. Download a new system to the unit. 

The PWR LED on the CPU module 
front panel is flashing red. 

The boot did not complete and the FPGA is not 
loaded. Download a new system to the unit. 

The power supply is connected to 
power sources and there is no 
power in AUX1 and/or AUX2. 

Check if the AUX connectors are off due to STS 
Hardware Test.   
 
If not, check if the fuse associated with the AUX is 
burned out and should be replaced.  (One fuse for 
AUX 1A/1B and another fuse for AUX 2A/2B.)  See 
Break-Fix Procedures chapter. 

No communication with WAN, IP 
Gateway.  

Check the unit's connection to the Ethernet.  
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BREAK-FIX PROCEDURES 

General 

 

This chapter refers only to replacement of removable modules, plug-ins, motherboard, 
power supply fuses, and backup battery.  If any other components in the unit require 
replacement, contact your local service center.   

Before replacing modules or plug-ins, see safety issues/warnings in the Installation 
chapter above. 

Note: A TORX screwdriver is required for component replacement. 

For information on installation of the frame/housing on the wall, see the Installation chapter 
above. 

The ACE3600 has a hot swap capability, which means that the modules can be removed from 
their slots and inserted without powering down the unit.  The only exception to this rule is the 
main power supply module, which cannot be removed during normal operation.   See 
Replacing a Power Supply Module below for details. 

If a module is inserted once the system is running, the system will recognize the module, but 
will not operate it using the application until the unit has been rebooted. 

Replacing a CPU Module 
Procedure 21-1  How to Replace a CPU Module 

1. To replace a CPU module, open the door of the CPU module and press the cable holder 
downward.  

2. Disconnect all cables from the connectors. 
3. Simultaneously press on the tabs on the top and bottom of the plastic front of the old 

module, and pull the module from its slot.  See Figure 21-1. 
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Press Down on 
Module Release Tab

Press Up on Module 
Release Tab  

Figure 21-1  ACE3600 Module Release Tabs 

4. Remove any SRAM plug-in memory from the old CPU module and plug in to the new 
CPU module. 

5. Slide the new module all the way into the slot until the tabs click into place. 
6. Reconnect the cables and press the cable holder back up into place. 

Replacing a Power Supply Module 

 

METAL PARTS OF THE POWER SUPPLY MAY BE VERY HOT. 
After removing the power supply module, allow the metal parts to cool down before 
servicing the unit. 
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Procedure 21-2  How to Replace a Redundant Power Supply Module 

1. To replace the second power supply module in a site with redundant power supplies, open 
the door of the power supply module and press the cable holder downward. 

2. Disconnect the cables from the connectors. 

3. Simultaneously press on the tabs on the top and bottom of the plastic front of the old 
module, and pull the module from its slot. 

4. Slide the new module all the way into the slot until the tabs click into place. 

5. Reconnect the cables and press the cable holder back up into place. 

The main power supply cannot be removed under power and a safeguard is added in order to 
prevent unplanned removal.   

Procedure 21-3  How to Replace the Main Power Supply Module 

1. To replace the main power supply module, open the door of the power supply module. 
2. Press down on the top of the main power cable connector to disconnect the user’s main 

power cable from the cable inlet on the bottom of the power supply module front panel. 
3. Follow steps 1-5 in Procedure 21-2 to replace the power supply. 

Replacing an I/O Module 
To replace an I/O module, follow the procedure below. 

Procedure 21-4  How to Replace an I/O Module 

1. If the I/O module includes a TB holder, remove TB holder by pulling on the extractor 
handles.  
If the I/O module does not include a TB holder, remove the TBs by hand or using the TB 
extractor. 

2. Simultaneously press on the tabs on the top and bottom of the plastic front of the old 
module, and pull the module from its slot. 

3. Remove any plug-in 24V power supplies from the old I/O module and plug-in to the new 
I/O module.  

4. For DO relay modules, reset the 12VDO dipswitch, if necessary.  See the Configuration 
chapter. 

5. Slide the new module all the way into the slot until the tabs click into place. 
6. If the I/O module includes a TB holder, reconnect the TB holder as described in the I/O 

Module section.  
If the I/O module does not include a TB holder, replace the TBs on the connectors on the 
front of the I/O module by hand. 
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Replacing a Plug-in Port on the CPU Module 
Procedure 21-5  How to Replace a Plug-in Port on the CPU Module 

1. To replace a plug-in port on the CPU module, remove the CPU module from the RTU. 

2. Unscrew the two supporting pins on the other side of the CPU board.  Save the screws. 

3. Unscrew the two supporting pins on the plug-in port. Save the screws. 

4. Connect the two supporting pins with screws to the new plug-in port. 

5. Replace the plug-in board with the RJ-45 connector facing the panel.  Carefully insert the 
plug-in board connector into the appropriate connector on the CPU board. 
For Ethernet 10/100 MB, use the J14 connector on the CPU (Plug-in 1 only.) 
For all other plug-in ports, use the J5 (Plug-in 1) or J6 (plug-in 2) connector. 

6. Connect the two supporting pins with screws to the other side of the CPU board. 

7. Replace the CPU module in the slot. 

Replacing a Plug-in SRAM Memory Card in the CPU Module 
Procedure 21-6  How to Replace a Plug-in SRAM Memory Card in the CPU Module 

1. To replace an SRAM memory card on the CPU module, remove the CPU module from the 
RTU. 

2. Remove the old plug-in SRAM memory card from the board.  
3. Place the new plug-in SRAM memory card with the connector facing the panel.  Carefully 

insert the plug-in board connector into the connector marked P12 on the CPU board. 
4. Secure the memory card to the CPU board with the supplied screw. 
5. Replace the CPU module in the slot. 
For more information, see Connecting SRAM Expansion Memory to the CPU Module in the 
CPU Module chapter. 

Replacing the Motherboard 
To replace the motherboard of the ACE3600 RTU, follow the procedure below. 

Procedure 21-7  How to Replace the Motherboard 

1. If the unit is installed in a NEMA4 housing, unscrew the four large screws and remove the 
metal chassis from the housing. 

2. Remove all modules from the outermost slots, generally the power supply module from the 
leftmost slot and I/O module from the rightmost slot.  

3. Unscrew the M5 screws on each side which secure the motherboard to the metal chassis.  
Save the screws.  See Figure 21-2. 
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Figure 21-2  ACE3600 Motherboard on Metal Chassis 

4. From inside the cage, push out the small cover on the side of the RTU rack/cage.  Save the 
cover. 

5. Slide the damaged motherboard out of the cage, through the opening on the side of the 
RTU rack/cage. 

6. Slide the new motherboard into the rack, through the opening on the side of the RTU 
rack/cage. 

7. Secure the motherboard to the rack/cage and metal chassis using the M5 screws saved in 
step 3. 

8. Replace the cover on the cage. 
9. If the unit was installed in a NEMA4 housing, replace the metal chassis in the housing and 

screw the four large screws from the metal chassis into the housing. 
10. Replace the modules in their respective slots. 
11. Make sure that the ground is reconnected. 
 

Replacing the Fuses on the Power Supply Module for AUX1/AUX2 
Procedure 21-8  How to Replace the Fuse for AUX1 1A/1B or AUX2 2A/2B 

1. To replace a fuse for AUX1 1A/1B or AUX2 2A/2B on the power supply module, 
2. Disconnect cables … from the connectors.  If the faulty fuses are attached to the main 

power supply, press down on the top of the main power cable connector to disconnect the 
user’s main power cable from the cable inlet on the bottom of the power supply module 
front panel.   

3. Simultaneously press on the tabs on the top and bottom of the plastic front of the old 
module, and pull the module from its slot.   
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4. Using narrow pliers, remove the faulty fuse from its groove on the board.   
5. Press the new fuse into the groove on the board. 
6. Slide the power supply module all the way into the slot until the tabs click into place. 
7. Reconnect cables as in installation… 
 

Replacing the Backup Battery on the RTU 
For instructions on replacing the backup battery on the RTU, see Replacing the Backup Battery 
in the Power Supply and Backup Battery chapter above. 

Interconnection Diagrams 
All internal electrical connections except for the main power, ground and battery are performed 
in the factory and supplied with the RTU.  The electrical interconnection diagrams are 
provided below. 

 

Figure 21-3  Electrical Interconnection (RTUs with I/O slots) 
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Figure 21-4  Electrical Interconnection (RTUs with no I/O slots) 
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APPENDIX A: GENERAL SPECIFICATIONS 

Specifications 
The specifications below are for the RTU as a whole.  For the individual technical and 
performance specifications of each module in the RTU, see the specific module chapter. 
 

Table A-1 ACE3600 Specifications 
General   

Frames No I/O slots - PS and CPU modules only, wall mount, 
Dimensions (WxHxD): 117 x 244 x 198* mm (4.61" x 8.23" x 7.80"*), 
Weight: 0.95 Kg (2.1 lb) 
 

3 I/O slots - PS, CPU  and 3 I/O modules, wall mount, 
Dimensions (WxHxD): 234 x 244 x 198* mm (9.21" x 9.61" x 7.80"*), 
Weight: approx. 1.9 Kg (4.19 lb) 
 

5 I/O slots - PS, CPU  and 5 I/O modules, wall mount, 
Dimensions (WxHxD): 314 x 244 x 198* mm (12.36" x 9.61" x 7.80"*), 
Weight: approx. 2.4 Kg (5.3 lb) 
 

7 I/O slots - PS, CPU  and 7 I/O modules; wall mount, 
Dimensions (WxHxD): 391 x 244 x 198* mm (15.39" x 9.61" x 7.80"*), 
Weight: 3.0 Kg (6.6 lb) 
 

8 I/O slots - PS , CPU  and 8 I/O modules, wall mount  or 19" rack,  
Dimensions (WxHxD): 435 x 244 x 198* mm (17" x 9.61" x 7.80"*),  
Weight: approx. 3.3 Kg (7.3 lb) 

* Depth including Module panel  

Metal Chassis Large  - for PS, CPU and up to 7 I/O slot frame, two radios and 6.5 or 10 
Ah backup battery, wall mount ,  
Dimensions (WxHxD): 448 x 468 x 200* mm (17.64"x 18.43"  x  7.88"*) 
 

Small  - for PS, CPU and up to 3 I/O slot frame, one radio and 6.5  Ah 
backup battery, wall mount,  
Dimensions (WxHxD): 335 x 355 x 198* mm (13.19" x 13.98"  x  7.8"*) 

* Depth including Frame and Module  
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Housing Large Nema 4X / IP65 painted metal -  up to 7 I/O slot frame, two radios 
and 6.5 or 10 Ah, backup battery,  
Dimensions (WxHxD): 500 x 500 x 210 mm (19.7" x19.7" x 8.26" ) 
 

Small Nema 4X / IP65 painted metal -  up to 3 I/O slot frame one radio and 
6.5 Ah backup battery,  
Dimensions (WxHxD): 380 x380 x 210 mm (15" x 15" x 8.26") 

Power Supply  10.8-16 V DC low-tier  

10.8-16 V DC (default) 

18-72 V DC 

18-72 V DC with 12V smart battery charger 

90-264 V AC, 50-60 Hz  

90-264 V AC, 50-60 Hz,  with 12V smart battery charger 

Backup Battery 6.5 Ah - Sealed Lead-Acid 

10 Ah  - Sealed Lead-Acid 

Operating Temperature -40 ºC to +70 ºC (-40 ºF to 158 ºF) 

Notes: 1) When using a metal housing option, the maximum operating  
               temperature outside the housing is +60 ºC (140 ºF). 

           2) ACT module and Motorola radios operating temperature range is: 
               -30 ºC to +60 ºC (-22 ºF to 140 ºF). 

Storage Temperature -55 ºC to +85 ºC (-67 ºF to 185 ºF)  

Operating Humidity 5% to 95% RH @ 50 ºC without condensation  

Mechanical Vibrations  Per EIA / TIA 603 Base-station, Sinusoidal 0.07mm @ 10 to 30 Hz, 0.0035 
mm @ 30-60 Hz  

Operating Altitude -400m to +4000 meter (-1312 ft to + 13120 ft) above sea level 
Note: When using 18-72V DC or  90-264 VAC Power supply the operating 
altitude is -400 to +2000m 

  
Regulatory Standards  

Safety UL 60950-1 (UL listed), CSA 22.2-950-1, EN60950-1, IEC 60950-1, 
AS/NZS 60950  

FM?? 

Emission Emission standards for industrial environments  

CFR 47 FCC part 15, subpart B (class A);  
CE EMC: EN50081-2/EN61000-6-4  

(CISPER 11 / EN55011 class A) 

Immunity Immunity standards for industrial environments  

Per EN50082-2 /IEC 61000-6-2   
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Communications  

Communication Ports  Up to 5 Ports per CPU 

Serial - up to 4 x RS232 ports 

Multi-drop – up to 3 x RS485 port 

Ethernet - up to 2 x 10/100 MB ports and 1 x 10 MB  

Two-way radio / analog trunked radio - up 2 x  modem ports  

Motorola Radio Support Mobile conventional two-way radios  –  CM 200 , CM 340, GM 3188, EM 
200, CDM750 

Portable conventional two-way radios – HT750, GP320, GP328, PRO5150 

Analog trunked radios – XTL5000, XTL2500, XTS2500 

Digital trunked radios – XTL5000, XTL2500, XTS2500, MTM800 
(TETRA)  

Third Party Radio Support Two-way radios, Data radios, TETRA radios (PD)  

Modem Support  Dial-up modems, Cellular modems (dial mode and PD) 

Protocols MDLC, TCP, UDP, IP, PPP, NTP, DHCP   

Third Party Protocol 
Support 

MODBUS RTU: master on RS232/RS485,  
                           slave on RS232/RS485/Ethernet  
DF1 (Allen Bradley): master on RS232 
DNP 3.0: master/slave on RS232/RS485/Ethernet 
IEC 60870-5-101: slave on RS232 

User Protocol (user 
program) 

Possible on RS232, RS485 and Ethernet ports  

 

Specifications subject to change without notice. 
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APPENDIX B: ENVIRONMENTAL PROTECTION 

Disposal of Components 
All components of the ACE3600 should be properly disposed of, in accordance with local 
regulatory standards and laws. 

All ACE3600 models comply with RoHS European Directive no. 2002/95/EC (Restriction of 
the use of Hazardous Substances) and WEEE Directive no. 2002/96/EC (Strategy of Waste 
management), with the exception of parts: 

• XTL5000 radio (included in models F7523A/F7513A/F7524A/F7514A/F7585A/F7586A) 

• XTL2500 radio (F7533A/F7593A/F7534A/F7594A/F7538A/F7598A) 

• XTS2500 radio (F7543A/F7544A/F7548A) 

• CDM750 radio (F7563A/F7564A) 

• ACT Module (option V155AE and kit FLM) 

Note: The ACE3600 RTU is categorized as Monitoring and Control Equipment.  Currently 
(December 2007) Monitoring and Control Equipment are exempt from RoHS compliance.  
This exemption may be cancelled in the future. 
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APPENDIX C: RS232/RS485 ADAPTOR AND ETHERNET 
CABLES 

General 

 
Note: On all of the Motorola RJ45 connector heads (except for Ethernet crossover), 
the numbering of the pins is different than the standard, as shown in the figure below.  
Pin 1-8 are left to right rather than right to left, as shown below.  Therefore, only 
original Motorola cables should be used. 

                           
 
This appendix provides the information required for connecting an RTU RS232 port to various 
units, as detailed below: 

• Connection to a computer/terminal (MDLC protocol or User port) 
• Connection to a modem (MDLC protocol or User port) 
• Connection to the GPS receiver (MDLC protocol) 
• Connecting a User port to a printer 
• Connecting a User port to an external unit 
• Connection to a radio (MDLC protocol) 
• RTU-to-RTU connection using MDLC protocol through RS232 ports (RS-Link) 
• ACE3600 RTU-to-ACE3600 RTU connection using MDLC protocol through RS485 ports 

(RS-Link) 
• ACE3600 RTU-to-MOSCAD RTU connection using MDLC protocol through RS485 ports 

(RS-Link) 
• ACE3600 RTU-to-PC Ethernet port connection without a hub 

Connection to a Computer or Terminal 
To connect one of the RTU RS232 ports to a computer/terminal, use the FLN6457B adaptor, 
which ends with the female 25-pin or 9-pin, D-type connector. The port may be defined either 
as a MDLC protocol port or as a User port. 
The signals that appear on the female 25-pin or 9-pin D-type connector are according to the 
RS232 standard – see the following table. In this case, the RTU serves as DCE (Data 
Communication Equipment). 
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RS232 Function 8-pin 
Connector (on 
RTU) 

25-pin Female 9-pin Female Direction 

TX-DATA 2 ← 2 3 from DTE 

RX-DATA 1 → 3 2 to DTE 

RTS 5 ← 4 7 from DTE 

CTS 8 → 5 8 to DTE 

DSR 7 → 6 6 to DTE 

GND 4 7 5 - 

DTR 3 ← 20 4 from DTE 

DCD (Rec line) 6 → 8 1 to DTE 
 
To extend the cable, you may use any extension cable with male and female D-type connectors 
(connected pin-to-pin, not crossed). 
Note: When a User port is defined as Computer/Terminal with DTR support: 
The RTU will not transmit unless it receives DTR=ON from the computer/terminal. 
The RTU will not receive unless it receives RTS=ON from the computer/terminal. 

Connection to a Modem 
To connect one of the RTU RS232 ports to an RS232 modem, use one of the adaptors provided 
in kit FLN6458B (option V213AE): 

• 9-pin adaptor for Async (#0189968V32) 
• RS232-E adaptor (#0189968V33) as in Connection to IDEN Radio below. 
• RS232-E+ adaptor (#0189968V34) as in Connection to TETRA Radio below. 
The asynchronous adaptor (#0189968V32) ends with the male 9-pin D-type connector. The 
port may be defined either as a MDLC protocol port or as a User port. 
The signals that appear on the male 9-pin D-type (or 25-pin) connector are according to the 
RS232 standard – see the following table. In this case, the RTU serves as DTE (Data Terminal 
Equipment). 

RS232 Function 8-pin 
Connector(on 
RTU) 

25-pin Male 9-pin Male Direction 

TX-DATA 1 → 2 3 from RTU 

RX-DATA 2 ← 3 2 to RTU 

RTS 6 → 4 7 from RTU 

CTS 3 ← 5 8 to RTU 

GND 4 7 5 - 
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RS232 Function 8-pin 
Connector(on 
RTU) 

25-pin Male 9-pin Male Direction 

DTR 8 → 20 4 from RTU 

DCD (Rec line) 5 ← 8 1 to RTU 
 
To extend the cable, you may use any extension cable with male and female D-type connectors 
(connected pin-to-pin, not crossed). 
Before transmitting, the RTU sends RTS=ON to the modem, and waits for CTS=ON from the 
modem as a condition for transmitting. 
The RTU will receive data from the modem only when DCD=ON. 
When using a modem in auto-answer mode (connected to a Computer port) for remote service, 
the RTU does not support RTS/CTS protocol since the port is designated to operate with a 
local computer as well as with a modem. 
For modems which support RS232-E, use either the RS232-E adaptor (#0189968V33) as in 
Connection to IDEN Radio below, or the RS232-E+ adaptor (#0189968V34), as in Connection 
to TETRA Radio below. 

Connection to GPS Receiver 
When an off-the-shelf GPS timing receiver is purchased (e.g. Synergy SynPaQ/E PPS Sensor 
with M12+), the data and power cable for that receiver should be purchased as well.   
Connect the data wire of the cable to the CPU port using the ACE3600 asynchronous RS232-E 
adaptor cable.  The port should be defined as a GPS receiver port (RS232, Async). 
Connect the power wire of the cable to a cable with the following connectors: 
RTU side: The connector should fit the auxiliary power connector on the ACE3600 power 
supply module. 
GPS Receiver side: The connector should fit the power connector on the GPS receiver cable. 

Connecting a User Port to a Printer 
To connect one of the RTU RS232 ports defined as a User port to a printer, you may use one of 
the two cables described in the previous paragraphs. Since the connection to the printer is not 
defined by the RS232 standard, every printer manufacturer has defined the connectors for his 
own convenience. Therefore, select the adaptor according to the functions of the various pins. 
If the FLN6458B adaptor (with the male 9-pin D-type connector) is used, refer to the following 
table. 

RS232 Function 9-pin Male Used as Direction 

TX-DATA 3 Serial Data to Printer 

CTS 8 Printer Ready from Printer 

GND 5 GND - 
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If the FLN6457B adaptor (with the female 9-pin, D-type connector) is used, refer to the 
following table. 

RS232 Function 9-pin Female Used as Direction 

RX-DATA 2 Printer Rx-Data to Printer 

DTR 4 Printer Ready from Printer 

GND 5 GND - 
 

Connecting a User Port to an External Unit 
To connect one of the RTU RS232 ports defined as a User port to an external unit (which 
supports RS232), you may use one of the two adaptors (FLN6457B or FLN6458B) according 
to the port definition in the site configuration. 
If the FLN6457B adaptor is used, refer to the pin assignment given in Connection to a 
Computer or Terminal in this chapter. 
If the FLN6458B adaptor is used, refer to the pin assignment given in Connection to a Modem 
in this chapter. 

Connection to a Radio 
For detailed instructions on connecting a radio to the ACE3600 RTU, see the Radio Types and 
Installation Kits chapter above.  

Connection to IDEN Radio 
To connect the RTU (via onboard serial or plug-in port) to an IDEN radio, use an adaptor 
which ends with the male 9-pin, D-type connector. The port should be defined as RS-232, 
Async, PPP, iDEN, MDLC over IP. 

RS232 Function 8-pin Connector(on 
RTU) 

9-pin Male Direction 

TX-DATA 1 → 3 from RTU 

RX-DATA 2 ← 2 to RTU 

CTS 3 ← 8 to RTU 

GND 4  5 - 

CD (Rec line) 5 ← 1 to RTU 

RTS  6 → Not used  

  7 → 4 from RTU 

DTR  8 → 7 from RTU 
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Connection to TETRA Radio 
To connect the RTU (via onboard serial or plug-in port) to a TETRA radio, use an RS232-E+ 
type adaptor which ends with the male 9-pin, D-type connector. The port should be defined as 
RS232, Async, PPP, Tetra, MDLC over IP. 

RS232 Function 8-pin Connector(on 
RTU) 

9-pin Male Direction 

TX-DATA 1 → 3 from RTU 

RX-DATA 2 ← 2 to RTU 

CTS 3 ← 8 to RTU 

GND 4  5 - 

CD (Rec line) 5 ← 1 to RTU 

RTS  6 → 4 from RTU 

  7  Not used  

DTR  8 → 7 from RTU 
 

RTU-to-RTU Connection Using MDLC Protocol through RS232 
To establish a link between two RTUs using MDLC protocol, the ports of both RTUs should 
be defined as RS232 RTU-to-RTU (RS-Link). The ports of the two RTUs should be connected 
by the FLN6457B and FLN6458B adaptors, when the adaptors are connected. 

 
Do not connect between RTUs without the adaptor cables. A direct connection will cause a 
short circuit between the pins that have the same function. 

RTU-to-RTU Synchronous Communication Using Plug-in Port 
The pin assignment of the cable to be used for RTU-to-RTU synchronous communication 
(using a plug-in port) is given below. 

 

RS232 Function 8-pin Connector 
(on sending RTU) 

8-pin Connector 
(on receiving RTU) 

Direction 

TX-DATA 1 → 2 ← from RTU 

RX-DATA 2 ← 1 → to RTU 

CTS 3 +6 →* 5 ← from RTU 

Signal GND 4  4  - 

CD (Rec line) 5 ← 3 +6 →* to RTU 

RTS  6 +3 →* 5 ← from RTU 
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RS232 Function 8-pin Connector 
(on sending RTU) 

8-pin Connector 
(on receiving RTU) 

Direction 

TX_CLK  7 → 8 ← from RTU 

RX_CLK 8 ← 7 → to RTU 
*Pins 3 and 6 are shorted. 

ACE3600 RTU-to-ACE3600 RTU Connection Using MDLC Protocol through 
RS485 

To establish a link between more than two ACE3600 RTUs using MDLC protocol, the ports of 
all RTUs should be defined as RS485 RTU multidrop. The ports of the RTUs should be 
connected using the RS485 connection box V186AD (FLN3641A).  Cable FKN8427A should 
be connected between ACE3600 RS485 port and one of the seven inlets of the connection box. 
 

RS485 Function 8-pin 
Connector* 
(on ACE3600) 

B (RX/TX-) 1  

A (RX/TX+) 8  
 
*Note: All seven connectors are shorted. 

ACE3600 RTU-to-MOSCAD RTU Connection Using MDLC Protocol 
through RS485 

To establish a link between an ACE3600 unit and a MOSCAD RTU using MDLC protocol, the 
ports of both RTUs should be defined as RS485 RTU multidrop. The ports of the two RTUs 
should be connected using the FKN8527A cable. 

 
Do not connect between RTUs without the adaptor cables. A direct connection will 
cause a short circuit between the pins that have the same function. 

 

RS485 Function 8-pin 
Connector 
(on ACE3600) 

4-pin  
Connector (on 
MOSCAD) 

B (RX/TX-) 1  2 

A (RX/TX+) 8  3 
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ACE3600 RTU-to-PC Ethernet Port Direct Connection without Hub 

  
Note: The RJ45 connector head for this connection is standard.  The numbering of the 
pins is according to the standard, as shown in the figure below.  Pin 1-8 are right to 
left, as shown below.  Therefore, any standard Ethernet crossover cable may be used. 

                           
 
To establish a link between an ACE3600 unit and the Ethernet port of a PC, without using a 
hub, the RTU port should be defined as an IP port (10/100 BT, Static, Ethernet LAN) with an 
IP address. The ports should be connected using an Ethernet crossover cable. 

IP Function 8-pin 
Connector 
(Plug 1) 

8-pin 
Connector 
(Plug 2) 

TX-DATA + 1 → 3 ← 

TX-DATA - 2 → 6 ← 

RX-DATA + 3 ← 1 → 

N/A 4  7 

N/A 5 8 

RX-DATA - 6 ← 2 → 

N/A 7 4 

N/A 8 5 
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APPENDIX D: ACE3600 MAXIMUM POWER RATINGS 

Power Rating Tables 
The tables below list the maximum power consumption (at room temperature) for each of the 
ACE3600 RTU building blocks (CPU, Power Supply, I/O modules, radios, etc) and the 
maximum peak power allowed for a fully loaded RTU, based on the housing type. 
The measurements below assume the worst case, in terms of input voltage. 
Before deploying your RTU, add up the power consumption of all components of your system 
to verify that it is within the maximum peak power for your housing type. 

 
Table D-1  Maximum Peak Power Allowed for Fully Loaded RTU 
Housing Description Maximum Input Power into Power Supply Module 

(in watts) 
19" Rack (w/out metal enclosure) 120w 
Large NEMA metal housing (50x50 cm)  120w 
Small NEMA metal housing (40x40 cm) 105w 

 
Table D-2  Power Consumption per RTU Module 
Module Name Self Power 

Consumption (no 
active I/O)  (in watts) 

Maximum Power Consumption 
per Active I/O (in watts) 
(when powered by internal 24V 
PS)   

Power Supply (maximum) 12.6  
CPU (3640/3610) 5.2  
Digital Input (16/32)  0.5 0.1  
Digital Input IEC Type 2 (16/32) 0.5 0.23  
Digital Output Relay ML (8/16)  0.1 0.01  
Digital Output Relay EE (8/16) 0.15 0.18  
Digital Output/Digital Input FET 
(all types) 

0.22 0.015  

Mixed I/O  
(DO ML +DI IEC Type 2) 

0.43 Additional maximum 3.1w from the 
24V PS for the entire module.  

Mixed I/O  
(DO EE + DI IEC Type 2) 

0.5 Additional maximum 4.9w from 24V 
PS for the entire module. 

Analog Output (@20mA) 0.94 0.6 
Analog Input Current/Voltage 
(8/16)  

0.5  

Mixed Analog Current/Voltage 
(@20mA) 

1.2 0.6  

24V Floating Plug-In Power 
Supply (No load) 

0.3  

24V Floating Plug-In Power 
Supply (externally loaded 150mA) 

4.8  
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Plastic Box Interface Typical Power  
(in watts) 

Power when all I/Os are on   
(in watts)  

Audio Control and Tone (ACT) 
Module 

0.6 2.2  

 
 
Radios Power in RX Mode  

(in watts) 
Power in TX Mode (in watts)  

XTL5000 (15W) 8.8 66.9  
XTL2500 (15W) 8.8 66.9  
XTS2500 (3W) 1.2 9.9  
HT750/GP320/PRO5150/GP328   
(UHF 4W/ VHF 5W) 

0.7 13.1  

CM200/CM140/EM200/GM3188 
(UHF 20W/ VHF 25W) 

3.7 75.1  

GM328/338/339/340  
(UHF 20W/ VHF 25W) 

3.6 73.2  

CDM750 (UHF 20W/VHF 25W) 3.9 74.5  
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